SAS® Add-In 8.2 for Microsoft Office: User’s Guide
Contents

Chapter 1 / What’s New in SAS Add-In 8, 8.1, and 8.2 for Microsoft Office ........................................ 1
   Overview ........................................................................ 1
   New SAS Panel .................................................................. 2
   Integration with SAS Visual Analytics .............................. 2
   General Enhancements .................................................... 3
   Enhancements to Automation Interface ............................... 3

Chapter 2 / Introduction to SAS Add-In for Microsoft Office ................................................................. 5
   About SAS Add-In for Microsoft Office .............................. 5
   About SAS Visual Analytics Add-In for Office .................. 6
   Determining Your SAS Add-In .......................................... 6
   Check for Software Updates ............................................. 7

Chapter 3 / Connecting to the SAS Platform ....................................................................................... 9
   Understanding Your Server Connections ......................... 9
   Working with the SAS Metadata Server ......................... 10
   Working with SAS Visual Analytics Profiles .................... 14
   Logging On to a Server .................................................... 15
   Migrating SAS Content ................................................... 16
   Managing Multiple Installations of the SAS Add-In .......... 17
   Loading and Unloading the SAS Add-In ......................... 19
   Using the SAS Grid Computing Environment ................. 19
   Connecting to the SAS Viya Environment ....................... 20

Chapter 4 / Using the SAS Add-In ..................................................................................................... 23
   Using the SAS Tab .......................................................... 23
   About the SAS Panel ....................................................... 23
   Understanding Role-Based Settings in the SAS Add-In .... 25

Chapter 5 / Customizing SAS Add-In for Microsoft Office ............................................................... 27
   About Customizing SAS Add-In for Microsoft Office ........ 27
   Setting the Data Options ................................................ 28
   Setting the Results Options ............................................ 35
   Setting the Task Options ................................................ 54
   Customizing the Ribbon and the SAS Panel .................... 56
   Setting the Advanced Options ....................................... 57

Chapter 6 / Working with Microsoft Excel Data and SAS Data Sources ........................................... 61
   About Accessing Data .................................................... 62
   Available Data Sources .................................................. 62
   Working with Data in a Microsoft Excel Worksheet .......... 63
   Working with Data in a PivotTable .................................. 68
   Modifying the Data Source ............................................. 69
   Filtering Data ................................................................... 70
   Sort Your Data .............................................................. 73
   Copy Data to a SAS Server ............................................. 74
   Update Data on the SAS Server ...................................... 75
   Working with Information Maps ...................................... 76
   Accessing Data in SAS Viya ............................................ 78
Chapter 7 / Working with OLAP Data .............................................................. 79
  Open an OLAP Cube .................................................................................. 80
  About the OLAP Analyzer ......................................................................... 80
  Understanding the OLAP Analyzer Interface ............................................. 81
  Creating a Slice of a Cube ........................................................................... 88
  Navigating in an OLAP Cube ...................................................................... 88
  Analyzing the Data in an OLAP Cube ........................................................ 93
  Filtering and Sorting Data in an OLAP Cube .............................................. 114
  Customizing the OLAP Analyzer ............................................................... 125
  Viewing an ESRI Map ................................................................................ 130
  Setting OLAP Analyzer Options ............................................................... 134

Chapter 8 / Working with SAS Tasks ............................................................ 137
  Accessing Tasks ......................................................................................... 137
  Selecting a Data Source for the SAS Task .................................................. 139
  Running Tasks on a Slice of a Cube ........................................................... 140
  View the Input Data Source ....................................................................... 141
  Creating Microsoft Excel Charts ............................................................... 141
  Changing the Destination of the Output Data ............................................ 148
  Viewing Output Data in Your Results ....................................................... 149
  View Properties of a Task ......................................................................... 149
  Working with Task Templates ................................................................... 149
  Working with Custom Tasks ..................................................................... 152

Chapter 9 / Working with Reports ............................................................... 153
  About Reports ........................................................................................... 153
  Open a Report ............................................................................................ 155
  Adding Comments to a Report ................................................................. 156
  View Display Rules for a Report ............................................................... 157
  Working with Prompts in SAS Visual Analytics Reports ........................... 158
  Create a Snapshot of a Report in Your Microsoft Office Document .......... 158
  View the Data Used to Create a Graph ...................................................... 159
  Remove SAS Links .................................................................................... 159
  Generating Reports from SAS Stored Processes ....................................... 160
  Refreshing SAS Content .......................................................................... 165

Chapter 10 / Working with SAS Programs .................................................. 169
  About the SAS Program Editor ............................................................... 169
  Run a SAS Program .................................................................................. 171
  Import a SAS Program ............................................................................. 172
  Export SAS Programs .............................................................................. 173
  Editing Program Files ............................................................................... 173
  Using the Syntax Help ............................................................................... 175
  Using Editor Macros ................................................................................ 176
  Creating and Saving a New Scheme .......................................................... 177
  Customizing the Editor Appearance ......................................................... 178
  Creating User-Defined Keywords .............................................................. 179
  Setting the Program Editor Options ......................................................... 179

Chapter 11 / Working with Documents in SAS Folders ............................... 183
  About SAS Folders .................................................................................... 183
  Save a Document to SAS Folders ............................................................. 183
  Open a Document from SAS Folders ......................................................... 184
  Specify the Security Settings for a Published Document ............................ 184
## Chapter 12 / Working with Results

- Viewing the Results ............................................ 187
- Modify the Results ............................................ 188
- Cutting, Pasting, and Refreshing Results .................. 189
- Delete SAS Content ........................................... 189
- Replicate SAS Content ....................................... 189
- Save a Report as HTML or PDF .............................. 190
- Export a SAS Visual Analytics Report to PDF ............ 190
- Applying Styles to the Results ............................... 191
- Sending Results .............................................. 193
- Inserting a Large Table into the Results ................... 195
- Troubleshooting: Working with Results ................... 197

## Chapter 13 / Managing SAS Content

- Working with Favorites ...................................... 201
- Managing Jobs .................................................. 202
- Scheduling a Time to Refresh SAS Content ............... 204
- Using the Manage Content Window ......................... 205
- Remove SAS Links ............................................ 205
- Setting the Properties of an Analysis or Data Source .... 206

## Appendix 1 / Customizing Styles

- About the Style Manager ...................................... 211
- Set a Default Style ........................................... 211
- Create a Copy of an Existing Style ......................... 212
- Edit an Existing Style ....................................... 212
- Create a New Style Based on an Existing Style .......... 213
- Add an External Style ....................................... 214
Overview

SAS Add-In 8, 8.1, and 8.2 for Microsoft Office is available in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, and Microsoft Outlook. Although some functionality is unique to a specific Microsoft Office application, most functionality is similar in each Microsoft application.

Here are the new features and enhancements in this release:

- a new user interface. For more information, see "New SAS Panel" on page 2.
- integration with SAS Visual Analytics 8.5 and earlier releases. For more information, see "Integration with SAS Visual Analytics" on page 2.
- general enhancements, such as the ability to customize the content on the Ribbon. For more information, see “General Enhancements” on page 3.
- changes to the automation interface to reflect the new user interface. For more information, see “Enhancements to Automation Interface” on page 3.

SAS Add-In 8.1 for Microsoft Office shipped in June 2019. Starting in this release, you can configure your site to access local PDF versions of the documentation. For more information, see “Access the Help Using Local PDF Files” in SAS Enterprise Guide and SAS Add-In for Microsoft Office: Administrator’s Guide.

SAS Add-In 8.2 for Microsoft Office shipped in November 2019 and runs on SAS 9.4, 9.3, and 9.2. It also runs on SAS Viya 3.4 and 3.5. Here are the new features in this release:

- integration with SAS Visual Analytics 8.5 and earlier releases.
ability to connect directly to workspace servers, including the workspace server on SAS Viya. For more information, see “Defining Workspace Servers” on page 12.

- accessibility improvements such as support for high contrast.

---

New SAS Panel

The new SAS panel consolidates all of the SAS add-in functionality, so you can quickly access everything in one place. The SAS panel contains these tabs:

- **From the Home tab**, you can view this information:
  - any sample SAS Visual Analytics reports from your SAS Demo server
  - any SAS content (such as data sources, reports, programs, and so on) that are currently open
  - any SAS content that you have recently opened
  - any tasks, reports, data sources, or stored processes that you have identified as favorites

- **From the Reports tab**, you can see all your server connections and their current status. Use this tab to open reports in SAS Add-In for Microsoft Office.

- **From the Tasks tab**, you can open any tasks that are shipped with the SAS add-in, any custom tasks that you have created, and any SAS Studio tasks (if SAS Studio is licensed and installed at your site).

- **The Results tab** shows all the reports that you have opened. This tab opens after you run a report, task, or stored process. You can interact with the report and select the report elements to include in the Office document.

- **The Programs tab** includes a code editor that you can use to write and run SAS programs. From this tab, you can view the SAS log and results. You can also select the elements of your program to include in the Office document.

- Use the **Search** tab to search all of the available servers for a report.

---

Integration with SAS Visual Analytics

The SAS add-in supports content from SAS Visual Analytics 8.4 and earlier releases. Starting in SAS Add-In 8.2 for Microsoft Office, support is added for SAS Visual Analytics 8.5.

- SAS Add-In for Microsoft Office is shipped with a default sample server. Sample reports from this server are available from the **Home** tab. If you remove a sample report or the sample server, click **Restore Sample Reports** in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “Customizing the Ribbon and the SAS Panel” on page 56.
If guest access is available, you can now log on to a SAS Visual Analytics Server as a guest. For more information, see “Define Your SAS Visual Analytics Profiles” on page 14.

When creating a server connection to a SAS Visual Analytics Server, you must include a description. By default, the description is userID@server. For more information, see “Define Your SAS Visual Analytics Profiles” on page 14.

The Server session locale option now specifies the locale for both the SAS Workspace Server and the SAS Visual Analytics Server. For more information, see “Setting the Advanced Options” on page 57.

Starting in SAS Add-In 8.2 for Microsoft Office, high contrast is supported.

General Enhancements

Here is the new and enhanced functionality for SAS Add-In 8 for Microsoft Office:

- The Automatically insert results into the Office document when opening a report option inserts the entire results into the current Office document when you first open the report. By default, the results are displayed only in the task pane. This option applies only when you are first opening a report. It does not apply when you refresh a report. For more information, see “Setting the Results Options” on page 35.

- Use the Number of recent tasks to display in the task browser option to specify the maximum number of tasks to display in the task browser. The default value is 15. For more information, see “Setting the Task Options” on page 54.

- You can now customize the menus on the SAS Ribbon. For more information, see “Customizing the Ribbon and the SAS Panel” on page 56.

- Starting in this release, KPI gauges are not inserted as a single screen shot into the document by default. Instead, these gauges are displayed on the Results tab in the SAS panel. To change this behavior, select the Include all KPI gauges when inserting into a document option. For more information, see “Setting the Results Options” on page 35.

- The SAS add-in now supports the EXCEL and POWERPOINT tagsets for the _ODSDEST= option, which is found in the code for many stored processes.

Enhancements to Automation Interface

For information about the automation interface, see SAS Add-In for Microsoft Office: Developer’s Guide.

The AutoInsertResultsIntoDocument option inserts the entire results into the current Office document when you first open the report. By default, the results are displayed only in the task pane. This option applies only when you are first opening a report. It does not apply when you refresh a report.
Starting in this release, the default value for the `DisplayAllKPIGauges` option is now `False`. KPI gauges are not inserted as a single screen shot into the document by default. Instead, these gauges are displayed on the `Results` tab in the SAS panel.

Because of changes in the user interface for the SAS add-in, these options are now obsolete:

- `CloseTaskBrowserOnOpen`
- `ShowPreviewChangesWindow`
- `PreviewVisualAnalyticsReports`
- `Word.InsertResultsIntoCurrentDoc`
- `Word.RTFStyle`
Introduction to SAS Add-In for Microsoft Office

About SAS Add-In for Microsoft Office

Note: SAS provides two add-ins for Microsoft Office: SAS Add-In for Microsoft Office and SAS Visual Analytics Add-In for Office. To determine which add-in you are running, see “Determining Your SAS Add-In” on page 6.

The functionality that is available in SAS Add-In for Microsoft Office varies between Microsoft applications. In general, the functionality of the SAS add-in is the same between Excel, PowerPoint, and Word. In all of these applications, you can run analyses, generate reports, and share this SAS content with other users at your site. You can also view SAS content from other SAS applications such as SAS Visual Analytics. You can monitor reports by using the SAS panel. In addition, in Microsoft Excel, you can open and edit data sources. Using Microsoft Outlook, you can share these reports through email, schedule meetings, and create tasks.

Here are some highlights of the functionality that is available by using SAS Add-In for Microsoft Office:

- Running analyses
  - dynamically execute stored processes and SAS tasks.
  - analyze SAS or Excel data by using tasks that are shipped with the SAS add-in, custom tasks that are created for SAS Enterprise Guide, or tasks that are shipped with SAS Studio.
  - write and run SAS code.
- Working with results
  - view and interact with reports created in SAS Visual Analytics.
  - embed the results in your documents and spreadsheets.
About SAS Visual Analytics Add-In for Office

The SAS Visual Analytics Add-In for Office enables you to perform these tasks:

- view and interact with reports created in SAS Visual Analytics.
- embed results from these reports in your Excel spreadsheets and PowerPoint presentations.
- refresh SAS content from a SAS Visual Analytics report to display the most up-to-date results.

SAS Visual Analytics Add-In for Office is not available in Microsoft Word or Outlook. It also does not include any functionality for working with SAS data or SAS tasks. For this functionality, you must use SAS Add-In for Microsoft Office.

Determining Your SAS Add-In

SAS provides two add-ins for Microsoft Office: SAS Add-In for Microsoft Office and SAS Visual Analytics Add-In for Office. For more information, see “About SAS Add-In for Microsoft Office” on page 5 and “About SAS Visual Analytics Add-In for Office” on page 6.

To determine which SAS add-in you are running:
1 On the SAS tab, click Help and select About SAS Add-In for Microsoft Office. The About dialog box appears.

2 Review the information in the About dialog box. You should see either “SAS Add-In for Microsoft Office” or “SAS Visual Analytics Add-In for Office.”

From the About dialog box, you can also view your site number and any configuration details, such as the locale for the metadata server.

---

Check for Software Updates

You can apply an update to SAS Add-In for Microsoft Office when you first open Excel, Word, PowerPoint, or Outlook or while you are working in these Microsoft Office applications. To apply a software update, you must close all Microsoft Excel, Word, PowerPoint, or Outlook applications.

To apply any hot fixes or software updates for the SAS add-in while you are working in Microsoft Excel, Word, PowerPoint, or Outlook:

1 Click the SAS tab on the Ribbon.

2 In the Tools group, click Help, and then select Check for Updates.

If an update is available, a message appears. In this message dialog box, a link to support.sas.com is available where you can learn more about the contents of this software update. Now, you can choose from these options:

- close all applications and install the update now
- continue working in the Microsoft Office application and receive a reminder about this update at a later time from SAS Add-In for Microsoft Office
- skip this update

Note: If the Check for Updates option is not available, your SAS administrator might have disabled this functionality. For more information, see SAS Intelligence Platform: Desktop Application Administration Guide.
Understanding Your Server Connections

From the Reports tab in the SAS panel, you can view your server connections and their status. In the SAS add-in, you can connect to one SAS metadata profile and multiple SAS Visual Analytics servers.

You can edit or create a server connection in these ways:

- From the SAS tab in the Ribbon, click Tools and select Connections.
In the Report tab of the SAS panel, click Manage Connections. The SAS Connections window appears. From this window, you can select your active profile, manage or create a metadata profile, and manage your SAS Visual Analytics profiles.

Metadata configuration information is shared between the Microsoft Office applications (Excel, Word, PowerPoint, and Outlook) where the SAS add-in is installed. This metadata information is also shared with SAS Enterprise Guide. Any changes that you make to your connection in SAS Add-In for Microsoft Office also appear in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, Microsoft Outlook, and SAS Enterprise Guide.

### Working with the SAS Metadata Server

#### About the SAS Metadata Server

The SAS Connections window displays which metadata server you are currently connected to and includes information about that connection. You can also connect to a metadata cluster, which contains multiple servers. Any specifications that you make in the SAS Connections window are valid for your current and future Microsoft Excel, Microsoft Word, Microsoft PowerPoint, and Microsoft Outlook sessions.

Metadata configuration information is shared between the Microsoft Office applications (Excel, Word, PowerPoint, and Outlook) where the SAS add-in is installed. This metadata information is also shared with SAS Enterprise Guide. Any changes that you make to your connection in SAS Add-In for Microsoft Office will also appear in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, Microsoft Outlook, and SAS Enterprise Guide.

#### Examine Your Connection

To examine your connection:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Connections.

2. In the SAS Connections window, click Manage. The Connections window appears.

3. From the selection pane, select these items:
   - Profiles to add, modify, or delete a profile. You can also specify the active profile.
   - Servers to add, edit, or edit workspace servers and specify a default server.
   - Updates to specify whether to automatically update the configuration.
Understanding Metadata Profiles

What Is a Metadata Profile?

A metadata profile defines the connection between SAS Add-In for Microsoft Office and a SAS Metadata Server. The SAS Metadata Server contains metadata definitions for objects such as workspace servers, libraries, and users that are used by the SAS add-in and other SAS applications. The primary application for creating metadata definitions is SAS Management Console, which you can also use to define libraries, as well as servers, users, groups, and authorization settings.

Note: Metadata configuration information is shared between SAS Enterprise Guide and SAS Add-In for Microsoft Office. Any changes that you make to your profile in SAS Add-In for Microsoft Office will also appear in SAS Enterprise Guide.

If you use the SAS add-in without a profile, you can access only a SAS server installed on your local machine. You cannot define libraries or share SAS resources with other SAS applications.

Create a Metadata Profile

To create a profile:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Connections.

2. In the SAS Connections window, click Manage. The Connections window appears.

3. In the selection pane, click Profiles to open the Profiles panel.

4. Click Add to create a new profile. The Create Profile dialog box appears.

5. In the Name box, specify a name for the profile. This name must be unique.

6. (Optional) In the Description box, provide a brief description of the profile to help you know what this profile is for.

7. In the Machine area, specify the name and port of the server to connect to. You can connect to either your local computer or a remote computer.

   Note: If you are connecting to your local computer, then localhost is the default name. You cannot change this name.

8. (Optional) Select the Set proxy list for metadata server check box if you are trying to connect to a SAS deployment that is set up as a virtual application.
Note: If you select this option, contact your SAS administrator for the URLs to enter in this field. Separate multiple URLs by a semicolon (;).

9 Specify your user name and password for the computer that you are trying to connect to.

Note: If you are connecting to a Windows computer or some UNIX systems, you can select the Use Integrated Windows Authentication check box. When you select this option, SAS Enterprise Guide uses the Windows authentication of the user who is logged in to the computer. You can click Advanced to set these options:

- The security package, which is the security protocol that is used to authenticate logged-on users to the server. If you select Negotiate, the server negotiates with the client to use either the Kerberos or NTLM protocol.
- The service principal name (SPN), which is a string that specifies the server to connect to. Normally, this field is blank. You can specify an SPN if the server is not running as a local service or you are using a cluster of servers that need to be accessed using the same SPN. Use the format SAS/host:port.
- The security packages to use with the Negotiate protocol. The server tries to use the first package listed. If the first package is not supported, the server uses the second package.

10 In the Authentication Domain box, specify the authentication domain for the profile to allow resource use without prompting. When a user tries to use a resource (such as a server or library), the authentication domain of the resource is compared to the value that is specified in the profile. If the domains match, the user can access the resource without entering any credentials. If the domains do not match, then the user must enter a user name and password.

11 Click Save or Save and Connect to create the profile. The profile is now available from the Connections window.

Defining Workspace Servers

In SAS Enterprise Guide, you can connect directly to a SAS 9 or SAS Viya workspace server. You define these workspace servers in the Connections window.

To add a workspace server:

1 From the main menu in SAS Enterprise Guide, select Tools ⇒ Connections. The Connections window appears.

2 In the selection pane, select Servers.

3 Click Add.

4 Specify the configuration of the workspace server and click Save.

The new workspace server appears in the Additional SAS Workspace Servers pane.
Note: In SAS Viya 3.5, TLS and SSL are automatically configured for the SAS object spawner. To connect to the SAS Viya workspace server from SAS Enterprise Guide, you must install the appropriate certificates. For more information, see “TLS Support for the SAS Object Spawner (Programming-Only Deployment)” in SAS Viya Administration: Programming Run-Time Servers and “Add Your Certificates to the Windows CA Store” in Encryption in SAS.

---

Select Your Default Server

Using the Connections window, you can specify which server you want to access by default. You can specify your default server in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, or Microsoft Outlook. When you specify a connection in one Microsoft application, the same connection is automatically used in the other Microsoft applications. For example, when you select a default server in Excel, the same connection is used when you open Word, PowerPoint, or Outlook.

To select a default server:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Connections. The SAS Connections window appears.

2. In the SAS Connections window, click Manage. The Connections window appears.

3. In the selection pane, select Servers.

4. Select the default server for the active profile.

5. To automatically add the local SAS server to the list of servers, select the Automatically add local SAS server (if installed) to server list check box.

---

Update Your Configuration

In the Connections window, you can specify whether to automatically update the configuration for your connection. You can save your profiles in a configuration update file that is stored in a network location. If your version of the SAS add-in uses automatic updating, then the SAS add-in checks the contents of the configuration update file whenever the application starts. If you have made any changes to the profiles, those changes automatically appear in the SAS add-in.

To automatically update the configuration of your connection:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Connections. The SAS Connections window appears.

2. In the SAS Connections window, click Manage. The Connections window appears.

3. In the selection pane, select Updates. The Updates pane opens.

4. Select the Update configuration automatically check box.
5 In the **Location of update file** box, enter the location of the update file.

6 To update the configuration, click **Check for updates now**.

---

### Select Your Active SAS 9 Metadata Profile

Your SAS 9 metadata profile defines the connection between SAS Add-In for Microsoft Office and a SAS Metadata Server. Although you can define multiple metadata profiles, only one profile can be active at a time. To create a metadata profile, see Creating a metadata server connection.

To select your active profile:

1. From the drop-down list, select the SAS 9 metadata profile that you want to use. To create a new profile or modify an existing profile, click **Manage**.

2. After you select the profile from the drop-down list, click **Set Active**. When a profile is active, the icon appears next to the profile name.

---

**Note:** If you use the SAS add-in without a profile, you can access a SAS server installed on your local machine only. You cannot define libraries or share SAS resources with other SAS applications.

---

### Working with SAS Visual Analytics Profiles

#### Define Your SAS Visual Analytics Profiles

All the SAS Visual Analytics reports that you need might not be saved to the server associated with the SAS 9 metadata profile. From the SAS Connections window, you can define connections to any additional SAS Visual Analytics servers that you need to access.

To create a SAS Visual Analytics profile:

1. Under the **Additional Visual Analytics Profiles** heading, click **Add**. The Add a Profile dialog box appears.

2. Enter the connection information for the SAS Visual Analytics server. The server name is the URL to the SAS Visual Analytics server. Contact your SAS administrator for this URL.

3. Add a description. This description is required. By default, the description is `userID@server`.

4. (Optional) Select the **Log on as guest** check box for guest access to the specified server.
If guest access is not available, the SAS add-in displays a message about invalid user ID or password when trying to connect to the server.

- If guest access is available, you can browse the server to see the folders and reports that are available to guest users.

5 Enter your credentials for the specified server. You might choose to select the **Save password** check box.

- If you save your password and the authentication information is correct, the SAS add-in tries to connect to the server without prompting you for additional information.

- If you do not save your password, you are prompted for your password when the SAS add-in tries to connect to the server.

6 Click **OK**. This SAS Visual Analytics server should now appear in the **Additional Visual Analytics Profiles** box.

---

**Note:** If you are using a SAS Visual Analytics server as your metadata server, do not define the same server in the **Additional Visual Analytics Profiles** box.

---

**Connecting to a SAS Visual Analytics Profile**

The SAS add-in does not connect to the SAS Visual Analytics profile as soon as you define it in the SAS Connections window. You can create the connection by selecting the profile name and clicking **Connect**. You can also wait and have the SAS add-in create the connection when you try to access SAS content on that server, such as when you try to open a SAS Visual Analytics report.

Use these icons to determine the status of your connections:

- ✓ - The SAS add-in successfully connected to the server.
- ▲ - More information (such as your password) is needed to connect to the server.
- ✗ - The SAS add-in cannot connect to the server. Reasons that you might see this icon are that your password is invalid or the SAS add-in could not find the specified server.

---

**Logging On to a Server**

The SAS add-in automatically connects to the default metadata server, so you are not prompted for your user name and password. If your credentials cannot be authenticated, you are prompted for your credentials when you try to use a feature in SAS Add-In for Microsoft Office.

In the logon window, simply enter your user name and password. When you are logging on to the metadata server, you can also select the option to save the logon information so that you do not have to enter your user name and password each
time you log on. If you click Cancel in the logon window, you can access items on your local file system only.

---

**Note:** If you do not know your user name and password for the server, contact your system administrator.

---

### Migrating SAS Content

If you have a Microsoft Office document that contains SAS content that was generated using a previous release of the SAS add-in, you can open this document by using SAS Add-In 8.2 for Microsoft Office.

- When you refresh an item in the document, the SAS content from the previous release is automatically converted to the 8.2 format. After the content is refreshed using SAS Add-In 8.2 for Microsoft Office, you cannot refresh the data by using the previous release of the SAS add-in.

- Because of the similar file formats between the 8.2, 8.1, 8.0, 7.1, 6.1, and 5.1 releases, you can open a file that was created in a previous release in SAS Add-In 8.2 for Microsoft Office, and then you can open the file again in the previous release of the SAS add-in. However, if you open a document from a previous release in SAS Add-In 8.2 for Microsoft Office and add new content, do not reopen this document in a previous release of the SAS add-in.

- To ensure that you are using the latest version of the data, refresh any data sources in your document before you use this data in SAS Add-In 8.2 for Microsoft Office. For example, measures that were available to a PivotTable in a previous release might not be available in the 8.2 release because you are connecting to a different server for the 8.2 release. By refreshing your data, any measures that no longer exist are removed from the PivotTable.

- In general, refresh content from a previous release when you migrate the content to SAS Add-In 8.2 for Microsoft Office. When you initially refresh content from a previous release in SAS Add-In 8.2 for Microsoft Office, you might notice that the style for the output has changed. The location of the styles differs between releases of the SAS add-in, so when you initially refresh the content, the SAS add-in cannot find the style that you applied to the output. When you refresh the content again in SAS Add-In 8.2 for Microsoft Office, the SAS add-in uses the style that you previously selected.

To work around this problem, before refreshing the content that you have migrated from a previous release of the SAS add-in, select the content in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, and then click Properties. In the Properties dialog box, select the style that you want to use, and then refresh the content in 8.2.

To migrate multiple files or to remap references to metadata objects (such as servers, libraries, information maps, and stored processes), use the Migration Wizard. To run this wizard, double-click MigrationWizard.exe in the directory where SAS Add-In for Microsoft Office was installed. After you open the wizard, click Help for more information about the migration options.
Available Releases

You can have multiple releases of SAS Add-In for Microsoft Office installed on your computer. The release of the SAS add-in determines what SAS content you can access.

<table>
<thead>
<tr>
<th>Release of SAS Add-In for Microsoft Office</th>
<th>Supported SAS Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>8, 8.1, 8.2</td>
<td>SAS 9.2, 9.3, 9.4, 9.4M1, 9.4M2, 9.4M3, 9.4M4, and 9.4M5; SAS Viya</td>
</tr>
<tr>
<td>7.1</td>
<td>SAS 9.2, 9.3, 9.4, 9.4M1, 9.4M2, 9.4M3, 9.4M4, and 9.4M5</td>
</tr>
<tr>
<td>6.1</td>
<td>SAS 9.2, 9.3, 9.4, 9.4M1</td>
</tr>
<tr>
<td>5.1</td>
<td>SAS 9.2, 9.3, 9.4, 9.4M1</td>
</tr>
</tbody>
</table>

However, you can use only one release of the SAS add-in at a time. Using the SAS Add-In for Microsoft Office Utility, you can select which release of the SAS add-in to enable for selected Microsoft Office applications. Before you can enable or disable the SAS add-in in a Microsoft Office application, you must have run the SAS add-in in that application at least once.

**Note:** Anyone can use the SAS Add-In for Microsoft Office Utility to specify where to run the SAS add-in (in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, or Microsoft Outlook). However, you must have administrator privileges to change the active version of the SAS add-in. For example, to change the active version from 7.1 to 8, you must be an administrator.

You can access the SAS Add-In for Microsoft Office Utility through a user interface or through the command line.

Using the Interface for the SAS Add-In for Microsoft Office Utility

To use the SAS Add-In for Microsoft Office Utility to manage your installations:
1 In Windows Explorer, double-click on the SwitcherUtility.exe file in the C:\Program Files\SAS\AddInForMicrosoftOffice\ release-number directory. The SAS Add-In for Microsoft Office Utility appears.

2 Select the release of the SAS add-in that you want to use.

3 Select the check box of the Microsoft Office application where you want to enable the selected release of the SAS add-in. You can use only one release of the SAS add-in at a time on your computer, so the same release of the SAS add-in is used for all the selected applications.

For example, you might choose to enable SAS Add-In 8.2 for Microsoft Office in Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook, but you do not want to enable the SAS add-in in Microsoft Word.

4 Click OK.

Using the Command Line

To manage your installations from the command line:

1 At a DOS prompt, enter cd C:\Program Files\SAS\AddInForMicrosoftOffice\8 and press Enter.

2 Enter your command using the following syntax: SwitcherUtility.exe <release-number> <application> <silent>

Here is an explanation of each argument in this command:

release-number
   is the version of the SAS add-in that you want to enable. Valid options are 5.1, 6.1, 7.1, and 8.

application
   is the name of the Microsoft Office application. To enable a version of the SAS add-in in an application, enter +application-name. To disable a version of the SAS add-in in an application, enter -application-name. Valid options are Excel, PowerPoint, Word, and Outlook.

   For example, to enable SAS Add-In 8.2 for Microsoft Office in Excel, PowerPoint, and Outlook, and to disable the SAS add-in for Word, enter SwitcherUtility.exe 8.2 +Excel +PowerPoint +Outlook -Word.

silent
   specifies that no output is written to the DOS window. The SAS add-in installs silently.

To view the Help for the SAS Add-In for Microsoft Office Utility, use the ? or help argument.

You can specify multiple arguments at the command line. If you do not specify any arguments at the command line and enter only SwitcherUtility.exe, then the SAS Add-In for Microsoft Office Utility appears.
Loading and Unloading the SAS Add-In

You can load and unload the SAS add-in from your Microsoft Excel, Microsoft Word, or Microsoft PowerPoint sessions without installing or uninstalling the SAS add-in. If you experience performance or memory problems, then you might want to unload the SAS add-in when you are not using it. Unloading the SAS add-in does not uninstall it. When you unload the SAS add-in, you simply remove its menus and commands from the interface. The SAS add-in is still installed on your computer, it is just not active. If you want to make the SAS add-in active again, then you can simply reload it.

To load or unload the SAS add-in from Microsoft Excel, Word, or PowerPoint:

1. In Microsoft Office, select File → Options. The Options dialog box for that application appears.
2. In the selection pane, select Add-Ins.
3. From the Manage drop-down list, select COM Add-ins and click Go. The COM Add-Ins dialog box appears.
4. In the Add-Ins available list, select SAS Add-In 8.2 for Microsoft Office.
5. Click OK.

Using the SAS Grid Computing Environment

A SAS grid enables the workload from SAS Add-In for Microsoft Office to be distributed among multiple computers on a network, all under the control of SAS Grid Manager. SAS Grid Manager provides load balancing, policy enforcement, efficient resource allocation, prioritization, and a highly available analytic environment. SAS Grid Manager also separates the SAS applications from the infrastructure that is used to execute the applications.

To configure SAS tasks to run on the grid, open the SAS Add-In for Microsoft Office Options dialog box. On the Tasks panel, select the Use grid when available check box. For more information, see “Setting the Task Options” on page 54.

Note: If your site administrator sets the AMOGridPolicy to Force in SAS Management Console, then SAS Add-In for Microsoft Office always uses the grid, and the Use grid when available option is ignored.

For more information about the SAS grid computing environment, see Scalability and Performance Community and Grid Computing in SAS.
Connecting to the SAS Viya Environment

What Is SAS Viya?

The SAS Viya environment is the third generation of high-performance in-memory analytics. The high-performance processing power of SAS Viya is SAS Cloud Analytic Services (CAS). CAS is a server that provides the run-time environment for data management and analytics with SAS. (Run-time environment refers to the combination of hardware and software where data management and analytics take place.)

For more information about the SAS Viya environment and programming in CAS, see these resources:

- SAS Cloud Analytic Services: User’s Guide
- An Introduction to SAS Viya Programming
- SAS Cloud Analytic Services: Fundamentals

Note: If your site has licensed and installed SAS 9.4M5 and SAS Viya, use this code to connect and manage your CAS sessions. If you are connecting to a server that is running SAS 9.4M4 or earlier, you can use SAS/CONNECT to submit code to a SAS Viya environment. For more information, see SAS/CONNECT User’s Guide

Connect to the CAS Server

To work with SAS Viya in SAS Add-In for Microsoft Office, your first step is to create a connection.

1. To open the Program Editor, click Programs on the SAS tab.
2. To create a connection to the CAS server, enter this code: `options cashost="<cas-server-name>" casport="<port-number>"; cas;` 
3. Click Run.

Create a CAS Session

In SAS Cloud Analytic Services, sessions are used to enable clients to communicate with the server to request actions. To use CAS, you explicitly start a session with the CAS server.
You use the CAS statement to create a session. Run this code in the Program Editor:

```
cas myCasSession;
```

For more information, see the “CAS Statement” in *SAS Cloud Analytic Services: User’s Guide*.

---

Disconnected from a CAS Session

To save resources, disconnect from your CAS session after you have finished your work. Run this code in the Program Editor:

```
cas myCasSession disconnect;
```
Using the SAS Add-In

Using the SAS Tab

In Microsoft Excel, Word, PowerPoint, and Outlook, the SAS add-in is available from the SAS tab on the Ribbon. The SAS functionality is organized into groups. The General and Tools groups should always be available. The Selection group is available in Excel, Word, and PowerPoint. Additional groups (and options) become available as you select SAS content or work with data in Microsoft Excel.

You can also customize the contents of the ribbon. For more information, see “About Customizing SAS Add-In for Microsoft Office” on page 27.

Note: If any options on the Quick Access Toolbar are enabled, these options do not apply to SAS content. You cannot save SAS content by using the options on the Quick Access Toolbar.

About the SAS Panel

From the SAS panel, you can quickly access sample reports from SAS Visual Analytics, reports, tasks, and programs. To open the SAS panel, click Home from the SAS tab on the Ribbon.

These tabs are available from the SAS panel:
The **Home** tab appears first. From this tab, click to view this information:

- any sample SAS Visual Analytics reports from your SAS Demo server
- any SAS content (such as data sources, reports, programs, and so on) that are currently open
- any SAS content that you have recently opened
- any tasks, reports, data sources, or stored processes that you have identified as favorites

From the **Reports** tab, you can see all your server connections and their current status. Use this tab to open reports. For more information, see "About Reports" on page 153.

From the **Tasks** tab, you can open any tasks that are shipped with the SAS add-in, any custom tasks that you have created, and SAS Studio 3.7 and 3.8 tasks (if SAS Studio is licensed and installed at your site). For more information, see “Accessing Tasks” on page 137.

The **Results** tab shows all the reports that you have opened. This tab opens after you run a report, task, or stored process.

The **Programs** tab includes a code editor that you can use to write and run SAS programs. From this tab, you can also view the log and results. For more information, see “About the SAS Program Editor” on page 169.

Use the **Search** tab to search all of the available servers for a report.
Understanding Role-Based Settings in the SAS Add-In

Because SAS Add-In for Microsoft Office is used by a variety of people and groups within an organization, your administrator might choose to restrict the menu items and functionality that users can access. By default, the SAS add-in is shipped with several default roles. These roles manage the availability of application features, called capabilities.

By using SAS Management Console, your administrator for SAS Add-In for Microsoft Office can modify these roles and specify the capabilities that are available to users at your site. For example, your administrator might want to restrict
who can save content to SAS Folders or who can open OLAP cubes. As a result, all
of the capabilities that are documented in the Help might not be available to you.

To view the capabilities that are available to you:

1. Click the **SAS** tab. In the **Tools** group, click **Connections**.

2. If a profile has defined capabilities, click **View Capabilities** to view a list of all the
capabilities and to determine which capabilities are available to you.

If you are authorized to use a capability, **Yes** appears in the **Authorized** field. To
enable a capability in your copy of the SAS add-in, contact your administrator for
SAS Add-In for Microsoft Office.

---

**Note:** Some capabilities are available only in specific Microsoft Office applications.
Therefore, according to the Function Settings dialog box, you might be authorized to
use a capability, but that functionality is not available in the current Microsoft Office
application.

---

For more information, see “Working with Roles and Capabilities” in SAS Enterprise
About Customizing SAS Add-In for Microsoft Office

The SAS Add-In for Microsoft Office Options dialog box enables you to change options that affect the entire SAS add-in.

To change an option:

1. Click the SAS tab on the Ribbon.
2. In the Tools group, click Tools and select Options.

The SAS Add-In for Microsoft Office Options dialog box options opens. The available options depend on your Microsoft Office application.

The Reset All button resets all of the options to their default settings. Any options that are common across Microsoft Excel, Microsoft Word, Microsoft PowerPoint, and Microsoft Outlook are reset, even if that application is not currently running. Options that are unique to the applications that are not running are not reset. For example, if you click Reset All in Excel, then all of the graph options that are the same in Excel,
Word, PowerPoint, and Outlook are reset (even though you are not running Word or PowerPoint). However, any options that are unique to Word, PowerPoint, or Outlook are not reset.

Setting the Data Options

Data Options in Microsoft Excel

Table 5.1 Setting General Data Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display labels instead of variable names</td>
<td>Specifies that you want the variables displayed by the labels that are specified in the data source. If you do not select this option, then the variable names are displayed. This option affects any dialog box or window that contains a list of variables, such as the Modify Data Source window.</td>
</tr>
<tr>
<td>Sort variables in alphabetical order</td>
<td>Specifies whether variables should be displayed in alphabetical order. If you do not select this option, then the variables are sorted in the order in which they appear in the data source. This option affects any dialog box or window that contains a list of variables, such as the Tasks tab in the SAS panel and the Modify Data Source window.</td>
</tr>
<tr>
<td>Show details of data sets in the File dialog box</td>
<td>Specifies whether to display additional details, such as Date Created and Date Modified, for each data set in the selected SAS library. These details are available when you use the Details view in the Open Data Source dialog box. This option is not selected by default. Selecting this option can slow the performance of this dialog box.</td>
</tr>
<tr>
<td>Display aggregated values when opening information maps</td>
<td>Specifies whether the Display aggregated values (group by category) check box in the Filter &amp; Sort dialog box is selected. This global option specifies the aggregated value for all information maps that you open. If you set this global option but do not want to display the</td>
</tr>
</tbody>
</table>
Option Name | Description
--- | ---
aggregated values for a specific information map, use the **Display aggregated values (group by category)** option in the Open Information Map dialog box. By default, the **Display aggregated values when opening information maps** check box is selected. For more information, see “Selecting the Data Items to Include in the Output” on page 76.

**Number of distinct values for filter** | Specifies the number of distinct values to display in the Modify Data Source window. You display values in the Modify Data Source window when you are creating a simple filter. The default value is 25.

Each time you click **More Values** on the **Filter** tab, an additional set of values is displayed. For example, if you specify 150 in the **Number of distinct values for filter** box, then 150 distinct values are displayed initially on the **Filter** tab. Each time you click **More Values** on the **Filter** tab, an additional 150 distinct values are displayed.

**Maximum number of rows to process for distinct value requests** | Specifies the number of rows that are processed when distinct values are retrieved. By default, the SAS add-in processes 100,000 rows when you request distinct values. Setting this limit to a very large number allows more rows to be processed. However, this action decreases performance when you are requesting distinct values from a large table.

---

**Table 5.2 Setting Display Options**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display data source and filter information on the status bar</strong></td>
<td>Displays the name of the input data source and any filter information on the Excel status bar by default. <strong>Note:</strong> You must select this option to view the input data source for a PivotTable. If you are working with SAS data in an Excel worksheet, then the name of the input data source is...</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Labels in first row for Excel data sources</strong></td>
<td>Specifies whether labels are in the first row of the Excel data. This option is selected by default, and the labels are used as labels for the variables in the tasks. If you do not have labels in the first row of your Excel data, clear this check box.</td>
</tr>
<tr>
<td><strong>Open data into an Excel Table</strong></td>
<td>Opens the data source into an Excel table. If you do not select this option, then the data is opened into Excel using the SAS formatting.</td>
</tr>
<tr>
<td><strong>Formatting</strong></td>
<td>Specifies how to format the data when displayed in Excel. By default, the SAS add-in selects the format to use. You can specify whether to display the raw (or unformatted) values or the presented (or formatted) values.</td>
</tr>
<tr>
<td><strong>Close edited data after period of inactivity</strong></td>
<td>Specifies that the SAS add-in should exit Edit mode if no changes have been made to the data in $n$ minutes. For more information, see “Edit a SAS Data Set in Microsoft Excel” on page 63.</td>
</tr>
</tbody>
</table>

Table 5.3  Setting Recent Data Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of items to display in recent data list</strong></td>
<td>Specifies the number of data sources that should be available from the Data drop-down list in the View SAS Data dialog box. By default, the last 10 data sources are available from the drop-down list.</td>
</tr>
<tr>
<td><strong>Clear History</strong></td>
<td>Removes all of the data sources from the Data drop-down list in the View SAS Data dialog box.</td>
</tr>
</tbody>
</table>

Table 5.4  Setting Options for Output Data Sets

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open output data automatically</strong></td>
<td>Specifies that any output data that is generated by a task be opened automatically. If the task also generates</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Open output data into pivot table</strong></td>
<td>Specifies that any output data that is generated by a task be opened in a pivot table (instead of a table in a Microsoft Excel worksheet). If the task also generates results (for example, HTML output), then those results are displayed first and the output data is inserted after the results.</td>
</tr>
<tr>
<td><strong>Show record numbers</strong></td>
<td>Specifies whether to show the record number in the first column of your worksheet. If you are working with a filtered data source, then the record numbers reflect the observation numbers that are in the filtered view of the SAS data source. Displaying the record number enables you to keep track of the rows in the data easily.</td>
</tr>
<tr>
<td><strong>Show data set and filter information in the worksheet</strong></td>
<td>Specifies to display the filter in the first line of the output data set.</td>
</tr>
<tr>
<td><strong>Number of records to display</strong></td>
<td>Specifies the number of records to display in your output data. By default, this value is set to 500. The maximum value that you can set for this field depends on your version of Microsoft Excel.</td>
</tr>
</tbody>
</table>

Table 5.5  Setting OLAP Data Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatically select fields for OLAP PivotTables</strong></td>
<td>Specifies whether the SAS add-in should automatically define the layout of a PivotTable when the input data source is an OLAP cube. By default, this option is not selected, so an empty PivotTable is created. You must assign variables from the OLAP cube to the fields in the PivotTable. When this option is selected, the SAS add-in automatically defines the layout when the OLAP cube is opened into a PivotTable.</td>
</tr>
</tbody>
</table>

OLAP Analyzer Options enables you to customize the options for the OLAP Analyzer. For more information, see “Setting OLAP Analyzer Options” on page 134.
### Table 5.6 Setting Security Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persist credentials for SAS data sets</td>
<td>Specifies the duration of security credentials for password-protected data. You can choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>- Persist during session - credentials do not need to be re-entered for the duration of the current session.</td>
</tr>
<tr>
<td></td>
<td>- Persist with Office document - credentials need to be entered only once for a Microsoft Office document.</td>
</tr>
<tr>
<td></td>
<td>- Persist for user - credentials need to be entered only once on a machine for the user that is logged on.</td>
</tr>
<tr>
<td></td>
<td>After you have opened a data source that is password-protected, click <strong>Clear</strong> to delete any passwords that are stored in Windows or in the current workbook.</td>
</tr>
</tbody>
</table>

### Data Options for Microsoft Word and Microsoft PowerPoint

### Table 5.7 Setting General Data Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display labels instead of variable names</td>
<td>Specifies that you want the variables displayed by the labels that are specified in the data source. If you do not select this option, then the variable names are displayed. This option affects any dialog box or window that contains a list of variables, such as the <strong>Modify Data Source</strong> window.</td>
</tr>
<tr>
<td>Sort variables in alphabetical order</td>
<td>Specifies whether variables should be displayed in alphabetical order. If you do not select this option, then the variables are sorted in the order in which they appear in the data source. This option affects any dialog box or window that contains a list of variables, such as the <strong>Tasks</strong> tab in the SAS panel and the <strong>Modify Data Source</strong> window.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show details of data sets in the File dialog box</td>
<td>Specifies whether to display additional details, such as Date Created and Date Modified, for each data set in the selected SAS library. These details are available when you use the Details view in the <strong>Open Data Source</strong> dialog box. This option is not selected by default. Selecting this option can slow the performance of this dialog box.</td>
</tr>
<tr>
<td>Display aggregated values when opening information maps</td>
<td>Specifies whether the <strong>Display aggregated values (group by category)</strong> check box in the Filter &amp; Sort dialog box is selected. This global option specifies the aggregated value for all information maps that you open. If you set this global option but do not want to display the aggregated values for a specific information map, use the <strong>Display aggregated values (group by category)</strong> option in the Open Information Map dialog box. By default, the <strong>Display aggregated values when opening information maps</strong> check box is selected. For more information, see “Selecting the Data Items to Include in the Output” on page 76.</td>
</tr>
<tr>
<td>Number of distinct values for filter</td>
<td>Specifies the number of distinct values to display in the Modify Data Source window. You display values in the Modify Data Source window when you are creating a simple filter. The default value is 25. Each time you click <strong>More Values</strong> on the <strong>Filter</strong> tab, an additional set of values is displayed. For example, if you specify 150 in the <strong>Number of distinct values for filter</strong> box, then 150 distinct values are displayed initially on the <strong>Filter</strong> tab. Each time you click <strong>More Values</strong> on the <strong>Filter</strong> tab, an additional 150 distinct values are displayed.</td>
</tr>
<tr>
<td>Maximum number of rows to process for distinct value requests</td>
<td>Specifies the number of rows that are processed when distinct values are retrieved. By default, the SAS add-in processes 100,000 rows when you request distinct values. Setting this limit to a very large number allows more rows to be processed. However, this action decreases performance when you are</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of items to display in recent data list</td>
<td>Specifies the number of data sources that should be available from the Data drop-down list in the View SAS Data dialog box. By default, the last 10 data sources are available from the drop-down list.</td>
</tr>
<tr>
<td>Clear History</td>
<td>Removes all of the data sources from the Data drop-down list in the View SAS Data dialog box.</td>
</tr>
</tbody>
</table>

**Table 5.8  Setting Recent Data Options**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persist credentials for SAS data sets</td>
<td>Specifies the duration of security credentials for password-protected data. You can choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Persist during session</strong> - credentials do not need to be re-entered for the duration of the current session.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Persist with Office document</strong> - credentials need to be entered only once for a Microsoft Office document.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Persist for user</strong> - credentials need to be entered only once on a machine for the user that is logged on.</td>
</tr>
<tr>
<td></td>
<td>After you have opened a data source that is password-protected, click <strong>Clear</strong> to delete any passwords that are stored in Windows or in the current workbook.</td>
</tr>
</tbody>
</table>
Setting the Results Options

Results Options in Microsoft Excel

Table 5.10  Setting General Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically insert results into the Office document when opening a report</td>
<td>Inserts the entire results into the current Office document when you first open the report. By default, the results are displayed only in the task pane. This option applies only when you are first opening a report. It does not apply when you refresh a report.</td>
</tr>
<tr>
<td>Show status window</td>
<td>Specifies that the SAS Status window is always displayed. The SAS Status window enables you to monitor the status of jobs that are being refreshed.</td>
</tr>
<tr>
<td>Prompt before opening results larger than $n$ KB</td>
<td>Specifies that you want a confirmation window to be displayed when you attempt to open results that are larger than $n$ kilobytes (KB). The valid range of values is from 0 to 1,000,000 KB. The default value is 1,000 KB.</td>
</tr>
<tr>
<td>Note: Opening large worksheets can be a time-intensive operation</td>
<td></td>
</tr>
</tbody>
</table>

Table 5.11  Setting Options for SAS Results

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show SAS log</td>
<td>Specifies that the SAS log, which is generated when you run a stored process or SAS task, is always displayed. If you select this option, the SAS log is displayed even if there are no errors when you run a stored process or task. The SAS log appears in a separate window called the SAS Add-In Log window.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Results Format</td>
<td>Specifies the format of the results from a task, a stored process, or a SAS Web Report Studio report. You can choose from these formats:</td>
</tr>
<tr>
<td></td>
<td>- <strong>SAS Report</strong> - generates the results as a SAS Report. This is the default results format. Use the <strong>Apply the SAS style to the results</strong> option to specify whether to apply a style to the results. For more information, see “About the Apply the SAS Style to the Results Option” on page 41.</td>
</tr>
<tr>
<td></td>
<td>- <strong>HTML</strong> - generates the results in HyperText Markup Language (HTML) format. Select the style for the results from the <strong>Style</strong> drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>CSV</strong> - generates the results in Comma-Separated Values (CSV) format. When you select CSV, no graphs are generated. Only tables can be displayed in the CSV format. If you are generating large tables, remember that Excel displays large tables more quickly in the CSV format than in other formats.</td>
</tr>
</tbody>
</table>

Note: The **CSV** option is available only in Microsoft Excel.

Note: The **Style** drop-down list includes the styles that are supplied by SAS, as well as any custom styles that you create using the Style Manager. To open the Style Manager, click **Manage Styles**. For more information, see “Applying Styles to the Results” on page 191.

Note: Microsoft Office does not support images as part of the background of styles. Therefore, if you select a style that uses an image as part of the background, the image is not displayed in the background of your results. Also, in Microsoft Excel, a color palette with only 56 colors is used. If you want to display a specific RGB color, you must replace another color on the color palette with the one that you want to add. For more information about how to change the color palette for a workbook, see the Help for Microsoft Excel.
### Option Name: Graph Format

**Description:**

Specifies the image format that you want to use for the graphical report output that is generated by a stored process or SAS task.

The image format is saved with the results. If you change the image format, then this new format is used in any future results. The new format is not applied to any existing graphical report output.

When you select an image format, consider the output type of the stored process, as well as your personal preference. For more information, see “Output Types for Stored Processes” on page 161.

Additional items to consider when selecting the image format:

- Unlike the other image formats, if you use the ActiveX format, you can change the appearance of a graph after you have generated it. However, these changes are temporary and are not saved with the results. Therefore, when you close the results, forward the results in an email, or send the results to another Microsoft application, the changes do not persist.

- Third-party ActiveX controls are not supported in 64-bit versions of Microsoft Office. If you are running in a 64-bit environment, use the ActiveX image format.

- Images in the ActiveX format must be generated and viewed on Windows. These images cannot be generated or viewed in UNIX or z/OS environments.

- You cannot generate ActiveX image results from a stored process in UNIX or z/OS environments. You can generate the ActiveX image results in a Windows environment, and then view these results in UNIX or z/OS environments.

- If a stored process generates PNG, JPG, or GIF results, then these files are stored in subdirectories of SAS Add-In for Microsoft Office directory, which is typically `C:\Documents and`
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply SAS ActiveX graph settings during refresh</strong></td>
<td>Initializes the Use graph settings generated by SAS option for results that use the ActiveX graph format. If you select this option, the Use graph settings generated by SAS option (that is available from the Properties dialog box for the selected results) is automatically set. If you do not select this option, the Use graph settings generated by SAS option is not selected. For more information, see “Setting the Appearance Properties” on page 207.</td>
</tr>
<tr>
<td><strong>Graph size</strong></td>
<td>Specifies the width and height for the images that are displayed in your graphical report output. To use the best fit determined for your images, select Automatic. To specify a width and height to use for your images, select Custom.</td>
</tr>
</tbody>
</table>

**Table 5.12  Setting Options for SAS Visual Analytics Reports**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display filters for Visual Analytics reports</strong></td>
<td>Displays the information for any specified filters before a report element in a SAS Visual Analytics report. If you are opening a crosstabulation report, the filter also includes any breadcrumbs. (An example of a breadcrumb is All Geographies &gt; North America &gt; United States.) The filters are created by the report author in SAS Visual Analytics. When the report is opened in the SAS add-in, you can use this filter to subset the data in the SAS Visual Analytics report. For example, you open a report that uses the Sasshelp.Class data set. When this report was created, the report author defined a filter called Gender. When you preview the report contents in SAS Add-In for Microsoft Office, you set Gender = “F,” so only those data values appear in the report element that you add to the Microsoft Office document.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Include all KPI gauges when inserting into a document</td>
<td>Displays all of the KPI gauges in a single screenshot. If this option is not selected, the gauges are displayed in a page. The number of gauges displayed on a page is determined by the maximum number of rows and columns specified for the SAS Visual Analytics report.</td>
</tr>
<tr>
<td>Save the full report state within the Office document</td>
<td>Specifies whether to save all the information needed to open the report. The full report state includes all the data and any interactions that you made with the report. (Examples of interactions are graph selections, any table sorting, any prompt values, drilling, or any expanded or collapsed sections). By default, the SAS add-in saves the full report state. As a result, when you reopen an Office document, the report in the document matches the report in the report controls panel. However, some reports can be quite large. Saving the full report state could result in an out-of-memory error when you save the workbook. To reduce the amount of memory used and to reduce the size of the workbook, clear the <strong>Save the full report state within the Office document</strong> check box. Now, the SAS add-in saves the user state, which includes any prompt values, any table sorting, and any expanded or collapsed sections. When you reopen the Office document, the report in the document might not match the report in the report controls panel. To synchronize the report in the document with the report in the report controls panel, click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>Apply style to Visual Analytics Reports</td>
<td>Specifies whether to apply a style to the results. The style is determined by the report, not by the options that you selected in the SAS Add-In for Microsoft Office Options dialog box.</td>
</tr>
<tr>
<td>Graph size</td>
<td>Specifies the width and height for the images that are displayed in your graphical report output. By default, the size is defined when you create the SAS Visual Analytics report. To specify a width and height to use for your images, select <strong>Custom</strong>.</td>
</tr>
</tbody>
</table>
### Table 5.13  Setting the Excel Location for the Results

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place grouped analyses on new worksheets</td>
<td>Specifies that a new worksheet be created for each unique value of the GROUP BY variable. GROUP BY variables are used by SAS tasks and stored processes. For example, you can assign a variable to the group by role when you run a SAS task. If you assign the Country variable to the <strong>Group charts by</strong> role in the Bar Chart task, then the bar chart for each country is placed on a new worksheet.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only if you selected SAS Report as the format for the results.</td>
</tr>
<tr>
<td>Show placeholder for results with no visual output</td>
<td>Specifies that a placeholder be inserted if the results contain no visual output. In Excel, the placeholder displays the name of the job and the time at which the job ran.</td>
</tr>
</tbody>
</table>

### Table 5.14  Setting Options for Table Values

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use raw values in SAS Report tables</td>
<td>Specifies how values are formatted in the results. By default, this option is selected and the formatting is done by Microsoft Excel or the SAS add-in. If you clear this option, then the formatting occurs on the server and the formatted value is returned to Excel.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only if you selected SAS Report as the format for the results.</td>
</tr>
<tr>
<td>Allow Excel to interpret value types in SAS Report tables</td>
<td>Prompts Microsoft Excel to try to interpret all values in a SAS Report table. If you deselect this option, then any character values are marked as text in Microsoft Excel. As a result, these text values cannot be used in any Excel formulas. You might want to deselect this option if your data contains leading zeros that need to be preserved.</td>
</tr>
</tbody>
</table>
### Table 5.15  Setting Options for Excel Integration

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Microsoft Excel charts when possible</td>
<td>Displays the results by using the charts in Microsoft Excel. (This option is available only in Microsoft Excel.) For more information, see “Creating Microsoft Excel Charts” on page 141. By default, this option is not selected, and the charts in the results use the value that you selected from the Format drop-down list. Note: To use native charts, your results format must be SAS Report.</td>
</tr>
<tr>
<td>Preserve Excel formats during refresh</td>
<td>Specifies that any Excel formats are saved when you refresh the SAS content.</td>
</tr>
</tbody>
</table>
Microsoft PowerPoint, your modifications are overwritten when you run the task again and the SAS style is reapplied.

### About the Apply Style to Visual Analytics Reports Option

The **Apply style to Visual Analytics Reports** option specifies whether to apply a style to the results. The style is determined by the report, not by the options that you selected in the SAS Add-In for Microsoft Office Options dialog box. If your SAS Visual Analytics report contains any graphical output, this output is an image. Any graphical output always uses the style specified by the SAS Visual Analytics report.

You can choose from these options:

- **Never** specifies that no style is applied. If you modify the report by using the styles in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, your modifications are not overwritten.
- **When inserting content only** specifies that the style is applied when the report is inserted into the Microsoft Office document.
- **When inserting and refreshing content** specifies that the style is applied when the report is inserted in the Microsoft Office document and when the report is refreshed. If you select this option, the style is always applied to the report. If you modify the report by using the styles in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, your modifications are overwritten when you run the report again and the report style is reapplied.

### Setting the Results Options for Microsoft PowerPoint

**Table 5.16 Setting General Options**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically insert results into the Office document when opening a report</td>
<td>Inserts the entire results into the current Office document when you first open the report. By default, the results are displayed only in the task pane. This option applies only when you are first opening a report. It does not apply when you refresh a report.</td>
</tr>
<tr>
<td>Show status window</td>
<td>Specifies that the SAS Status window is always displayed. The SAS Status window enables you to monitor the status of jobs that are being refreshed.</td>
</tr>
<tr>
<td>Prompt before opening results larger than n KB</td>
<td>Specifies that you want a confirmation window to be displayed when you attempt to open results that are larger than n kilobytes (KB). The valid range of values</td>
</tr>
</tbody>
</table>
Option Name | Description
---|---
| is from 0 to 1,000,000 KB. The default value is 1,000 KB.
| Note: Opening large worksheets can be a time-intensive operation.

Table 5.17  Setting Options for SAS Results in Microsoft PowerPoint

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show SAS log</td>
<td>Specifies that the SAS log, which is generated when you run a stored process or SAS task, is always displayed. If you select this option, the SAS log is displayed even if there are no errors when you run a stored process or task. The SAS log appears in a separate window called the SAS Add-In Log window.</td>
</tr>
</tbody>
</table>
| Graph Format | Specifies the image format that you want to use for the graphical report output that is generated by a stored process or SAS task. The image format is saved with the results. If you change the image format, then this new format is used in any future results. The new format is not applied to any existing graphical report output. When you select an image format, consider the output type of the stored process, as well as your personal preference. For more information, see Output types for stored processes. For more information, see “Output Types for Stored Processes” on page 161. Additional items to consider when selecting the image format:  
  - Unlike the other image formats, if you use the ActiveX format, you can change the appearance of a graph after you have generated it. However, these changes are temporary and are not saved with the results. Therefore, when you close the results, forward the results in an email, or send the results to another Microsoft application, the changes do not persist.  
  - Third-party ActiveX controls are not supported in 64-bit versions of... |
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office. If you are running in a 64-bit environment, use the ActiveX image format.</td>
<td></td>
</tr>
<tr>
<td>Images in the ActiveX format must be generated and viewed on Windows. These images cannot be generated or viewed in UNIX or z/OS environments.</td>
<td></td>
</tr>
<tr>
<td>You cannot generate ActiveX image results from a stored process in UNIX or z/OS environments. You can generate the ActiveX image results in a Windows environment, and then view these results in UNIX or z/OS environments.</td>
<td></td>
</tr>
<tr>
<td>If a stored process generates PNG, JPG, or GIF results, then these files are stored in subdirectories of SAS Add-In for Microsoft Office directory, which is typically C:\Documents and Settings\username\My Documents\My SAS Files\Add-In for Microsoft Office. Deleting the PNG, JPG, or GIF files, or directories that contain these files, causes your results to display improperly.</td>
<td></td>
</tr>
<tr>
<td><strong>Apply SAS ActiveX graph settings during refresh</strong></td>
<td>Initializes the Use graph settings generated by SAS option for results that use the ActiveX graph format. If you select this option, the Use graph settings generated by SAS option (that is available from the Properties dialog box for the selected results) is automatically set. If you do not select this option, the Use graph settings generated by SAS option is not selected. For more information, see “Setting the Appearance Properties” on page 207.</td>
</tr>
<tr>
<td><strong>Graph size</strong></td>
<td>Specifies the width and height for the images that are displayed in your graphical report output. To use the best fit determined for your images, select Automatic. To specify a width and height to use for your images, select Custom.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display filters for Visual Analytics reports</td>
<td>Displays the information for any specified filters before a report element in a SAS Visual Analytics report. If you are opening a crosstabulation report, the filter also includes any breadcrumbs. (An example of a breadcrumb is All Geographies &gt; North America &gt; United States.) The filters are created by the report author in SAS Visual Analytics. When the report is opened in the SAS add-in, you can use this filter to subset the data in the SAS Visual Analytics report. For example, you open a report that uses the Sashelp.Class data set. When this report was created, the report author defined a filter called Gender. When you preview the report contents in SAS Add-In for Microsoft Office, you set Gender = “F,” so only those data values appear in the report element that you add to the Microsoft Office document.</td>
</tr>
<tr>
<td>Include all KPI gauges when inserting into a document</td>
<td>Displays all of the KPI gauges in a single screenshot. If this option is not selected, the gauges are displayed in a page. The number of gauges displayed on a page is determined by the maximum number of rows and columns specified for the SAS Visual Analytics report.</td>
</tr>
<tr>
<td>Save the full report state within the Office document</td>
<td>Specifies whether to save all the information needed to open the report. The full report state includes all the data and any interactions that you made with the report. (Examples of interactions are graph selections, any table sorting, any prompt values, drilling, or any expanded or collapsed sections). By default, the SAS add-in saves the full report state. As a result, when you reopen an Office document, the report in the document matches the report in the report controls panel. However, some reports can be quite large. Saving the full report state could result in an out-of-memory error when you save the workbook. To reduce the amount of memory used and to reduce the size of the workbook, clear the Save the full report state within the Office document check box.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>in</strong> saves the user state, which includes any prompt values, any table sorting, and any expanded or collapsed sections. When you reopen the Office document, the report in the document might not match the report in the report controls panel. To synchronize the report in the document with the report in the report controls panel, click <strong>Refresh</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Apply style to Visual Analytics Reports</strong></td>
<td>Specifies whether to apply a style to the results. The style is determined by the report, not by the options that you selected in the SAS Add-In for Microsoft Office Options dialog box.</td>
</tr>
<tr>
<td><strong>Graph size</strong></td>
<td>Specifies the width and height for the images that are displayed in your graphical report output. By default, the size is defined when you create the SAS Visual Analytics report. To specify a width and height to use for your images, select <strong>Custom</strong>.</td>
</tr>
</tbody>
</table>

Table 5.19  Setting the PowerPoint Location for the Results

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Place result on new slide</strong></td>
<td>Specifies that the results that you generated are placed on a new slide. If the layout is valid, the layout of the new slide matches the layout of the previous slide. If the layout is not valid, the layout of the new slide contains a standard title element with one object placeholder. By default, the results are added to the current slide.</td>
</tr>
<tr>
<td><strong>Honor placeholders in slide layout</strong></td>
<td>Specifies that the SAS output (table, graph, or image) is inserted into a placeholder on a slide. Where the content is inserted on the slide depends on the slide layout and whether an item is selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Layout of Current Slide</th>
<th>How the Results Are Inserted</th>
</tr>
</thead>
<tbody>
<tr>
<td>The slide is blank.</td>
<td>The results are inserted into the middle of the slide. New slides are created as needed to contain all of the results.</td>
</tr>
<tr>
<td>Layout of Current Slide</td>
<td>How the Results Are Inserted</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The slide contains a placeholder, but nothing is selected.</td>
<td>A text element that is not a title, filter, or error message is inserted into the selected placeholder or the first available placeholder.</td>
</tr>
<tr>
<td>The slide contains an object placeholder, but a non-object shape is selected.</td>
<td>The results are placed in the middle of the slide, as if the slide was blank.</td>
</tr>
<tr>
<td>The slide contains an object placeholder, and this placeholder is selected.</td>
<td>The first element of the results is inserted into the selected placeholder. Additional slides are added if needed. The new slides will have the same layout as the original slide.</td>
</tr>
<tr>
<td>The slide contains an object placeholder, but no item on the slide is selected and all the placeholders contain content.</td>
<td>A new slide with the identical layout is added, and the output is inserted into the new slide.</td>
</tr>
<tr>
<td>The slide layout contains no object placeholders.</td>
<td>The SAS add-in treats the output as if the placeholders were turned off, and the results are placed in the middle of the slide. The results might overlap any existing content.</td>
</tr>
</tbody>
</table>

**Note:** The size of the SAS output is limited by the size of the placeholder in the slide layout. If you change the slide layout, the size of the placeholder might change, but any existing SAS output is not resized.

**Table 5.20  Setting Options for Titles and Footnotes**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include SAS titles</td>
<td>Specifies that the SAS title for the results is displayed. The SAS add-in creates a new shape and places the title above the placeholder for the results. The title is centered directly above the output.</td>
</tr>
<tr>
<td></td>
<td>If you select the <strong>Use title placeholder</strong> check box, then the SAS title is inserted into the title placeholder on the slide. If the title placeholder is not empty, then the SAS add-in creates a shape and inserts the title in the new shape. To insert the SAS title in the title placeholder, delete any existing text and refresh your results. If you delete the title placeholder, it is not re-created.</td>
</tr>
</tbody>
</table>
**Option Name** | **Description**
--- | ---
Include footnotes | Specifies that the SAS footnotes for the results are displayed in the bottom center of the slide.

---

### Setting the Results Options for Microsoft Word

**Table 5.21  Setting General Options**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically insert results into the Office document when opening a report</td>
<td>Inserts the entire results into the current Office document when you first open the report. By default, the results are displayed only in the task pane. This option applies only when you are first opening a report. It does not apply when you refresh a report.</td>
</tr>
<tr>
<td>Show status window</td>
<td>Specifies that the SAS Status window is always displayed. The SAS Status window enables you to monitor the status of jobs that are being refreshed.</td>
</tr>
</tbody>
</table>
| Prompt before opening results larger than n KB | Specifies that you want a confirmation window to be displayed when you attempt to open results that are larger than \( n \) kilobytes (KB). The valid range of values is from 0 to 1,000,000 KB. The default value is 1,000 KB.  

Note: Opening large worksheets can be a time-intensive operation. |

---

**Table 5.22  Setting Options for SAS Results in Microsoft Word**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show SAS log</td>
<td>Specifies that the SAS log, which is generated when you run a stored process or SAS task, is always displayed. If you select this option, the SAS log is displayed even if there are no errors when you run a stored process or task. The SAS log appears in a separate window called the SAS Add-In Log window.</td>
</tr>
</tbody>
</table>
### Option Name | Description
--- | ---
**Results Format** | Specifies the format of the results from a task, a stored process, or a SAS Web Report Studio report. You can choose from these formats:

- **SAS Report** - generates the results as a SAS Report. This is the default results format. Use the **Apply the SAS style to the results** option to specify whether to apply a style to the results. For more information, see “About the Apply the SAS Style to the Results Option” on page 41.

- **HTML** - generates the results in HyperText Markup Language (HTML) format. Select the style for the results from the **Style** drop-down list.

**Note:** The **Style** drop-down list includes the styles that are supplied by SAS, as well as any custom styles that you create using the Style Manager. To open the Style Manager, click **Manage Styles**. For more information, see “Applying Styles to the Results” on page 191.

**Note:** Microsoft Office does not support images as part of the background of styles. Therefore, if you select a style that uses an image as part of the background, the image is not displayed in the background of your results.

**Graph Format** | Specifies the image format that you want to use for the graphical report output that is generated by a stored process or SAS task.

The image format is saved with the results. If you change the image format, then this new format is used in any future results. The new format is not applied to any existing graphical report output.

When you select an image format, consider the output type of the stored process, as well as your personal preference. For more information, see Output types for stored processes. For more information, see “Output Types for Stored Processes” on page 161.

Additional items to consider when selecting the image format:

- Unlike the other image formats, if you use the ActiveX format, you can change the appearance of a graph after you have generated it. However, these changes are temporary and are not saved with the results. Therefore, when you close the results, forward the results in an email, or send the results to another Microsoft application, the changes do not persist.

- Third-party ActiveX controls are not supported in 64-bit versions of Microsoft Office. If you are running in a 64-bit environment, use the ActiveX image format.
### Option Name

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images in the ActiveX format must be generated and viewed on Windows. These images cannot be generated or viewed in UNIX or z/OS environments.</td>
</tr>
<tr>
<td>You cannot generate ActiveX image results from a stored process in UNIX or z/OS environments. You can generate the ActiveX image results in a Windows environment, and then view these results in UNIX or z/OS environments.</td>
</tr>
<tr>
<td>If a stored process generates PNG, JPG, or GIF results, then these files are stored in subdirectories of SAS Add-In for Microsoft Office directory, which is typically <code>C:\Documents and Settings\username\My Documents\My SAS Files\Add-In for Microsoft Office</code>. Deleting the PNG, JPG, or GIF files, or directories that contain these files, causes your results to display improperly.</td>
</tr>
</tbody>
</table>

### Apply SAS ActiveX graph settings during refresh

Initializes the **Use graph settings generated by SAS** option for results that use the ActiveX graph format. If you select this option, the **Use graph settings generated by SAS** option (that is available from the Properties dialog box for the selected results) is automatically set. If you do not select this option, the **Use graph settings generated by SAS** option is not selected. For more information, see “Setting the Appearance Properties” on page 207.

### Graph size

Specifies the width and height for the images that are displayed in your graphical report output. To use the best fit determined for your images, select **Automatic**. To specify a width and height to use for your images, select **Custom**.

---

**Table 5.23  Setting Options for SAS Visual Analytics Reports**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display filters for Visual Analytics reports</td>
<td>Displays the information for any specified filters before a report element in a SAS Visual Analytics report. If you are opening a crosstabulation report, the filter also includes any breadcrumbs. (An example of a breadcrumb is All Geographies &gt; North America &gt; United States.) The filters are created by the report author in SAS Visual Analytics. When the report is opened in the SAS add-in, you can use this filter to subset the data in the SAS Visual Analytics report. For example, you open a report that uses the Sashelp.Class data set. When this report was created, the report author defined a</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter called Gender. When you preview the report contents in SAS Add-In for Microsoft Office, you set Gender = &quot;F,&quot; so only those data values appear in the report element that you add to the Microsoft Office document.</td>
<td></td>
</tr>
<tr>
<td>Include all KPI gauges when inserting into a document</td>
<td>Displays all of the KPI gauges in a single screenshot. If this option is not selected, the gauges are displayed in a page. The number of gauges displayed on a page is determined by the maximum number of rows and columns specified for the SAS Visual Analytics report.</td>
</tr>
<tr>
<td>Save the full report state within the Office document</td>
<td>Specifies whether to save all the information needed to open the report. The full report state includes all the data and any interactions that you made with the report. (Examples of interactions are graph selections, any table sorting, any prompt values, drilling, or any expanded or collapsed sections). By default, the SAS add-in saves the full report state. As a result, when you reopen an Office document, the report in the document matches the report in the report controls panel. However, some reports can be quite large. Saving the full report state could result in an out-of-memory error when you save the workbook. To reduce the amount of memory used and to reduce the size of the workbook, clear the Save the full report state within the Office document check box. Now, the SAS add-in saves the user state, which includes any prompt values, any table sorting, and any expanded or collapsed sections. When you reopen the Office document, the report in the document might not match the report in the report controls panel. To synchronize the report in the document with the report in the report controls panel, click Refresh.</td>
</tr>
<tr>
<td>Apply style to Visual Analytics Reports</td>
<td>Specifies whether to apply a style to the results. The style is determined by the report, not by the options that you selected in the SAS Add-In for Microsoft Office Options dialog box.</td>
</tr>
</tbody>
</table>
### Graph size

Specifies the width and height for the images that are displayed in your graphical report output. By default, the size is defined when you create the SAS Visual Analytics report. To specify a width and height to use for your images, select Custom.

---

### Setting Results Options in Microsoft Outlook

**Table 5.24 Setting General Options**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show status window</strong></td>
<td>Specifies that the SAS Status window is always displayed. The SAS Status window enables you to monitor the status of jobs that are being refreshed.</td>
</tr>
</tbody>
</table>
| **Prompt before opening results larger than nnn** | Specifies that you want a confirmation window to be displayed when you attempt to open results that are larger than \( n \) kilobytes (KB). The valid range of values is from 0 to 1,000,000 KB. The default value is 1,000 KB.  
   **Note:** Opening large worksheets can be a time-intensive operation. |

**Table 5.25 Specifying the Format for Your Results**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show SAS log</strong></td>
<td>Specifies that the SAS log, which is generated when you run a stored process or SAS task, is always displayed. If you select this option, the SAS log is displayed even if there are no errors when you run a stored process or task. The SAS log appears in a separate window called the SAS Add-In Log window.</td>
</tr>
<tr>
<td><strong>Results Format</strong></td>
<td>Specifies the format of the results from a stored process or a SAS Web Report Studio report. You can choose from the following formats:</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAS Report</td>
<td>- generates the results as a SAS Report. This is the default results format. Use the <strong>Apply the SAS style to the results</strong> option to specify whether to apply a style to the results. For more information, see About the Apply the SAS style to the results option.</td>
</tr>
<tr>
<td>HTML</td>
<td>- generates the results in HyperText Markup Language (HTML) format. Select the style for the results from the <strong>Style</strong> drop-down list.</td>
</tr>
</tbody>
</table>

**Note:** The **Style** drop-down list includes the styles that are supplied by SAS, as well as any custom styles that you create using the Style Manager. To open the Style Manager, click **Manage Styles**. For more information about styles, see Applying styles to the results.

**Graph Format**

Specifies the image format that you want to use for the graphical report output that is generated by a stored process or a SAS Web Report Studio report.

The image format is saved with the results. If you change the image format, then this new format is used in any future results. The new format is not applied to any existing graphical report output.

When you select an image format, consider the output type of the stored process, as well as your personal preference. For more information, see Output types for stored processes. For more information, see “Output Types for Stored Processes” on page 161.

Additional items to consider when selecting the image format:

- Unlike the other image formats, if you use the ActiveX format, you can change the appearance of a graph after you have generated it. However, these changes are temporary and are not saved with the results. Therefore, when you close the results, forward the results in an email, or send the results to another Microsoft application, the changes do not persist.
Third-party ActiveX controls are not supported in 64-bit versions of Microsoft Office. If you are running in a 64-bit environment, use the ActiveX image format.

Images in the ActiveX format must be generated and viewed on Windows. These images cannot be generated or viewed in UNIX or z/OS environments.

You cannot generate ActiveX image results from a stored process in UNIX or z/OS environments. You can generate the ActiveX image results in a Windows environment, and then view these results in UNIX or z/OS environments.

If a stored process generates PNG, JPG, or GIF results, then these files are stored in subdirectories of SAS Add-In for Microsoft Office directory, which is typically `C:\Documents and Settings\username\My Documents\My SAS Files\Add-In for Microsoft Office`. Deleting the PNG, JPG, or GIF files, or directories that contain these files, causes your results to display improperly.

**Graph Size**

Specifies the width and height for the images that are displayed in your graphical report output. To use the best fit determined for your images, select **Automatic**. To specify a width and height to use for your images, select **Custom**.

### Setting the Task Options

To set the options for tasks in Microsoft Excel, Microsoft Word, and Microsoft PowerPoint:

1. Click the **SAS** tab on the Ribbon.
2. In the **Tools** group, click **Tools** and select **Options**.
3. In the SAS Add-In for Microsoft Office Options dialog box, select **Tasks** from the selection pane.
### Table 5.26  General Task Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert SAS program as a comment</td>
<td>Specifies that the SAS program that is associated with the task that you are running is included in the task results. The code is included as a comment in Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td>Default library for output data</td>
<td>Specifies the library in which you want to store any output data that might be generated by the task. The default library is the SAS Work library.</td>
</tr>
<tr>
<td>Use grid when available</td>
<td>Enables the SAS add-in to run tasks in a SAS grid computing environment. For more information, see “Using the SAS Grid Computing Environment” on page 19.</td>
</tr>
</tbody>
</table>

### Table 5.27  Specifying the Number of Recent Tasks

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the number of recent tasks</td>
<td>Specifies the number of recent tasks to display in the task browser. The default is 15 tasks.</td>
</tr>
</tbody>
</table>

### Table 5.28  Setting Options for Titles and Footnotes

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include SAS procedure titles</td>
<td>Includes the name of the SAS procedure that is associated with the task in the heading of the task results. This option is not available for all SAS tasks.</td>
</tr>
<tr>
<td>Default title</td>
<td>Specifies text that you want to include as the title of your task results. The title can contain text and macro variables that are evaluated when the task is run. You can enter up to 10 lines of text.</td>
</tr>
<tr>
<td>Default footnote</td>
<td>Specifies text that you want to include as a footnote in your task results. The footnote can contain text and macro variables that are evaluated when the task is run. Footnotes are displayed at the bottom of the task results. If you do not specify a footnote, then the footnote that is generated by the task is used. To change the text back to the default that is used by the SAS add-in, click <strong>Reset Footnote</strong>.</td>
</tr>
</tbody>
</table>
Table 5.29  Setting Custom Code Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert custom SAS code before task code</td>
<td>Inserts custom code that you have written before the automatically generated task code. You can create or edit your custom code by clicking Edit.</td>
</tr>
<tr>
<td>Insert custom SAS code after task code</td>
<td>Inserts custom code that you have written after the automatically generated task code. You can create or edit your custom code by clicking Edit.</td>
</tr>
</tbody>
</table>

Table 5.30  Specifying SAS Studio Settings

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display SAS Studio tasks from your version of SAS Studio | Specifies to display in the task interface any tasks that are shipped with SAS Studio. If you are running SAS Studio 3.7 or 3.8, you can access either the SAS Studio Enterprise Edition or the SAS Studio Single User Edition. SAS Add-In for Microsoft Office and SAS Studio Single User Edition must be installed on the same machine. If you have more than one instance of SAS Studio Single User Edition installed, you must select one instance to be active. Internet Explorer 10 (or later) is required to run the SAS Studio tasks. For more information, see “Accessing Tasks” on page 137.  
  Note: SAS Studio 5.2 tasks are not available in SAS Add-In from Microsoft Office. |

Customizing the Ribbon and the SAS Panel

To customize the appearance of the Ribbon or to restore sample reports in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, and Microsoft Outlook:

1  Click the SAS tab on the Ribbon.
2  In the Tools group, click Tools and select Options.
3  In the SAS Add-In for Microsoft Office Options dialog box, select Customize from the selection pane.

<table>
<thead>
<tr>
<th>Group of Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Ribbon options</td>
<td>From the SAS tab on the Ribbon, you can select the items to be displayed in the General section. By default, these buttons and menu items are available:</td>
</tr>
</tbody>
</table>
Group of Options | Description
---|---
| the Reports button |  
| the Tasks menu |  
| Note: This menu is not available in Microsoft Outlook. |  
| the Programs menu |  
| Note: This menu is not available in Microsoft Outlook. |  
| the Currently Open menu |  
| the Recent menu |  
| the Favorites menu |  
To remove an item from the Ribbon, clear the check box under Ribbon Options. For the Recent menu, you can specify the number of items to include in this list. The default value is 25.

Setting the options for the home page | Use the Show the getting started panel on the home page option to display or remove the getting started panel on the home page.

Restoring sample reports for SAS Visual Analytics | SAS Add-In for Microsoft Office is shipped with a default server for sample reports. This default server, vatry.ondemand.sas.com or SAS Demo Server, appears in the list of additional SAS Visual Analytics servers. You log on to this server as a guest. For more information, see “Define Your SAS Visual Analytics Profiles” on page 14.

When you open the Home tab in the SAS panel, four sample reports are automatically displayed. You can choose to delete these reports or delete the SAS Demo Server from your list of SAS Visual Analytics servers.

To restore the four sample reports that appear when the Home page appears or the sample server if it has been removed, click Restore Sample Reports in the Options dialog box.

Setting the Advanced Options

These options are available in Microsoft Excel, Word, and PowerPoint. Most options are available in Microsoft Outlook with a few noted exceptions.

1  Click the SAS tab on the Ribbon.

2  In the Tools group, click Tools and select Options.

3  In the SAS Add-In for Microsoft Office Options dialog box, select Advanced from the selection pane.
Table 5.31  Setting General Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically check for updates</td>
<td>Specifies that the SAS add-in should prompt you when updates are available. For more information, see “Check for Software Updates” on page 7.</td>
</tr>
<tr>
<td>Reset All Warnings</td>
<td>Resets the SAS add-in to display all warning messages, including those that you have selected not to be shown. When you get a warning message dialog box, you can choose not to view that warning again by selecting the Do not show this dialog again check box.</td>
</tr>
<tr>
<td>Editor Options</td>
<td>Enables you to customize the Program Editor. These settings are shared between the program editors in SAS Enterprise Guide and SAS Add-In for Microsoft Office. As a result, any changes that you make are reflected in both SAS applications. Note: This option is not available in Microsoft Outlook.</td>
</tr>
</tbody>
</table>

Table 5.32  Deleting SAS Results Files

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Files</td>
<td>The files that are created by SAS Add-In for Microsoft Office are typically stored in C:\Users\username\Documents\My SAS Files. However, you can select a different location for these results files. Each folder in this location is a separate stored process or task that was executed. The folder contains all the files that are needed to display the results for that stored process or task. These files are not deleted when you close your Microsoft Excel, Microsoft Word, or Microsoft PowerPoint session. In the SAS Results Files section, you can see the amount of disk space that these files are using and the date of the oldest file. To delete the files for Microsoft Excel, Word, and PowerPoint, click Delete Files. For example, if you are working in Microsoft Excel and you click Delete Files, then the SAS add-in deletes all Microsoft Excel, Word, and PowerPoint files. You can also specify whether to always automatically delete these files when you close Microsoft Excel, Word, or PowerPoint. If you delete these files and have images in the results that are linked to these files, then those links will be broken. Also, any SAS Report content that you chose not to display when you previewed the results is treated as new content when you refresh the stored process or task.</td>
</tr>
</tbody>
</table>
### Table 5.33  Email Settings for Scheduling

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduling options</td>
<td>To send your scheduled results via email, you must specify these items:</td>
</tr>
<tr>
<td></td>
<td>- your email address</td>
</tr>
<tr>
<td></td>
<td>- the name of your outgoing mail server (SMTP)</td>
</tr>
<tr>
<td></td>
<td>If the server requires you to log on, you might need to provide your user name and password. Select the Use Secure Password Authentication (SPA) check box to authenticate your password. Some internet service providers require this authentication.</td>
</tr>
<tr>
<td></td>
<td>For help with any of these options, contact your system administrator.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “About Scheduling When the SAS Content Is Refreshed” on page 204.</td>
</tr>
</tbody>
</table>

**Note:** This option is not available in Microsoft Outlook.

### Table 5.34  Setting Publishing Options

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt for untracked data sources when publishing documents</td>
<td>Displays the Verify Document for Impact Analysis dialog box when you are saving a document to SAS Folders. This option is selected by default. For more information, see “About SAS Folders” on page 183.</td>
</tr>
</tbody>
</table>

**Note:** This option is not available in Microsoft Outlook.

### Table 5.35  Setting Language Settings

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server session locale</td>
<td>Sets the locale of the workspace server session and the SAS Visual Analytic server session. You can choose from these options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use the Microsoft Office display language</strong> uses the locale specified for the user interface in Microsoft Office.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use the locale of the client machine</strong> uses the locale specified in the</td>
</tr>
<tr>
<td>Option Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>regional settings of the operating system.</td>
<td></td>
</tr>
<tr>
<td><strong>Use the locale of the server</strong> uses the default locale for the SAS workspace server. SAS Visual Analytic servers do not have a default locale, so these servers use the locale of the client machine.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 5.36 Configure Application Logging**

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable logging</td>
<td>Enables you to change the logging settings. Logging is not turned on by default. Click <strong>Edit File</strong> to edit the logging file. Click <strong>Browse Log Files</strong> to open Windows Explorer and see the contents of the log folder.</td>
</tr>
<tr>
<td></td>
<td>Here are examples of default locations for your configuration file and log folder:</td>
</tr>
<tr>
<td></td>
<td><strong>The configuration file is saved in</strong></td>
</tr>
<tr>
<td></td>
<td>C:\Users\user-ID\AppData\Roaming \SAS\AddInForMicrosoftOffice \8.0\logging.config.</td>
</tr>
<tr>
<td></td>
<td><strong>The log folder is located at</strong> C:\Users \user-ID\AppData\Roaming\SAS \Add-InForMicrosoftOffice \8.0\Logs.</td>
</tr>
</tbody>
</table>
## Working with Microsoft Excel Data and SAS Data Sources

### About Accessing Data

- [About Accessing Data](#)
- [Available Data Sources](#)

### Working with Data in a Microsoft Excel Worksheet

- [Working with Data in a Microsoft Excel Worksheet](#)
  - Open a SAS Data Source in a Microsoft Excel Worksheet
  - Edit a SAS Data Set in Microsoft Excel
  - Select the Variables to Display in a Microsoft Excel Worksheet
  - Select the Variables to Include in the Output
  - Sort Your Data
  - Display All Records in a Data Source
  - Including Labels from an Excel Worksheet
  - View the Column Properties

### Working with Data in a PivotTable

- [Working with Data in a PivotTable](#)
  - Open a SAS Data Source in a PivotTable
  - Adding Variables to the PivotTable

### Modifying the Data Source

- [Modifying the Data Source](#)

### Filtering Data

- [Filtering Data](#)
  - About Filtering Data
  - Create a Simple Filter
  - Create an Advanced Filter
  - About the Advanced Filter Builder

### Sort Your Data

- [Sort Your Data](#)

### Copy Data to a SAS Server

- [Copy Data to a SAS Server](#)

### Update Data on the SAS Server

- [Update Data on the SAS Server](#)

### Working with Information Maps

- [Working with Information Maps](#)
  - About Opening Information Maps
  - Selecting the Data Items to Include in the Output
  - Selecting a Filter for a SAS Information Map

### Accessing Data in SAS Viya

- [Accessing Data in SAS Viya](#)
About Accessing Data

To access SAS data, you do not have to have SAS installed on your PC. You can do any of the following:

- access data via a workspace server
- reference SAS data sources on remote servers by using metadata definitions
- open data sources directly by using your computer's file system or by navigating to the server and library folders accessible from your computer

For more information, see “Examine Your Connection” on page 10.

There are three ways to access data:

- using a workspace (IOM) server that is registered in the current metadata server list using the file system to navigate the data that is stored on your PC, and data that is accessible on your network. You can access individual workspace servers directly if you define these servers in the Servers pane in the Connections dialog box.

  Note: When accessing large data sets using the file system, the data source might fail to load if there is not enough memory or system resources. If this happens, you must restart Microsoft Excel. If you continue working without restarting Excel, some functionality might not work correctly. You should use the workspace server to access large data sets.

- using a locally installed copy of SAS.

  Note: If you are using SAS Visual Analytics Add-In for Office, this functionality for working with SAS data is not available. For this functionality, you must use SAS Add-In for Microsoft Office. For more information, see “Determining Your SAS Add-In” on page 6.

Available Data Sources

In SAS Add-In for Microsoft Office, you can select from the following data sources:

- SAS data sources.
- OLAP cubes.
- SAS Information Maps. An information map is a collection of data items and filters that describes and provides a view of physical data. You can create information maps using various SAS tools, such as SAS Information Map Studio. The SAS add-in enables you to open the information maps that have been created at your site.
Microsoft Excel data. This data source can include data from a saved or open workbook. This data source is available only in Excel.

Working with Data in a Microsoft Excel Worksheet

Open a SAS Data Source in a Microsoft Excel Worksheet

To open a data source in a Microsoft Excel worksheet:

1. Click the SAS tab in the Ribbon. Then click Data. The View SAS Data dialog box appears.

2. Select the data source that you want to view. Click Filter & Sort to select the variables to display, create a filter, or sort your data. By default, all variables in the data source are displayed in the output.

3. Select Worksheet. You can also specify the number of records to view on each page, whether record numbers should appear in the first column, and whether the data source and filter information should be displayed in the output.

4. Specify whether the data source should appear in a new worksheet, an existing worksheet, or a new workbook.

5. Click OK. The data source opens and appears in the default table style for Microsoft Excel.

Edit a SAS Data Set in Microsoft Excel

In Microsoft Excel, you can open and edit a SAS data set that is saved on a SAS server. When you commit your changes to the SAS server, you are overwriting an existing data set, and you cannot undo your changes after you commit the changes to the server. Before editing any data, it is recommended that you back up the data on the SAS server. Then if you need to undo any changes, you can overwrite the updated data set with a previous version.

While you have the data set in Edit mode, the data set is locked and cannot be opened by other users at your site. If you are inactive for several minutes, then the SAS add-in exits Edit mode and the data set is unlocked. To specify the length of time that a session must be inactive before the data set is unlocked, use the Close edited data after period of inactivity option on the Data panel in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “Data Options in Microsoft Excel” on page 28.
Note: While in Edit mode, the raw values for the data are displayed in Excel formats. You must exit Edit mode to see the SAS formatted values.

To edit an existing SAS data set:

1. Open the SAS data set in Microsoft Excel.
2. Click the SAS tab in the Ribbon. In the External Data group, click Begin Edit. The data source is now in Edit mode.
3. To add a column, delete a column, or modify the properties of a column, click Edit Column Properties. The Column Properties window appears.
4. To add a record:
   a. In the External Data group, click Create New Records.
   b. In the Create New Records dialog box, specify how many records to insert and whether to insert those records above or below the selected record in the data set. Click OK. A blank record is added to the data set.
   c. Enter a value for each cell in the new record.
   d. In the External Data group, click Commit. The new record is written to the data set on the server.
5. To edit an existing record:
   a. Click the cell that you want to edit and enter your changes.
   b. In the External Data group, click Commit to save the changes to the server.
6. To delete records in the table, select the records and click Delete Records. You are prompted to confirm the deletion of these records. When you click Yes, the records are deleted from the data set on the server.
7. To exit Edit mode, click End Edit. The data set is unlocked so that other users can now update this data set.

Select the Variables to Display in a Microsoft Excel Worksheet

When you open a data source, you must specify at least one variable to display in the worksheet. After the data source is open, you can also add or remove variables from the Microsoft Excel worksheet.

To select the variables to display in an Excel worksheet:

1. If you are opening a new data source, click Filter & Sort in the View SAS Data dialog box. If you are modifying an existing data source, click the SAS tab in the Ribbon. In the Selection group, click Filter & Sort. The Modify Data Source window appears.
2. Click the Variables tab if it is not already selected.
3 Select the variables to include.

Note: By default, the labels that are specified in the data source are displayed. To view the variable names instead of the labels for the selected data source, clear the Display labels instead of variable names check box in the Modify Data Source window. To always display the variable names for every data source that you select or open, clear the Display labels instead of variable names check box in the SAS Add-In for Microsoft Office Options dialog box.

4 (Optional) To change the order of a variable, select the variable from the Selected list and click the up or down arrow to move the variable up or down one position in the list. The order that the variables appear in the Selected list is the order that they appear in the Excel worksheet.

5 (Optional) To use any custom formats when the data opens in Excel, select the Use custom formats when available check box. This option is available only if at least one variable in the selected data source has a custom format.

A custom format is one that you create. For example, your data source contains a variable named Gender, and this variable has four stored values: f, F, m, M. When you open the data in Excel, you want to see "female" for the values f and F, and "male" for the values m and M, so you created a custom format. If you select the Use custom formats when available check box, then the custom format is used. If you do not select this option, then the custom format is not used, and the values for the Gender variable appear as f, F, m, M.

6 Click OK to save your changes and open the data in an Excel worksheet. You can also create a filter and specify sorting criteria.

Select the Variables to Include in the Output

If your data source is a SAS data set, then the Variables tab in the Modify Data Source window lists all of the variables in the data source. Whether you can select the variables depends on which task you are performing.

- If you are selecting a data source to perform an analysis in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, then all of the variables are included by default.
- If you are opening a data source in Microsoft Excel, you can select the variables to include in the worksheet. By default, no variables are selected.

If your data source is an information map, then you can select the data items to include.

Sort Your Data

Using the SAS add-in, you can sort the data in ascending or descending order by multiple variables in the data source. You can also choose the order in which you want to sort the values of that variable.
To sort your data:

1. After you have selected the variables or data items that you want to include in the output, click the Sort tab.
2. In the Sort by drop-down list, select which variable that you want to use to sort the rows.

Note: By default, the variable labels are displayed. To view the variable names instead of the labels, clear the Display labels instead of variable names check box in the Modify Data Source window. To always display the variable names for every data source, clear the Display labels instead of variable names check box in the SAS Add-In for Microsoft Office Options dialog box. For more information, see "Data Options in Microsoft Excel" on page 28.

Note: If you are using a data source from a local file system, then you cannot sort on a variable that has brackets ([]) in the name.

3. Select whether you want to sort the variable values in ascending or descending order.

4. To sort by additional variables, select another variable from the Then by drop-down list and select whether you want to sort the values for the variable in ascending or descending order. Repeat this step for all of the remaining variables that you want to use to sort the data.

5. Click OK to save your changes. You can also filter your data.

Display All Records in a Data Source

By default, when you open a data source, the first 500 rows are displayed in the worksheet. You can change the default number of rows that are displayed to any number of rows between 1 and the record limit. Microsoft Excel limits the number of rows available in a worksheet to 1,048,576 rows.

To display all of the records in the current view of the data source, click the SAS tab in the Ribbon. In the Navigate group, click View All.

You might want to display all of the records in the data source for the following reasons:

- When you open a data source that exceeds record limit, the SAS add-in creates additional worksheets to display all of the data. A message box appears that
asks you to confirm the creation of these worksheets. The number of worksheets that can be created is limited by the amount of available memory. Displaying all of the rows in a large data set might take some time.

- If the number of records that meet the filter criteria exceeds the number of rows that are displayed by default, then displaying all the records keeps you from having to navigate through the data or changing the default number of rows to display.

Including Labels from an Excel Worksheet

By default, the contents in the first row of Microsoft Excel data are used as the labels of the variables in the tasks.

To specify that the first row of your Excel data contains data rather than labels:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Options. The SAS Add-In for Microsoft Office Options dialog box appears.
2. In the selection pane, click Data.
3. Deselect the Labels in first row for Excel data sources check box and click OK.

View the Column Properties

To view the column properties for a data source, click the SAS tab in the Ribbon. In the External Data group, click View Column Properties.

Note: If your input data source is an information map, you cannot view the properties of each column in the data.

From the Column Properties window, you can view these properties for each column in the data source:

- the column name
- the column label
- the type, which specifies whether the data in the column is character or numeric
- the group
- the length for the values in the column
- the format that is used to display the data
- the format that is used to read the data (also called the informat)
- the expression that is used to calculate the values of the column

To edit these properties, you must be in Edit mode. For more information, see “Edit a SAS Data Set in Microsoft Excel” on page 63.
Working with Data in a PivotTable

Open a SAS Data Source in a PivotTable

To open a data source in a PivotTable:

1. Click the SAS tab in the Ribbon. In the General group, click Data. The View SAS Data dialog box appears.
2. Select the data source that you want to view. Click Filter & Sort to select the variables to display, create a filter, or sort your data. By default, all variables in the data source are displayed in the output.
3. Select PivotTable.
4. Specify whether the PivotTable should open in a new worksheet, an existing worksheet, or a new workbook.
5. Click OK. The PivotTable opens and appears in the default table style for Microsoft Excel.

Adding Variables to the PivotTable

You can use SAS data sets or OLAP cubes to create a PivotTable report. You can customize the PivotTable report by using the PivotTable toolbar in Excel. For more information about PivotTable reports, see the Microsoft Excel Help.

Working with a SAS Data Set

When a SAS data set is opened into the PivotTable report, an empty PivotTable report and the PivotTable Field List window open. This window lists all of the variables that are available for the PivotTable report. You select these variables when you select the data source to open. From the PivotTable Field List window, drag and drop the variables into the PivotTable report.

When opening a SAS data set into a PivotTable report, remember these restrictions:

- Data sets that are password-protected and saved locally cannot be opened into a PivotTable report.
- Formats are applied when the variable is included in the PivotTable report. If variable has a custom SAS format, then the result in the PivotTable report is a string. If you are opening data that is saved locally into a PivotTable report, then any date values are unformatted.
- To sort the data in a PivotTable report, you must use the sort functionality in Excel for PivotTable. Using the sort functionality in the SAS add-in does not change the order in which the fields are displayed in the PivotTable.
Working with an OLAP Cube

When an OLAP cube is opened into the PivotTable report, an empty PivotTable report is created by default. To select the variables, calculated measures, or calculated members to include in the report, use the PivotTable Field List window.

However, you can select the **Automatically select fields for OLAP PivotTables** check box to have the SAS add-in automatically populate the rows and columns of the report. For more information, see “Data Options in Microsoft Excel” on page 28.

By default, user credentials are not saved with the PivotTable report in the Microsoft Excel workbook. If you open an OLAP cube in a PivotTable report, the next time you open the workbook, you are prompted to refresh the PivotTable report. If you refresh the PivotTable report, you can interact with the PivotTable without being prompted for your credentials. If you do not refresh the PivotTable report when you open the workbook, you must click **Refresh** on the **SAS** tab before you can interact with the PivotTable.

To save the credentials with the PivotTable report:

1. In the Ribbon, click the **Analyze** tab. Click **Change Data Source** and select **Connection Properties**. The Connection Properties dialog box appears.
2. Click the **Definition** tab.
3. Under the **Connection string** option, select the **Save password** check box. Click **OK**.
4. In the Ribbon, click the **SAS** tab. Click **Refresh**.

---

Modifying the Data Source

The Modify Data Source window appears when you select a data source or when you are opening SAS data in Microsoft Excel. From this window, you can perform these tasks:

- select the variables to include
- create a filter
- sort your data

In the Modify Data Source window, you can select these display options:

- **Display labels instead of variable names** determines whether the name or the label for the variable will be displayed on the **Variables** tab and in the column headings of the worksheet. By default, this check box is selected to show the label for the variable as it is specified in the data source. You can specify the default value for the workbook by using the option on the **Data** panel in the SAS Add-In for Microsoft Office Options dialog box.

- **Validate** enables you to view the generated SAS code for the query. The Validate window indicates whether the expression syntax is valid. If the syntax is not valid, you can view the error log.
Filtering Data

About Filtering Data

You can create a simple filter by using the options in the Modify Data Source window, or you can create your own filter expression by using the Advanced Filter Builder.

You can use just one variable in a filter, or you can use multiple variables to create several comparison expressions. If you create more than one comparison expression in your filter, then you can specify whether the relationship between these filter elements is AND or OR. Any filters that are joined by an AND relationship are evaluated first. The filters are not evaluated in the order in which you created them on the Filter tab. For example, suppose you created the following filter: Sex = 'M' or Name = 'Carol' and Date = '1980'

In this example, the SAS add-in filters the data in the following order:

1. SAS identifies all of the rows that have Name equal to Carol and Date equal to 1980.
2. The OR relationship is evaluated, and the SAS add-in adds all rows that have Sex equal to M.

If you want the filter elements to be evaluated in a different order, then you must use the Advanced Filter Builder to create your filter.

Note: If you select Data ⇒ Filter, then you will be using the Microsoft Excel filter tool. The Excel filter tool is not the same tool as the SAS filter tool. The Excel filter tool filters only the records that are displayed in your worksheet. The SAS filter tool filters all of the records in a data source on the server, and then returns the filtered data to your worksheet.

Create a Simple Filter

You can create a filter when you are opening a new data source or after you have opened the data source in a Microsoft Excel worksheet. You can create an advanced filter by using the Advanced Filter Builder to build a comparison expression. For more information, see “Create an Advanced Filter” on page 72.

To create a simple filter:

1. If you are opening a new data source, click Filter & Sort in the View SAS Data dialog box.
   - If you are modifying an existing data source, click the SAS tab in the Ribbon. In the Selection group, click Filter & Sort.
The Modify Data Source window appears.

2 Click the **Filter** tab.

3 Select a variable from the first drop-down list. The drop-down list contains all of the variables in your data. By default, the variables are displayed in the order in which they appear in the data source. To display the variables in alphabetical order, select the **Sort variables in alphabetical order** check box of the SAS Add-In for Microsoft Office Options dialog box. For more information, see “**Data Options in Microsoft Excel**” on page 28.

Note:  By default, the variable labels are displayed. To view the variable names instead of the labels, clear the **Display labels instead of variable names** check box in the Modify Data Source window. To always display the variable names for every data source, clear the **Display labels instead of variable names** check box in the SAS Add-In for Microsoft Office Options dialog box.

4 Select an operator from the second drop-down list.

5 Enter a value in the third box or click to display a list of values that you can select for the value of the variable.

If the SAS data source is located in your computer's file system or on a server accessible from your computer, then the list of values is populated in the order in which the unique values occur in the data. If the data source is not located in your computer's file system or on a server accessible from your computer, then the list of values is populated in ascending order.

Note:  If you selected the **Between** or **Not between** operator, then you must specify a beginning and ending value. If you selected the **In a list** or **Not in a list** operator, then you must specify the list of values for the comparison. You can type or paste values in the box. Click **Add Values** to select a value from the data source. Each value must be on a new line.

For all other operators, the first 25 distinct values in the data source are displayed in the list. If you would like to view more values, click **More Values**. Each time you click **More Values**, the next 25 distinct values for the variable are displayed in addition to the initial 25 values. To specify how many distinct values that you want to retrieve at a time to display in the list of values, specify a new value for the **Number of distinct values for filter** option in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “**Data Options in Microsoft Excel**” on page 28.

6 Select **AND** or **OR** from the last drop-down list to add additional filters to the data. Repeat steps 2 - 5 to create these filter elements.

7 Click **OK** to save your changes. You can also specify sorting criteria.
Create an Advanced Filter

You can create an advanced filter by using the Advanced Filter Builder to build the comparison expression.

1. If you are opening a new data source, click **Filter & Sort** in the View SAS Data dialog box.
   
   If you are modifying an existing data source, click the **SAS** tab in the Ribbon. In the **Selection** group, click **Filter & Sort**. The Modify Data Source window appears.

2. Click the **Filter** tab, and then click **Advanced Edit** to open the Advanced Filter Builder.

3. Build your expression using constant values, mathematical operators, functions, and columns in tables.

4. Click **OK** to save the filter. The filters that you created are displayed as text in the **Filter** tab in the Modify Data Source window. You can also specify sorting criteria.

About the Advanced Filter Builder

You can use the Advanced Filter Builder to create filter expressions that you apply to the data source. The expression uses in-fix notation, with parentheses to change the order of precedence for expression evaluation. You can build your expression by using constant values, mathematical operators, functions, and columns in tables. The constant value can either be a number (such as 10 or 3.14) or a string (such as 'NC' or 'Sales Numbers').

**Note:** If your filter consists of only a constant value, then every row in the data source appears in the output.

Functions are identified by an argument list enclosed in parentheses and separated by commas. Functions that do not contain arguments must still have an empty set of parentheses.

**Note:** If you create a filter by using the Advanced Filter Builder, you are not able to edit that filter in the Modify Data Source window. For this reason, filters that are created using the Advanced Filter Builder are displayed as text on the **Filter** tab in the Modify Data Source window.

In the Advanced Filter Builder, you can add these items to your expression:

**Operators**

To add an operator, click the buttons beneath the text box. The operators are added to the expression.
Functions

To add a function, expand the list of functions in the lower left section of the window. You can select a function from the alphabetical list of functions, or you can expand the list of categories and select the function from within a category. When you select a function, a short description of the function appears in the lower right section of the window. Double-click the function to add it to your expression.

Note: The functions in the Data Quality category require SAS Data Quality Server to be licensed and installed on the server.

Note: If your data is loaded from your computer's file system (also known as the local provider), then the SAS functions are not available.

Columns

To add a column, expand the list of tables in the lower left section of the window. Expand the table from which you want to add a column. Double-click the column name that you want to add to your expression.

To add a specific value of a column, select the column and click Get Values to view all of the unique values of the column.

Note: To view the columns for your input data source, expand Selected Columns. Double-click the column name that you want to add to your expression, or select a column and click Get Values to view all the unique values of the column.

To validate the expression syntax before you save the filter, click Validate. The Validate window that opens indicates whether the expression syntax is valid or not. If the syntax is not valid, you can view the error log.

Sort Your Data

Using the SAS add-in, you can sort the data in ascending or descending order by multiple variables in the data source. You can also choose the order in which you want to sort the values of that variable.

Note: If you select Data Æ Sort, you are using the Microsoft Excel sort tool. This is not the same tool as the SAS sort tool.

Note: If you are opening data into a PivotTable report, sorting the input data does not change the order in which the fields are displayed in the PivotTable. You must use the sorting functionality in Excel for PivotTables to change the order of the fields.

To sort your data:

1. In the Modify Data Source window, click the Sort tab.
2 In the **Sort by** drop-down list, select which variable that you want to use to sort the rows.

**Note:** By default, the variable labels are displayed. To view the variable names instead of the labels, clear the **Display labels instead of variable names** check box in the Modify Data Source window. To always display the variable names for every data source, clear the **Display labels instead of variable names** check box in the SAS Add-In for Microsoft Office Options dialog box.

**Note:** If you are using a data source from a local file system, you cannot sort on a variable that has brackets ([ ]) in the name.

3 Select whether you want to sort the variable values in ascending or descending order.

4 To sort by additional variables, select another variable from the **Then by** drop-down list and select whether you want to sort the values for the variable in ascending or descending order. Repeat this step for all of the remaining variables that you want to use to sort the data.

5 Click **OK** to save your changes.

---

**Copy Data to a SAS Server**

You might want to make a Microsoft Excel or SAS data source available to everyone at your site. In Microsoft Excel, you can copy a data source to a SAS server. After a data source is copied to a SAS server, it becomes a SAS data set, and you can use it like any other SAS data source.

To copy a data source to a SAS server:

1 Click the **SAS** tab in the Ribbon. Click **Tasks** and select **Data ▸ Copy to SAS Server**. The Choose Data dialog box appears.

2 Select the data source that you want to copy to the SAS server. Click **OK**.
   The Copy to SAS Server dialog box appears.

3 To have the SAS add-in automatically rename any columns in the data set that do not follow SAS naming conventions, select the **Rename columns to comply with SAS naming conventions** check box. In the **Columns** pane, you can compare the SAS names for each column with the column names in the input data source.

4 Select the SAS library where you want to save the data. By default, the data is copied to the Work library and given the filename _EXCELEXPORT. To change the library or filename, click **Browse**. The Save SAS Data Source window appears. After you have selected the SAS library and specified the filename to use, click **OK** to return to the **Copy to SAS Server** dialog box.

5 Click **OK** to copy the data.
In addition to copying the data to the server, the SAS add-in returns the data source as an output data set. If you selected the **Open output data automatically** option, then this data set opens in a new worksheet.

Any changes that you make to the data source in Excel are not automatically copied to the SAS server. For more information, see “Update Data on the SAS Server” on page 75.

---

**Update Data on the SAS Server**

After you copy data to a SAS server, you might update the data in Microsoft Excel. To update the version of the data on the SAS server, you must refresh the Copy to SAS Server task.

To update data that you have copied to the SAS server:

1. Open the **Results** tab in the SAS panel and find the results for the Copy to SAS Server task.
2. Click **_refresh icon**.

![Copy to SAS Server result](image)
Working with Information Maps

About Opening Information Maps

After you have selected the SAS Information Map to use as the data source or to open in Microsoft Excel, you can select the data items that you want to include, apply filters to the data, sort the data, and specify the output location. After you click OK in the Open Information Map window, a prompt might appear if the information map references a stored process.

Note: OLAP information maps that were created in SAS Information Map Studio are not supported in the SAS add-in.

Selecting the Data Items to Include in the Output

When you select an information map to use as the input data source or to open into a Microsoft Excel worksheet, you must first select the data items that you want to include. By default, no data items are selected. If you do not select a data item, the data item is not included in the data source, but it remains in the information map.

To select the data items to include:

1. Select the information map to use as the data source for the task or to open in Microsoft Excel. The Open Information Map window appears.
2. Click the Data Items tab if it is not already selected.
3. Move one or more data items to move to the Selected variables list.
4. To display predefined computed items such as summarizations in the Available data items list, select the Display aggregated values (group by category) check box.

- If you select this option, then the inclusion of these items results in an aggregated data set that is summarized according to the information map definition, displaying the measure data items across the categorical data items. Aggregation is the process of grouping data, using an operation that produces a statistic such as a sum, average, minimum, or maximum.
- If this option is cleared, detail data is displayed in the data set. Detail data is nonsummarized (or partially summarized) factual information that pertains to a single area of interest, such as sales figures, inventory data, or human-resource data.
TIP  To set this option for all information maps, use the Display aggregated values when opening information maps option. For more information, see “Data Options in Microsoft Excel” on page 28.

5  (Optional) Click Additional data options to complete these tasks:
   - add the folder information to the label of the data item in the Selected variables list
   - override the default column length (32 bytes) for calculated columns
   - rename your data items so that they comply with SAS naming rules

6  Click OK to save your changes.

Selecting a Filter for a SAS Information Map

Filters are often defined when an information map is created. However, you can also create custom filters for an information map. These custom filters are available only in your current session of SAS Add-In for Microsoft Office. These filters are not saved with the information map.

To select a filter when the data source is a SAS Information Map:

1  After you select the data items to include, click the Filter tab.

2  Add filters to Selected filters list.

   Note: A filter name can contain either single quotation marks or double quotation marks. If a filter name contains both types of quotation marks, the filter is not supported in SAS Add-In for Microsoft Office.

3  To create a custom filter, click .

4  To change the logical condition that joins two filters, click the Operator cell that is next to the filter and select AND or OR from the drop-down list. By default, multiple filters are joined by using AND as the logical condition.

5  To combine filters into groups, click . In the Filter Combination window, you can group, ungroup, and delete filters; change logical conditions; and change the order of filters for an information map.

6  To apply a NOT operator to a filter, select the filter in the Selected filters list and click to display YES in the Not column for the filter.

   To remove a NOT operator from a filter, select the filter and click again.

7  Click OK to save your changes.
Accessing Data in SAS Viya

If you are connected to a SAS 9.4M5 server and your site has licensed and installed SAS Viya products, you can work with SAS Cloud Analytic Services (CAS) tables. SAS Cloud Analytic Services performs analysis on in-memory tables only. You must first load your data into in-memory CAS tables and then run analyses against the CAS tables.

All access to data with SAS Cloud Analytic Services is through a caslib. A caslib is an in-memory space to hold tables, access control lists, and store data source information. All data is available to CAS through caslibs, and all operations in CAS that use data are performed with a caslib in place. Authorized users can add or manage caslibs with the CASLIB statement.

CAS tables are referenced by their caslib and the table name. After you create a caslib, you can load your data into CAS. You can load data from your client machine, from a server, or from a database table.

For more information, see the CASLIB Statement in SAS Cloud Analytic Services: User’s Guide.
Open an OLAP Cube

You can use the OLAP Analyzer to view data in a SAS OLAP cube, in an OLAP cube that is created by Microsoft Analysis Services, or in an OLAP cube from an SAP provider.

To open an OLAP cube in the OLAP Analyzer:

1. Click the SAS tab in the Ribbon. In the General group, click Data. The View SAS Data dialog box appears.

2. To select an OLAP data source, click Browse. In the Open Data Source dialog box, select OLAP Servers or Private OLAP Servers. Select the OLAP server and catalog that contain the OLAP cube and click Open.

3. In the View SAS Data dialog box, select OLAP Analyzer.

4. Specify whether the OLAP Analyzer should open in a new worksheet, an existing worksheet, or a new workbook.

5. Click OK. The OLAP Analyzer opens in Microsoft Excel.

About the OLAP Analyzer

The OLAP Analyzer enables you to view data that is stored in an OLAP (online analytical processing) cube. An OLAP cube is a specialized data storage facility that stores summarized data in a matrix-like format for fast and easy access. Users can...
quickly view large amounts of presummarized data at any cross section of business dimensions. A business dimension can be any aspect of the data that makes sense, such as time, geography, or product.

When you open an OLAP cube in a Microsoft Excel worksheet, the SAS add-in displays a maximum of 100 rows by 100 columns (or 10,000 cells). After the OLAP cube is open in the worksheet, you can resize the OLAP cube to display additional rows and columns.

All of the table and graph views in the OLAP Analyzer are synchronized so that when you make a change to one view, such as expanding, drilling, or filtering, all of the other table and graph views are updated as well.

Note: The OLAP Analyzer is placed on top of the Microsoft Excel worksheet, not in a specific cell. Therefore, you cannot apply Excel formats to data in the OLAP Analyzer.

---

Understanding the OLAP Analyzer Interface

Using the Cube Manager

The OLAP Analyzer consists of the Cube Manager on the right side and the table view in the Microsoft Excel worksheet. The Cube Manager includes the following views that you can use to manage the open cube. Click the appropriate icon to open each view. The views that are available in the Cube Manager can change if you are viewing a write-enabled cube, a cube that is associated with an ESRI map, or a Cube Explorer view.

In the Customized Items and Sets, Filters, and Conditional Highlights views, you can select which items you want to display in the views.

- **Data Dimensions** - enables you to select members for the cube views by using a tree view of the default hierarchy for each dimension.

- **Customized items and sets** - enables you to add a percentage of the visual total item to the table view, to create and edit your calculated members, calculated measures, and member sets, and to view the MDX code for global calculated measures or calculated members.

- **Filters** - enables you to create and edit filters on the OLAP cube

- **Conditional highlights** - enables you to create and edit conditional highlights for the OLAP cube.

- **Bookmarks** - enables you to create and edit bookmarks.

The table and graph views display the current view of the cube and enable you to drill in your data and expand and collapse levels.
Using the Data Dimensions View

The Data Dimensions view in the Cube Manager enables you to select members for the cube views by using a tree view of the default hierarchy for each dimension. The tree view displays all of the items that are included in the current query in bold.

Below the tree view, the Data Dimensions view also displays a table of attributes for the selected member, level, or hierarchy. The attributes can include a count of the selected item. Member items display a count of their children, and hierarchies display a count of their descendants.

The Data Dimensions view enables you to browse or search for members, levels, and hierarchies.

Note: The search function can find only items that are in a part of the tree view that has been expanded at least once. When you start a search for an item, you cannot cancel the search.

Using the View Manager

The View Manager is displayed below the Ribbon in Microsoft Excel. The View Manager can display the dimensions that are being used in the columns and rows, the filters that are applied to the views, and any conditional highlights that are applied to the table view. You can customize the View Manager by changing the information that is displayed in it.

From the View Manager, you can access many features of the OLAP Analyzer, including rearranging the rows and columns in the table and graph views, creating new filters, and creating conditional highlights.

To customize the View Manager

1. Click Show in the View Manager. The options that are available depend on whether a table, graph, or Cube Explorer is selected in the worksheet.

2. Specify the options for the table, graph, or Cube Explorer.

   - If a table is selected, you can display the hierarchies on the column and row axes and display any slicers, filters, and conditional highlighting. You can also display the hidden hierarchies. By default, each hierarchy that is not displayed in the table view as a row or a column is included as a hidden hierarchy. Hidden hierarchies are always set to the default member of the hierarchy which is usually the [All] member. When you change the value of a hidden hierarchy, it becomes a slicer.
If a graph or Cube Explorer is selected, you can display the measures used in the graph view, the hierarchies used to group the data, any slicers, and filters. You can also display the hidden hierarchies. By default, each hierarchy that is not displayed in the table view as a row or a column is included as a hidden hierarchy. Hidden hierarchies are always set to the default member of the hierarchy which is usually the [All] member. When you change the value of a hidden hierarchy, it becomes a slicer.

**TIP** You might need to resize the View Manager to view all of the detail options.

To reset the View Manager to display only the columns, rows, and slicers in a table, only the measures, categories, and sub-categories hierarchies in a graph, and only the measures, categories, and slicers for the Cube Explorer, click Reset to Default.

### Using the Table View

When you open an OLAP cube, the OLAP Analyzer displays a table in a Microsoft Excel worksheet. The region that contains the table is called the table view. Because all of your data might not be visible in the region for the table view, use the scroll bars that appear along the bottom and along the right side of the inserted region to view all of your data. You can also create a graph view of the data.

The table view displays the current view of the cube in a table format and enables you to explore your data by drilling in your data and expanding and collapsing levels. You can create multiple table and graph views of the same cube.
At the top of the table view, the View Manager displays the measures and dimensions that are displayed in the current view. You can use the View Manager to change to another member in the same dimension and to rearrange the order of the rows and columns. You can also view and edit the filters and highlights that are applied to the view. By default, each dimension that is not displayed in the table view as a row or column is included as a hidden hierarchy.

If you have enabled the **Show raw values on data cells** option for the view, you can move the mouse pointer over each data cell to display the raw, unformatted value of the cell. For more information, see “Specifying Options for Raw Values and Unique IDs” on page 135. You can also use the Properties dialog box for the view to set other options for the current view of the active. Only one table view can be open at a time.

**Customizing the Cube Manager**

In the Customized Items and Sets, Filters, and Conditional Highlights views of the Cube Manager, you can change how items in those views are displayed and grouped, and you can sort them. You can also search for items in each view.

To change how items are displayed:

1. In the upper right corner of the view that you want to change, click the current display type. By default, all items in the group are displayed. For example, in the Customized Items and Sets view, the default display type is **All items and sets** and the items are grouped by type.

2. From the pop-up menu, select the display option and grouping option that you want to use.

**Working with the Cube Explorer**

**About the Cube Explorer**

In addition to viewing your OLAP data in the table view and graph view, you can also use the Cube Explorer to navigate in your data. The Cube Explorer enables you to select a dimension, expand a node within that dimension, and then change to another level or dimension. You can use this method to explore the data and find paths through the cube that might point to areas that need further analysis.

**Creating a Cube Explorer View**

You can create a new Cube Explorer view by using the Create New Cube Explorer View Wizard. In the wizard, you can select the dimension from which you want to start and one or more measures to analyze. By default, each dimension that is not displayed in the view is included as a hidden hierarchy. The default value for each
dimension is the [All] member, which includes all members of that dimension. You can change the filter to specify a specific filter value that you choose.

When you create a view in the Cube Explorer, it is added as another view in the worksheet. You can print the Cube Explorer view and save it as a JPEG or BMP file.

To create a Cube Explorer view:

1. Click the SAS tab in the Ribbon. In the OLAP Analyzer group, click Insert View and select Explorer. The Create New Cube Explorer View Wizard appears with a list of dimensions that are defined for the current cube.

2. Select the dimension from which you want to start, or expand the list of dimensions to select a specific member from which you want to start.

3. Click Next.

4. Select one or more measures to analyze from the list of measures that are defined in the current cube. You can select up to 10 measures to analyze, but one measure must be defined as the primary measure. The cube’s default measure is defined as the primary measure and is used to calculate the parent-child relative contribution percentages that are displayed at each node.

5. If you want to change the primary measure, select the measure that you want to use as the primary measure and click Set as Primary Measure.

6. Click Next.

7. If you want to create a slicer based on the other dimensions in the cube, select the dimension that you want to use in the slicer, and click . Repeat this step to add slicers for other dimensions.

8. Click Finish. The Cube Explorer opens with the data that you selected.

Navigating in the Cube Explorer

In the Cube Explorer, you can expand and collapse nodes and sort nodes by name or value. You can select a node and change to another dimension. This enables you to view a subset of data in another dimension at the level that you choose based on a member in the current dimension.

You can also copy a level in the current view in the Cube Explorer to the table view to use it as a starting point for more complex analysis.

To expand a node to a lower level within the same dimension, click the down arrow on the node that you want to expand, or right-click the node and select Expand.

To collapse an expanded node, click the up arrow on the node that you want to collapse, or right-click the node and select Collapse.
To sort the nodes in a level, right-click a node in the level that you want to sort and select Sort. From the pop-up menu, you can select either of the following options:

- **Name ▶ Ascending** or **Name ▶ Descending** to sort the nodes by member name
- **measure-name Ascending** or **measure-name Descending** to sort the nodes by the measure value

To view data in another level from a level in the current dimension, click a node in the level that you want to use and select **Change to ▶ dimension-name ▶ level-name**. A new row of nodes is added to the Cube Explorer for the new level.

To copy a level to the table view, right-click a node in the level that you want to copy and select **Create a Table for this Level**. Because the other table and graph views that you have created are synchronized, a warning message tells you that all existing table and graph views will be changed to the new table. The new table view opens with the level that you selected. If the table is already open, then the current table view is changed to reflect the selected level.

### Modifying a Cube Explorer View

You can modify an existing Cube Explorer view by adding and removing measures. In addition, you can change the parent-child relative contribution percentage that is displayed above each node.

**Note:** You can also use the View Manager to modify a view after you have created it.

To add a measure to a Cube Explorer view:

1. In the View Manager, make sure that the measures are displayed.
2. Right-click the area to the right of the measures and select **Add Measure measure-name**. The new measure is added to each node in the view.

To remove a measure from a Cube Explorer view:

1. In the View Manager, make sure that the measures are displayed
2. To remove a measure from the view, click the inverted triangle icon beside the measure that you want to remove and select **Remove from Explorer**. The measure is removed from all of the nodes in the view.

To change the percentage:

1. In the View Manager, make sure that the measures are displayed
2. Click the inverted triangle icon beside any measure and select **Show Percentage For ▶ measure-name**. The nodes are updated to display the new percentage.
Customizing the Appearance of the Cube Explorer

You can customize the appearance of the Cube Explorer by changing the labels that are displayed, the look of the parent nodes, and the color shadings.

In the Cube Explorer panel, select the options that you want to change:

- **Show percentage** – displays the relative contribution of each child node to its parent by using the primary measure that was defined when you created the view.

  **Note:** The percentages might not always add up to 100%, depending on the statistic that is used in the measure and whether calculated members are included in the results. The percentages would not add up to 100% in the following examples:

  - The primary measure represents an average value, such as the average cost per unit. Because the values are averages instead of precise values, the total might not be exactly 100.
  
  - The primary measure includes values from a calculated member that aggregates members from other levels. For example, you might have a cube with a Cars dimension that includes levels for several car companies as well as a Red Cars calculated member that includes all red cars. In this case, the total percentage would be greater than 100 because the red cars would be counted twice: once with car company level and again with the Red Car calculated member. Percentages from calculated members are displayed with an asterisk.

- **Show level labels** – displays the name of each level within its dimension.

- **Show calculated members in results** – includes calculated members in the current Cube Explorer view.

- **Orientation** – specifies how you want to display the nodes in the Cube Explorer.

- **3D look for parent nodes** – displays the parent nodes with a three-dimensional appearance.

- **Apply color shadings based on** – determines how color shading is applied. If you select Dimension levels, then nodes are shaded darker the deeper in the hierarchy that they are. If you select Measure values, then nodes are shaded darker as the value increases.

  To change the colors that are used for the shading, select a color from the color drop-down list.

  To change the background color of the Cube Explorer, select a color from the **Background color** drop-down list.

Any changes that you make are immediately applied to the Cube Explorer.
Creating a Slice of a Cube

Using the OLAP Analyzer, you can manually create a slice of a cube. When you create a slice of a cube, you are creating a SAS data set that is based on the current view of an OLAP cube in the OLAP Analyzer.

To create a slice of a cube:

1. Open the OLAP cube in the OLAP Analyzer, and navigate in the cube to create the view of the data that you want in the slice.

2. In the OLAP Analyzer group on the SAS tab in the Ribbon, click .

The cube slice is opened in a Microsoft Excel worksheet, and now you can use the cube slice as an input data source.

Navigating in an OLAP Cube

Creating a New Cube View

The OLAP Analyzer displays the OLAP cube with a default table view. Only one table view can be open at a time. You can create additional graph views.

To create a new view:

1. Click the SAS tab in the Ribbon. In the OLAP Analyzer group, click Insert View and select a view type. If you select Automatic Chart, then the OLAP Analyzer chooses the best chart for the data based on the number of measures and whether the data includes a time dimension.

   The Choose Location dialog box appears.

2. Specify the region where you want to insert the new view, and then click OK.

   The new view opens in the Excel worksheet.

Adding and Rearranging Members in the Table and Graph Views

In the OLAP Analyzer, you can change the members that are displayed in the table and graph views. You can add new members to the views, and you can also move members between the rows and columns.

To add a member to the table and graph views:
1 In the Cube Manager, click to display the Data Dimensions view.

2 Expand the tree as necessary, and select one or more members or member sets that you want to add.

Note: If you select a member of a different type, then all previously selected members are deselected and only the current member remains selected. For example, if you have selected three measures, and you press Ctrl + click to also select a level, then the measures are automatically deselected and only the level is selected.

3 Right-click the selected member and add to the row axis, to the column axis, or the slicer dimension.

The table and graph views are updated.

Understanding the Hidden Hierarchies and Slicers

By default, each hierarchy that is not displayed in the table view as a row or a column is called a hidden hierarchy. The default value for each hidden hierarchy is the default member for the hierarchy. (The default member for a hierarchy is usually the [All] member, which includes all members of that hierarchy.)

You can assign another member in the hierarchy to a hidden hierarchy to create a slicer. Slicers restrict the data that is displayed. For example, in a cube that contains sales data, you could display the sales by customer region and year. You could create a slicer to restrict this data by using the Products hierarchy to display only the sales data for electronic products as shown below.

You can view the hidden hierarchies and slicers in the View Details area of the OLAP Analyzer.

To create a slicer:

1 To display the hidden hierarchies, click Show in the View Details area, and then select Hidden. Click OK.

2 Click the hidden hierarchy that you want to edit. The Select Members window appears.

3 Use the Browse, Search, and Use Filter tabs to select the members that you want to use.

4 You can add members in the following ways:
   - To add only the selected member, click Add.
To add the selected member and all of its children members, click the inverted triangle on the Add button and select Selected and children.

To add the selected member and all of its descendants, click the inverted triangle on the Add button and select Selected and all descendants.

To add all of the members, click Add All.

Note: You cannot select any members that are ancestors of other selected members.

Click Select to update the hierarchy. The slicer is applied to the cube and added to the list of slicers in the View Details area.

Drilling Up and Down within an OLAP Cube

The OLAP Analyzer displays the OLAP cube in a table view that you can use to drill up and down in your data. You can use drilling to navigate in your data from the most summarized levels to the most detailed levels. You can drill down on all members of a level, or you can drill down on a specific member of the level. You can also drill in the graph view. Because the table view and graph views are synchronized, all views are updated when you drill up or down in one view.

For dimensions with multiple hierarchies, you can change the drill-down path by changing the navigation hierarchy for members or for hierarchies, levels, and measures.

To drill on all members of a level in the table view, right-click on the level heading that you want to drill down on and select Drill Down. From the submenu, select the level to which you want to drill down.

To drill on a specific member of a level in the table view, in the row or column heading for the member that you want to drill down on, click [3].

To drill in the graph view, right-click the area of the graph where you want to drill, and select Drill Down on or Drill Up to. A submenu lists the rows and columns that you can drill on. You can also choose to drill on both rows and columns. If you double-click an area of the graph, the default behavior is to drill on all of the rows and columns.

To change the navigation hierarchy for a member:

1. In the table view, right-click on the row or column heading that you want to change and select Replace With.

2. From the pop-up menu, you can select a level in the current hierarchy, another hierarchy, or another dimension to use for navigation. The current member is removed from the table view and is included instead as a hidden hierarchy.

To replace the navigation hierarchy for a hierarchy, level, or measure, right-click on a level or measure heading in the table view, or click beside a dimension or measure in the View Manager, and select Replace With. From the pop-up menu, you can select a replacement for the current level, hierarchy, or measure.
Note: You cannot change the navigation hierarchy in dimensions that have only one default hierarchy defined.

Isolating and Removing Members

You can isolate one or more members in the table or graph views of the OLAP Analyzer so that no other members are displayed. You can also remove specific members from the view. Because the table and graph views are synchronized, all views are updated when you isolate or remove members in one view.

TIP You can return to previous views of the cube by clicking the Back button. You can also restore the default view of the cube.

To isolate or remove a member, right-click the row or column heading in the table view that you want to keep or remove, and select Keep Only member-name in hierarchy-name or Remove member-name. You can also right-click the appropriate member label in the graph view and select Keep Only hierarchy-name, member-name or Remove member-name.

Browsing the Different Views of an OLAP Cube

After you have created different views, or slices, of an OLAP cube, you can browse backward and forward through the different views. You can also reset your view to the default view.

If you want to save a specific view, you can save it as a bookmark. You can also specify a bookmark that you create to be the default view.

To browse through views, click the Back and Forward buttons in the OLAP Analyzer group in the SAS tab in the Ribbon.

To restore the default view:

1. Click in the Cube Manager to open the Bookmarks view.
2. Click Initial default view. The default view is restored.

Setting and Using Bookmarks

You can set a bookmark in an OLAP cube to save a particular view, or slice, of the cube. You can then use the Bookmarks view in the Cube Manager to go to that saved bookmark directly without navigating through the grid again.

You can also edit, rename, and delete bookmarks that you have previously saved as well as restore the default view. To change the default view, specify a bookmark that you create to be the new default view.
Note: If you create a bookmark that includes an item such as a filter, percent of visual total, conditional highlight, calculated measure, or calculated member, then that bookmark is automatically deleted if the item is deleted.

To create a new bookmark:
1. Click in the Cube Manager to open the Bookmarks view.
2. Click in the Bookmarks view. The Add Bookmark dialog box appears.
3. In the Name box, enter a name for the bookmark. If you save the new bookmark with the same name as an existing bookmark, you are prompted to choose a new name for the bookmark.
4. In the Description box, enter a description of the bookmark.
5. Click Add to save the bookmark. The new bookmark is added to the list of bookmarks.

To go to an existing bookmark:
1. Click in the Cube Manager to open the Bookmarks view.
2. Click the name of the bookmark that you want to go to. The table and graph views are updated.

Note: To reset both the table view and the graph to their default view and clear any filters that are set, click Initial view in the Bookmarks view.

To edit an existing bookmark:
1. Click in the Cube Manager to open the Bookmarks view.
2. Click Manage in the Bookmarks view. The Manage Bookmarks window appears.
3. Select the bookmark that you want to edit. In addition to deleting, reordering, or renaming a bookmark, you can also select the bookmark to use as the default view of the cube and edit the MDX code that is used to create the query for the bookmark.

Note: You cannot edit or delete the Initial view bookmark.

4. Click OK to save your changes.

To restore the default view, right-click in a table view or a graph view and select Show Default View.

Note: You can also restore the default view by clicking Initial view in the Bookmarks view.
Analyzing the Data in an OLAP Cube

About Customized Items and Sets

The Customized Items and Sets view in the Cube Manager enables you to customize your cube views with items that are derived from other values within the cube. You can also create groups of members from the same dimension.

Here are the customized items and sets that you can create:

- calculated measures
- calculated members
- percent of visual total items
- member sets
Creating Calculated Measures

What Is a Calculated Measure?
You can add a calculated measure to a dimension in an OLAP cube. A calculated measure is a special dimension that usually represents numeric data values that are analyzed. Calculated measures can be computed from other values and must return either a string or a numeric value. However, most OLE DB for OLAP providers support only numeric values.

Note: This option is available only for OLAP cubes that were created with SAS 9 or that were created for other OLE DB for OLAP providers that support calculated measures.

Count Analysis
You can use this type of analysis to calculate the discount count of a measure.

1 If you are using the OLAP Analyzer, click in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.
   If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members ⇒ New.
   The Add Calculated Member wizard opens.

2 In the Name box, enter the name of the new calculated measure.

3 For the type of analysis, select Special analysis, and from the drop-down list, select Count analysis. Click Next.

4 Select the type of calculation for the new measure:
   ▪ Member Count - counts the number of members in the hierarchy or counts the number of members on a specified level.
   ▪ Unique Item Count (Discount Count) - counts the number of nonempty values for a level in a hierarchy.

5 Select the hierarchy to use in the calculation. You can also select the level of the hierarchy to use. Selecting a level is usually recommended. If you are calculating a distinct count, then select the measure to use in the calculation.

Note: If you are working with an SAP cube, then you must select a level.

Click Next.

6 For a unique item count, select the measure to use.

7 Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in
Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

8 Specify how the new measure is available:

- **Locally, to me** - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.

- **Publicly, to all users at all times** - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

---

**Note:** If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

---

**Note:** You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

---

9 In the **Solve order** box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

Click **Next**.

10 Review a summary of your selections and the MDX expression. Click **Finish** to create the new calculated measure.

---

**Note:** If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.

---

### Custom Calculation

To create a calculated measure for a custom calculation:

1 If you are using the OLAP Analyzer, click **Add** in the Cube Manager. In the Customized Items and Sets view, click **Add Calculated Member**.

   If you are working in a PivotTable, click **OLAP Options** on the **SAS** tab, and select **Calculated Members** ⇒ **New**.

   The Add Calculated Member wizard opens.

2 In the **Name** box, enter the name of the new calculated measure.
3 For the type of analysis, select **Use MDX statement to create custom analysis**. Click **Next**.

4 Specify the formula that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

5 Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

6 Specify how the new measure is available:

- **Locally, to me** - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.

- **Publicly, to all users at all times** - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

   **Note:** If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to **Locally, to me**. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

   **Note:** You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

7 In the **Solve order** box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query. Click **Next**.

8 Review a summary of your selections and the MDX expression. Click **Finish** to create the new calculated measure.

   **Note:** If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.
Relative Contribution Analysis

You can use this type of analysis to determine how much the value of a measure contributes to the total value or to the value of a parent dimension. You can choose to display this calculation as a percentage.

To create a new measure for relative contribution analysis:

1. If you are using the OLAP Analyzer, click \[\text{Add Calculated Member}\] in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.
   
   If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members \(\Rightarrow\) New.
   
   The Add Calculated Member wizard opens.

2. In the Name box, enter the name of the new calculated measure.

3. For the type of analysis, select Special analysis, and from the drop-down list, select Relative Contribution analysis. Click Next.

4. Select the type of calculation for the new measure:
   - Member contribution relative to a selected member - how much the member contributes to a selected value. For example, you might need to know how much the sales of a product contributed to your company’s yearly sales.
   - Member contribution relative to its parent - how much the member contributes to the value of the parent member. For example, you might need to know how much the sale for a state contributed to the quarterly sales for a geographic region.

5. Select the hierarchy to use in the calculation. You can also select the level of the hierarchy to use. Selecting a level is usually recommended. If you are calculating a distinct count, then select the measure to use in the calculation.
   
   Note: If you are working with an SAP cube, then you must select a level.

   Click Next.

6. If you are calculating a member’s contribution relative to a selected value, then select the member that contains the value to use in the comparison.

7. Select the measure to use in the calculation. Click Next.

8. Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

9. Specify how the new measure is available:
   - Locally, to me - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.
   - Publicly, to all users at all times - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS
OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

Note: If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

Note: If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.

10 In the Solve order box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

Click Next.

11 Review a summary of your selections and the MDX expression. Click Finish to create the new calculated measure.

Note: If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.

Basic Analysis

You can use this type of analysis to calculate the sum, the difference, the product, the ratio, and the percent change of two measures.

Note: This option is available only for OLAP cubes that were created with SAS®9 or that were created for other OLE DB for OLAP providers that support calculated members.

1 If you are using the OLAP Analyzer, click in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.

If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members ⇒ New.

The Add Calculated Member wizard opens.

2 In the Name box, enter the name of the new calculated measure.

3 For the type of analysis, select Basic analysis. Click Next.

4 Select the type of calculation for the calculated measure:
   - Sum - the combined value of two measures.
- **Difference** - the difference between two measures.
- **Product** - the multiplied value of two measures.
- **Ratio** - the relationship between two measures.
- **Percent change** - the percent change between two measures.

After you have selected the calculation type, use the drop-down lists in the **Calculations** area to specify the measures to use in the calculation. Click **Next**.

5. Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

6. Specify how the new measure is available:
   - **Locally, to me** - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.
   - **Publicly, to all users at all times** - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

   **Note:** If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to **Locally, to me**. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

   **Note:** You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

7. In the **Solve order** box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

   Click **Next**.

8. Review a summary of your selections and the MDX expression. Click **Finish** to create the new calculated measure.

   **Note:** If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.
Time Series Analysis

You can use this type of calculated item to calculate the sum or average of a measure during a specific time period, and to compare activity between time periods, the amount of growth between time periods, and balance calculations.

Note: If your OLAP cube does not contain a time dimension, this analysis is not available.

To create a calculated member for time series analysis:

1. If you are using the OLAP Analyzer, click in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.

   If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members \(\Rightarrow\) New.

   The Add Calculated Member wizard opens.

2. In the Name box, enter the name of the new calculated measure.

3. For the type of analysis, select Special analysis, and from the drop-down list, select Time series analysis. Click Next.

4. Select the type of calculation for the new measure:
   - **Rolling totals** - the cumulative total of a specified measure for a specified time period. For example, you could calculate the cumulative sales of a product from the beginning of the year to the current date.
   - **Rolling averages** - the cumulative average of a specified measure for a specified time period. For example, you could calculate the average sales of a product from the beginning of the year to the current date.
   - **Totals to date** - the cumulative totals of a measure for a specified time period. For example, you could calculate the cumulative total sales for a product from the beginning of the year to the current date.
   - **Average to date** - the cumulative average of a measure for a specified time period. For example, you could calculate the cumulative average sales for a product from the beginning of the year to the current date.
   - **Growth, comparing parallel periods** - a comparison of the value of a measure during parallel time periods. For example, you could compare product sales from Q1 2013 to product sales from Q1 2012.
   - **Growth, comparing parallel period totals to date** - a comparison of the totals during parallel time periods. For example, you could compare total product sales from January through the current month to the total product sales from January through the same month last year.
   - **Growth, comparing consecutive periods** - a comparison of the value of a measure for a time period versus the preceding period. For example, you could compare product sales from one quarter to the next.
   - **Opening balance** - the value of a measure at the beginning of a time period. For example, this value could be the amount of inventory that you have for a product at the beginning of the month.
Closing balance - the value of a measure at the end of a time period. For example, this value could be the amount of inventory that you have for a product at the end of the month.

5 Select the hierarchy to use in the calculation. You can also select the level of the hierarchy to use. Selecting a level is usually recommended. If you are calculating a distinct count, then select the measure to use in the calculation.

Note: If you are working with an SAP cube, then you must select a level.

Click Next.

6 From the In drop-down list, select the measure to use in the calculation.

Note: This option is available only if you selected a growth calculation.

7 From the With measure drop-down list, select the measure to use in the calculation.

8 Specify the time period of the data. For some calculations, you might need to specify the number of periods for the analysis. For example, you might want to specify how many time periods (such as months or years) that you want to include in a rolling calculation, or you might want to compare data between two periods (such as sales in 2007 compared with sales in 2006).

Click Next.

9 Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

10 Specify how the new measure is available:

- **Locally, to me** - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.

- **Publicly, to all users at all times** - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

Note: If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

Note: You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.
In the Solve order box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query. Click Next.

Review a summary of your selections and the MDX expression. Click Finish to create the new calculated measure.

Note: If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.

Trends and Forecasting Analysis
You can use this type of calculated item to calculate the correlation or the covariance, or to perform a linear regression analysis.

Note: If your OLAP cube does not contain a time dimension or your provider does not support the statistics for trend and forecasting analysis, this analysis is not available.

To create a calculated member for trends and forecasting analysis:

1. If you are using the OLAP Analyzer, click in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.

   If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members ➔ New.

   The Add Calculated Member wizard opens.

2. In the Name box, enter the name of the new calculated measure.

3. For the type of analysis, select Special analysis, and from the drop-down list, select Trends and Forecasting analysis. Click Next.

4. Select the type of calculation for the new member:
   - **Correlation** - statistic that measures the strength of the linear relationship between two series of values. The values of correlation coefficients range from –1 to 1.
   - **Covariance** - the tendency of two measures to increase or decrease together at the same time.
   - **Linear Regression Intercept** - the intercept of the line that is created by an attempt to assign a linear function to your data by using the least squares method.
   - **Linear Regression Point** - a predicted value on the line that is created by an attempt to assign a linear function to your data by using the least squares method.
   - **Linear Regression Slope** - the slope of the line that is created by an attempt to assign a linear function to your data by using the least squares method.
Linear Regression Variance - the average of the total squared dispersion between each observation and the line that is created by an attempt to assign a linear function to your data by using the least squares method and the sample mean.

Select the measure or measures to use in the calculation.

Select the time hierarchy.

If you are calculating the linear regression point, you can also select the time period to use in the calculation. By default, the trend is calculated across all time periods.

Select the format that you want to apply to the new calculated measure. If you are using a SQL server cube, then the formats in this list are similar to formats in Microsoft Excel. If you are using a SAS cube, then the formats in the list are SAS formats. You can also specify a custom format.

Specify how the new measure is available:

- Locally, to me - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.

- Publicly, to all users at all times - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

Note: If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

Note: You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

In the Solve order box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

Click Next.

Review a summary of your selections and the MDX expression. Click Finish to create the new calculated measure.

Note: If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.
Changing the Format of a Measure

You can change the format of measures that are displayed in the OLAP Analyzer. If you change the format of a globally calculated measure or a measure that was defined with the cube, a new measure is created with the format that you selected. The new measure is used to replace the existing measure in the view. If you change the format of a calculated measure that you have created, then the definition of the calculated measure is updated with the new format.

To change the format of a globally calculated measure or a measure that was defined with the cube:

1. In the table view, right-click the row or column heading of the measure that you want to reformat and select **Change Format To** `format-name`.

2. In the warning dialog box, click **Replace**. A new measure named `measure-name_formatted` is created with the format that you selected. The original measure is replaced in the view with the new measure.

To change the format of a calculated measure in the table view, right-click the row or column heading of the measure that you want to reformat and select **Edit measure-name format-name**. The measure values are reformatted, and the format is saved with the calculated measure definition.

Creating Calculated Members

About Calculated Members

You can add a calculated member to a dimension in an OLAP cube. A calculated member is a member whose value is derived from the values of other members in the same dimension. A calculated member must be associated with a parent dimension. By default, the member is added to the top level of the parent dimension, which in most cases is the All level. However, you can specify the level to use.

Note: This option is available only for OLAP cubes that were created with SAS®9 or that were created for other OLE DB for OLAP providers that support calculated members.

Note: Calculated members that were created in SAS Information Map Studio are not supported in SAS Add-In for Microsoft Office.

Aggregate Across Members

To create a calculated member that is aggregated across members:

1. If you are using the OLAP Analyzer, click `add` in the Cube Manager. In the Customized Items and Sets view, click **Add Calculated Member**.

2. If you are working in a PivotTable, click **OLAP Options** on the **SAS** tab, and select **Calculated Members** `New`.
The Add Calculated Member wizard opens.

2 In the Name box, enter the name of the new calculated member.

3 For the type of analysis, select Aggregate across members.

4 Select the parent dimension. The member is added to the top member of the parent dimension, which in most cases is the All member. To change the member, click All member-name.

The selected member appears in the Add Calculated Member wizard. Click Next.

5 If you are aggregating members for a parent, then from the Select a member pane, select a member. The children of that member appear in the Check members to aggregate pane.

If you are aggregating members on a level, then from the Select a member pane, select a level. The members of that level appear in the Check members to aggregate pane.

6 In the Check members to aggregate pane, select the check boxes for the members that you want to aggregate. Click Next.

7 Specify how the new measure is available:
   - Locally, to me - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.
   - Publicly, to all users at all times - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

   Note: If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

   Note: You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

8 In the Solve order box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

Click Next.

9 Review a summary of your selections and the MDX expression. Click Finish to create the new calculated measure.
Custom Calculation

To create a calculated member for a custom calculation:

1. If you are using the OLAP Analyzer, click in the Cube Manager. In the Customized Items and Sets view, click Add Calculated Member.
   If you are working in a PivotTable, click OLAP Options on the SAS tab, and select Calculated Members => New.
   The Add Calculated Member wizard opens.

2. In the Name box, enter the name of the new calculated member.

3. For the type of analysis, select Use MDX statement to create custom analysis. Click Next.

4. From the Parent hierarchy drop-down list, select the parent dimension. The member is added to the top member of the parent dimension, which in most cases is the All member.

5. Specify the formula that you want to use for the new calculated member.
   After you have created and verified your expression, click Next.

6. Specify how the new measure is available:
   - Locally, to me - the calculated measure is valid for as long as you are using the OLAP cube in your current session. After the calculated measure has been created, it can be used by all queries in the same session. A calculated measure with this scope is available only to the person who created it.
   - Publicly, to all users at all times - the calculated measure is available to anyone who connects to that cube. This option is available only on a SAS OLAP server. If you are not using a SAS OLAP server, then this option is disabled and the value is set to Locally, to me. You must also have WriteMetadata permission on the metadata server to use this option. If you do not have this permission, then an error message is displayed. For more information, contact your SAS administrator.

Note: If the calculation for the new measure includes a measure with local scope, then the scope option is disabled and the value is set to Locally, to me. When a measure with local scope is used to create another calculated measure, the new calculated measure must be created with local scope as well.

Note: You cannot specify the availability of a calculated measure for an OLAP cube that is opened in a PivotTable.

7. In the Solve order box, enter the number that specifies the priority for evaluating the calculated member or calculated measure. A higher solve order results in the calculated member or calculated measure being evaluated later in the
expression. The solve order usually is not needed, but it can be used when there is more than one calculated member or calculated measure in a query.

Click **Next**.

8 Review a summary of your selections and the MDX expression. Click **Finish** to create the new calculated measure.

Note: If you are working with an SAP cube, you cannot specify the format, availability, and solve order options. Any calculated measures that you create are available only to you.

---

**Editing Calculated Measures and Calculated Members**

**Edit a Calculated Measure or Calculated Member**

Before you edit a calculated measure or calculated member, review these restrictions:

- You cannot add, edit, or delete a calculated measure or calculated member that is publicly available and is associated with an OLAP cube that is opened in a PivotTable.

- When you create a calculated measure or calculated member using the OLAP Analyzer, you must specify how the calculated item is available. Calculated items can be available locally (only to you) or globally (publicly available to everyone at your site). You cannot edit calculated items that are publicly available and were not created in the current session. Global calculated items that were created in the current session can be edited.

1 Click in the Cube Manager to open the Customized Items and Sets view.

2 In the Customized Items and Sets view, select the calculated measure or calculated member that you want to edit. Click **Edit**. The Add Calculated Measure wizard or the Add Calculated Member wizard appears.

3 Using the options in the wizard, modify the calculated measure or calculated member, and click **Finish** to save your changes.

Note: You cannot change the hierarchy for an existing calculated member, so when you edit a calculated member, the **Parent hierarchy** drop-down list is disabled.

**Viewing the MDX Code for a Generated Calculated Measure or Calculated Member**

When you create a calculated measure or calculated member, you must specify how the calculated item is available. Calculated items can be available locally (only to you) or globally (publicly available to everyone at your site). You cannot edit calculated items that are publicly available. However, you can view and copy the MDX code for these global calculated measures or calculated members.
To view the MDX code for a global calculated measure or calculated member:

1. Click in the Cube Manager to open the Customized Items and Sets view.

2. In the Customized Items and Sets view, select the calculated measure or calculated member and click View. The View MDX Statements dialog box appears.

   **Note:** The View button is available only for calculated measures or calculated members that you cannot edit. If you can edit the calculated measure or calculated member, then the Edit button is available instead.

3. To copy the MDX code, click Copy to Clipboard.

Using the Advanced Expression Editor for a Calculated Measure or Calculated Member

You can use the Advanced Expression Editor to create the formula for a calculated measure or calculated member. To create an expression:

1. You can build your expression by using constant values, existing members, mathematical operators, and MDX functions. You can use the Advanced Expression Editor window to add these elements, or you can enter them in the expression box at the top of the Advanced Expression Editor window.
   - To add operators, click the buttons below the expression box.
   - To add an MDX function, select a category of functions from the MDX Functions list, and then select the specific function that you want to use.

   **Note:** The functions are categorized according to their return type. To view all of the functions in alphabetical order, select the All category.

   - To add a specific dimension or level to the query, click the tab that corresponds to the dimension. Select the appropriate dimension or level and click to add it to your expression.
   - To add metadata to the query, select the metadata item and click to add it to your expression. You can also double-click items in the MDX Functions and Metadata boxes to add the items to the expression.

2. Click Verify to validate your expression.

3. Click OK. If your MDX syntax is not valid, you will not be able to save the expression.

Setting Options for the MDX Editor

You can customize these options for the Enhanced Editor that is available in the MDX Editor.
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow cursor movement past end of line</td>
<td>enables you to move the cursor past the end of the line in the program window. If you do not select this option, the cursor jumps down to the next line when you move it past a carriage return, and only the text on each line is highlighted during selection.</td>
</tr>
<tr>
<td>Drag and drop text editing</td>
<td>enables drag-and-drop editing to cut, copy, or paste text.</td>
</tr>
<tr>
<td>Show line numbers</td>
<td>displays line numbers in leftmost column of program windows. You cannot select line numbers.</td>
</tr>
<tr>
<td>Strip Ctrl+Z characters</td>
<td>removes any Ctrl-Z characters from the file. Ctrl-Z characters can be an end-of-file marker in some files.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File type</td>
<td>displays the type of file whose general settings you are editing. To change the settings of another file type, select the file type from the File type drop-down list.</td>
</tr>
</tbody>
</table>
| Tab settings                                    | ▪ Tab size - displays the number of spaces that are inserted into your text when you insert a tab character. The default value is four spaces for each tab character.  
  ▪ Insert spaces for tabs - inserts the number of spaces listed in the Tab size box instead of a single tab character.  
  ▪ Replaces tabs with spaces on file open - automatically replaces all tab characters with the number of spaces listed in the Tab size box when you open the file. |
<p>| Indention                                       | specifies the indentation for a new line.                                                                                                  |
|                                                 | ▪ None - turns off all automatic indentation.                                                                                               |</p>
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>- automatically indents a new line by the amount of space that the previous line is indented.</td>
</tr>
</tbody>
</table>

Creating and Using Member Sets

In the OLAP Analyzer, you can create member sets, which are groups of members from the same dimension. You can use member sets in the Data Dimensions view to add multiple members to the rows and columns at one time.

To create a new member set:

1. Click in the Cube Manager to open the Customized Items and Sets view.
2. Select Add ➔ Member Set.
3. Specify a name for the member set.
4. Select the dimension from which you want to select members.
5. Use the Browse, Search, or Use Filter tabs to select the members that you want to include in the member set.
6. Click OK to create the member set.

Creating and Using Percent of Visual Total Items

In the OLAP Analyzer, you can create another type of measure that computes the percent that each value is of a visual row, column, or grand total. Visual totals display only the total of the values that are displayed in the cube view. In order to create a percent of visual total item, you must display visual totals in the cube view.

Note: Percent of visual total items cannot be used in conditional highlights, calculated measures or members, or as filter criteria.

To create a new percent of visual total item:

1. Click in the Cube Manager to open the Customized Items and Sets view.
2. Select New ➔ Percent of Visual Total.
3. From the Percent of drop-down list, select the total that you want to use.
   - Grand Total - calculates the percent that each value is of the grand total of all row and column totals
   - Row Total - calculates the percent that each value is of the total for the row.
   - Row Subtotals - calculates the percent that each value is of the subtotal for each row. The row subtotal is the row total for each level.
   - Column Total - calculates the percent that each value is of the total for the column.
Column Subtotals - calculates the percent that each value is of the subtotal for each column. The column subtotal is the column total for each level.

4 Select the measure that you want to use in the calculation.

5 Enter the name of the percent of total item. The name is displayed in the list of items in the Customized Items and Sets view.

6 Click OK to create the percent of total item.

Note: If the cube totals that are displayed are not visual totals, then you are prompted to set the totals to visual totals. If you do not set the totals to visual totals, then the percent of total item is created, but it cannot be added to the view until the totals are set to visual totals.

Adjusting Values in a Write-Enabled Cube

If you are using an OLAP server that supports write-enabled cubes, such as Microsoft SQL Server Analysis Services, then you can use the OLAP Analyzer to adjust values in the cube. You might want to adjust values in a cube in order to conduct a what-if analysis and determine how a change to one value might affect other values in the cube. For example, in a cube that contains budget data, you could adjust the budgeted values for personnel expenditures to see how total profit is affected.

When you adjust a value in a cube, the OLAP Analyzer automatically makes proportional adjustments to all of the other leaf values in the hierarchy. The adjusted values are stored in a separate file that is saved with your project and automatically applied to the cube each time you open it in that project. The original values in the cube are not updated. If you want to view the cube in its original form again, you can clear the cube changes or reopen the cube in your project.

You can adjust a value either by specifying a new value or by specifying the percentage by which you want to increase or decrease the current value.

Note: Depending on the size of your cube, the process of adjusting all of the leaf values might take a few minutes. You cannot stop the process once it has started.

To adjust a value in a cube in the table view, right-click the value that you want to change and click Adjust Value. Select one of the following options:

- Enter Value - enables you to specify a new value in the cube. The percentage of change is calculated and applied to all of the leaf values in the hierarchy.

  Note: You can also specify a new value by double-clicking the value that you want to change and then entering the new value.

- Increase Value by 10% - increases the current value by 10%. All of the leaf values in the hierarchy are also increased by 10%.

- Increase Value by 5% - increases the current value by 5%. All of the leaf values in the hierarchy are also increased by 5%.
- **Decrease Value by 10%** - decreases the current value by 10%. All of the leaf values in the hierarchy are also decreased by 10%.

- **Decrease Value by 5%** - decreases the current value by 5%. All of the leaf values in the hierarchy are also decreased by 5%.

- **Change Value by Other Percent** - opens the Adjust Value By Percent dialog box so that you can specify the percentage by which to adjust the value. Select whether you want to increase or decrease the values, and then specify the percentage. All of the leaf values in the hierarchy are also adjusted by the same percentage.

**Note:** To view a list of all the changes that you have made to the cube, click in the Cube Manager.

To clear the cube changes and return to the original cube values:

1. Click in the Cube Manager to open the Cube Change History view.
2. Click **Clear All**, and then click **OK** in the confirmation dialog box.

---

### Viewing Member Properties

You can use the OLAP Analyzer to view member properties that might be stored with your cube. Member properties are additional attributes that can be associated with dimension members. For example, in a cube that stores sales data for retail stores, you might also have member properties that include each store’s size in square feet, the store address, and the current manager.

You can view one or more properties at a time, and you can choose to display member properties instead of the member caption.

To view member properties:

1. In the table view, right-click on the level heading for which you want to view member properties and select **Show Member Property**.
2. In the **Level** box, select the level from which you want to select member properties.
3. In the **Member properties for level-name** box, select one or more member properties that you want to include in the table view.
4. If you want to turn off the display of the property name and show only the property value, clear the **Show property name for level-name** check box.
5. If you want to turn off the display of the member captions and show only the member properties, clear the **Show member caption for level-name** check box. You can clear the **Show member caption for level-name** check box only if you have selected at least one member property to display.
6. Click **OK** to display the member properties in the table view.
Edit an Existing Cube View

The OLAP Analyzer displays the OLAP cube with a default table view. You can use the View Editor to edit any existing table view by adding and removing members from the columns and rows. You can also rearrange the order of the columns and rows. When you edit a view, no changes are made to the table until you save them.

You can also delete existing views.

To edit an existing view:

1. Right-click on the table view and select Table View ➔ Edit View ➔ Edit with View Editor. The Edit window appears.

2. Click the Browse tab if it is not already selected, and expand the tree as necessary to view the different levels in a dimension. By default, the dimensions are displayed in a parent-child hierarchy.

   **TIP**  
   The tree view displays all of the items that are included in the current query in bold.

   **TIP**  
   To view the levels inside the parent-child hierarchy, click Show Levels. The hierarchical tree view is replaced with a view that displays all of the levels for a dimension without regard for their parent-child relationship. You can use the Show Levels option to view lower-level members that might otherwise be hidden if their parents are hidden due to security restrictions.

3. To add a member to the columns or rows, select the member that you want to add. You can drag the member to the list of columns or rows, or you can choose to add a member as follows:
   - To add only the selected item to the list of columns or rows, click the arrow beside the Columns or Rows area.
   - To add the selected item and all of its descendants, click the inverted triangle on the arrow button and select Selected and all descendants.

   **Note:** This option is relevant only if the selected item is a member rather than a dimension.

4. To rearrange the order of the columns or rows, select the member that you want to move up or down and click the appropriate or button.

5. Click OK.
Using the MDX Editor

By default, the query that the OLAP Analyzer has created for the current view of the OLAP cube is displayed in the MDX Editor. You can either edit that query, or clear the query and write your own.

For details about MDX syntax, refer to the Microsoft Data Access Components Software Developer’s Kit.

To use the MDX Editor:

1. Right-click on the table view and select Edit View ⇒ Edit with MDX Editor.
2. Select the members and functions that you want to use in your query.
3. When you are ready to run your query, click OK.

Filtering and Sorting Data in an OLAP Cube

About Filtering Data in an OLAP Cube

When you view OLAP data in the OLAP Analyzer, you might want to retrieve only data that meets certain criteria, based on values in the data. The process of telling the OLAP Analyzer which data to retrieve is called creating a filter and is performed in the Filters view of the Cube Manager.

When you apply a filter to your data, the filter can usually remain applied while you expand, collapse, or drill in your data. However, if you change what is displayed in the table or graph views so that the filter can no longer be applied, then the filter is automatically removed from the view.
Two Types of Filters: Rank Values and Range of Values

You can filter your OLAP data by specifying criteria to limit the values in a column that is currently displayed in the table. You can filter the data by ranking the measure values of the column or by specifying a range of the measure values to view.

You can create two types of filters:

- **Rank values** - filters the data by ranking measure values.
- **Range of values** - filters the data by specifying a range of measure values to view.

When you create a rank filter, you can choose whether you want to view the top or bottom rankings, and you can choose to rank the data by count, by percentage of count or total value, or by sum. For example, you could choose to filter a column of profit data to display only the top 10 profits in that column.

When you create a range filter, you can specify the range of values by selecting a comparison operator and the value that you want to be compared in the filter. For example, you could choose to filter a column of profit data to display only values that are below $20,000.

Create a Rank Values Filter for a Column

To create a column filter based on rank:

1. Click 📉 in the Cube Manager to open the Filters view.
2. Click 📉 in the Filters view. The New Filter dialog box appears.
3. For the **Limit members on column** option, select the column on which you want the filter to be based. By default, the first column in the table is selected. To select another column, click the column name.
4. For the **Based on** option, select **Rank**.
5. To create the filter, you must specify the measure that you want to use. This option is available only if there are measures displayed in the columns of the table view.
6. Select whether you want the top (largest) or bottom (smallest) values returned in the ranking. By default, the top values are returned.
7. Specify the number of values that you want to return in the ranking. The default value is 10.
8. Specify how you want the rank to be determined:
   - **Count** - returns the top or bottom \( n \) members, where \( n \) is the numeric value that you specified. For example, if you specified **Bottom** and a numeric value of 5, then the filter would return the bottom, or smallest, five members.
   - **Percent by Count** - returns the top or bottom \( n \) percent of members, where \( n \) is the numeric value that you specified. For example, if you specified **Top** and
a numeric value of 10, then the filter would return the top, or largest, 10% of the members. If there were 500 members in the set, the top 50 members would be returned.

- **Percent by Value** - returns the top or bottom n percent of the sum of the values of the selected measure, where n is the numeric value that you specified. For example, if you specified Top and a numeric value of 90, then the sum of the members that are returned would equal at least 90% of the total sum of all of the measure values. If the member values that are being filtered include 6, 3, and 1, which add up to 10, then the members that are returned would be 6 and 3, which add up to 9, or 90% of 10.

- **Sum** - returns the top or bottom members until their sum is at least the numeric value that you specified. For example, if you specified Top, a numeric value of 10, and the member values to filter include 5, 3, 2, and 1, then the members that are returned would be 5, 3, and 2 because their sum is 10.

9 Specify whether you want to include ties and missing values in your filter results. By default, ties are included. Click the ties and missing values option to display the check boxes.

- **Include ties** - includes multiple members that meet the criteria for the last member to return in your filter results. If you want to include only one arbitrarily chosen last member, then clear the Include ties check box.

- **Include missing values** - includes missing values in the values that are ranked. This option is not selected by default.

10 Specify a name for the filter. By default, the filter name is **Column (columnname)**.

11 Click OK to create the new filter. The new filter is applied to the cube and added to the list of filters in the Filters view.

---

**Create a Range of Values Filter for a Column**

To create a column filter based on range:

1 Click ☐ in the Cube Manager to open the Filters view.

2 Click ☐ in the Filters view. The New Filter dialog box appears.

3 From the Select a type of filter box, select **Filter values on a column in the table**.

4 For the Limit members on column option, select the column on which you want the filter to be based. By default, the first column in the table is selected. To select another column, click the column name.

5 For the Based on option, select **Range**.

6 To create the filter, you must specify the measure that you want to use. This option is available only if there are measures displayed in the columns of the table view.

7 Select the comparison operator that you want to use. The default value is **Is greater than**. To select another operator, click the currently selected operator,
and then make a selection from the box. If you want to negate the comparison operator, click the currently selected operator, and then select Not and the comparison operator that you want to use.

**TIP** You can create a filter to display only measure data with missing values by using the `Is missing` operator. The `Is missing` operator returns all data in which the value is missing.

8 Specify the value that you want to be compared in the filter. The default value is 0. You can also select another measure as the comparison value by clicking the currently selected comparison value, and then selecting a measure from the **Enter a value** drop-down list.

9 Specify the name of the filter. By default, the filter name is **Column (columnname)**.

10 Click **OK**. The new filter is applied to the cube and added to the list of filters in the Filters view.

---

**Create a Rank Values Filter for a Row**

You can filter your OLAP data by specifying criteria to limit the values in a row that is currently displayed in the table. You can filter the data by ranking the measure values of the row or by specifying a range of the measure values to view.

You can create two types of filters:

- **Rank values** - filters the data by ranking measure values.
- **Range of values** - filters the data by specifying a range of measure values to view.

When you create a rank filter, you can choose whether you want to view the top or bottom rankings, and you can choose to rank the data by count, by percentage of count or total value, or by sum. For example, you could choose to filter a row of sales data to display only the columns of regions in the top 10%.

When you create a range filter, you can specify the range of values by selecting a comparison operator and the value that you want to be compared in the filter. For example, you could choose to filter a row of sales data to display only columns of regions with sales over $25,000.

To create a column filter based on rank:

1 Click **in the Cube Manager to open the Filters view.**

2 Click **in the Filters view. The New Filter dialog box appears.**

3 From the **Select a type of filter** box, select **Filter values on a row in the table.**

4 For the **Limit members on row** option, select the row on which you want the filter to be based. By default, the first row in the table is selected. To select another row, click the column name.

5 For the **Based on** option, select **Rank**.
To create the filter, you must specify the measure that you want to use. This option is available only if there are measures displayed in the rows of the table view.

Select whether you want the top (largest) or bottom (smallest) values returned in the ranking. By default, the top values are returned.

Specify the number of values that you want to return in the ranking. The default value is 10.

Specify how you want the rank to be determined:

- **Count** - returns the top or bottom \( n \) members, where \( n \) is the numeric value that you specified. For example, if you specified **Bottom** and a numeric value of 5, then the filter would return the bottom, or smallest, five members.

- **Percent by Count** - returns the top or bottom \( n \) percent of members, where \( n \) is the numeric value that you specified. For example, if you specified **Top** and a numeric value of 10, then the filter would return the top, or largest, 10% of the members. If there were 500 members in the set, the top 50 members would be returned.

- **Percent by Value** - returns the top or bottom \( n \) percent of the sum of the values of the selected measure, where \( n \) is the numeric value that you specified. For example, if you specified **Top** and a numeric value of 90, then the sum of the members that are returned would equal at least 90% of the total sum of all of the measure values. If the member values that are being filtered include 6, 3, and 1, which add up to 10, then the members that are returned would be 6 and 3, which add up to 9, or 90% of 10.

- **Sum** - returns the top or bottom members until their sum is at least the numeric value that you specified. For example, if you specified **Top**, a numeric value of 10, and the member values to filter include 5, 3, 2, and 1, then the members that are returned would be 5, 3, and 2 because their sum is 10.

Specify whether you want to include ties and missing values in your filter results. By default, ties are included. Click the ties and missing values option to display the check boxes.

- **Include ties** - includes multiple members that meet the criteria for the last member to return in your filter results. If you want to include only one arbitrarily chosen last member, then clear the **Include ties** check box.

- **Include missing values** - includes missing values in the values that are ranked. This option is not selected by default.

Specify a name for the filter. By default, the filter name is **Row (row-name)**.

Click **OK** to create the new filter. The new filter is applied to the cube and added to the list of filters in the Filters view.

---

**Filtering Members of a Hierarchy Based on Their Values**

You can filter your OLAP data by specifying criteria to limit the members of a data hierarchy based on measure values, regardless of whether the values that are being used as filtering criteria are displayed in the table view. For example, in a table view that displays sales data by quarter for each sales region, you could create a filter to
view the top three sales regions for the entire year without displaying the annual total in the table.

You can create two types of filters:

- **Rank values** - filters the data by ranking measure values.
- **Range of values** - filters the data by specifying a range of measure values to view.

When you create a rank filter, you can choose whether you want to view the top or bottom rankings, and you can choose to rank the data by count, by percentage of count or total value, or by sum. For example, you could choose to filter the Beverage members of the Products hierarchy to display only the beverages with a total profit in the bottom 10%.

When you create a range filter, you can specify the range of values by selecting a comparison operator and the value that you want to be compared in the filter. For example, you could choose to filter the Beverage members of the Products hierarchy to display only the beverages with an annual marketing expense less than $30,000.

To create a hierarchy values filter based on rank:

1. Click 🅱️ in the Cube Manager to open the Filters view.
2. Click 🅱️ in the Filters view. The New Filter dialog box appears.
3. From the Select a type of filter box, select **Filter members of a hierarchy based on their values**.
4. For the Hierarchy option, select the hierarchy whose members you want to filter.
   
   **Note:** If you select a hierarchy that is not currently displayed in the table view, then you cannot apply the filter until the hierarchy is added to the table view.

5. The default value in the Limit members of drop-down list is either the parent member if all the members in the query share the same parent or the highest level of all the members in the query if the members do not share the same parent. To browse for the member or level that is associated with the member property that you want to use, click the member name to open the Member or Level dialog box.
   
   - To browse for a specific member, select **A member** from the Select drop-down list.
   - To browse for a specific level, select **A level** from the Select drop-down list.
   
   **Note:** If you choose to filter on a specific member, you are filtering on the children of the selected member. If you choose to filter on a specific level, you are filtering on all of the members of the selected level.

6. For the Based on option, select **Rank**.
7. Select the measure whose values you want to be ranked. By default, the measure that is displayed first in the table is selected. To select another measure, click the measure name. The measure that you select does not have to be displayed in the table view.
Select whether you want the top (largest) or bottom (smallest) values returned in the ranking. By default, the top values are returned.

Specify the number of values that you want to return in the ranking. The default value is 10.

Specify how you want the rank to be determined:

- **Count** - returns the top or bottom $n$ members, where $n$ is the numeric value that you specified. For example, if you specified Bottom and a numeric value of 5, then the filter would return the bottom, or smallest, five members.

- **Percent by Count** - returns the top or bottom $n$ percent of members, where $n$ is the numeric value that you specified. For example, if you specified Top and a numeric value of 10, then the filter would return the top, or largest, 10% of the members. If there were 500 members in the set, the top 50 members would be returned.

- **Percent by Value** - returns the top or bottom $n$ percent of the sum of the values of the selected measure, where $n$ is the numeric value that you specified. For example, if you specified Top and a numeric value of 90, then the sum of the members that are returned would equal at least 90% of the total sum of all of the measure values. If the member values that are being filtered include 6, 3, and 1, which add up to 10, then the members that are returned would be 6 and 3, which add up to 9, or 90% of 10.

- **Sum** - returns the top or bottom members until their sum is at least the numeric value that you specified. For example, if you specified Top, a numeric value of 10, and the member values to filter include 5, 3, 2, and 1, then the members that are returned would be 5, 3, and 2 because their sum is 10.

Specify whether you want to include ties and missing values in your filter results. By default, ties are included. Click the ties and missing values option to display the check boxes.

- **Include ties** - includes multiple members that meet the criteria for the last member to return in your filter results. If you want to include only one arbitrarily chosen last member, then clear the Include ties check box.

- **Include missing values** - includes missing values in the values that are ranked. This option is not selected by default.

For the Apply filter to option, select one or more other dimensions to filter the selected dimension. For example, you could limit your filter of top sales to the year 2017 by setting the Apply To option to the member [2017] of the Time dimension. To browse for dimensions, click the dimension name to open the Apply To dialog box.

To apply the filter to the default members of all of the other dimensions, select **The default members of all other dimensions** and click OK.

To apply the filter to members that you select from other dimensions, select **Selected members from dimensions**, and then select the dimension that you want to use from the Dimension drop-down list. To specify the individual members that you want to use, select **Specify members**. To specify a filter to use instead of individual members, select **Use filter**. Only filters that are associated with the dimension that you have selected are displayed. The filter that you select is evaluated when the range filter is evaluated, and the members that are returned by that filter are used as the selected members. The filter or members that you select are displayed in the **Selected** area.
Specify a name for the filter. By default, the filter name is **Hierarchy (membername)**.

Click **OK** to create the new filter.

To create a hierarchy values filter based on range:

1. Click 🔄 in the Cube Manager to open the Filters view.
2. Click 🔄 in the Filters view. The New Filter dialog box appears.
3. From the **Select a type of filter** box, select **Filter members of a hierarchy based on their values**.
4. For the **Hierarchy** option, select the hierarchy whose members you want to filter.
   
   **Note:** If you select a hierarchy that is not currently displayed in the table view, then you cannot apply the filter until the hierarchy is added to the table view.

5. For the **Limit members of** option, select the member on which you want the filter to be based. By default, the [ALL] member is selected. To select another member, click the member name.
6. For the **Based on** option, select **Range**.
7. Select the measure whose values you want to be compared in the filter. By default, the measure that is displayed first in the table is selected. To select another measure, click the measure name and select the measure that you want to use. The measure that you select does not have to be displayed in the table view.
8. Select the comparison operator that you want to use. The default value is **Is equal to**. To select another operator, click the currently selected operator, and then make a selection from the box. If you want to negate the comparison operator, click the currently selected operator, and then select **Not** and the operator that you want to use.

**TIP** You can create a filter to display only measure data with missing values by using the **Is missing** operator. The **Is missing** operator returns all data in which the value is missing.

9. Specify the value that you want to be compared in the filter. The default value is 0. You can also select another measure as the comparison value by clicking the comparison value and selecting a measure from the **Enter a value** drop-down list.

10. For the **Apply filter to** option, select one or more other dimensions to filter the selected dimension. For example, you could limit your filter of top sales to the year 2017 by setting the **Apply To** option to the member [2017] of the Time dimension. To browse for dimensions, click the dimension name to open the Apply To dialog box.
   - To apply the filter to the default members of all of the other dimensions, select **The default members of all other dimensions** and click **OK**.
   - To apply the filter to members that you select from other dimensions, select **Selected members from dimensions**, and then select the dimension that
you want to use from the Dimension drop-down list. To specify the individual members that you want to use, select Specify members. To specify a filter to use instead of individual members, select Use filter. Only filters that are associated with the dimension that you have selected are displayed. The filter that you select is evaluated when the range filter is evaluated, and the members that are returned by that filter are used as the selected members. The filter or members that you select are displayed in the Selected area.

11 Specify a name for the filter. By default, the filter name is Hierarchy (membername).

12 Click OK to create the new filter.

Filtering Members of a Hierarchy Based on Their Labels

You can filter your OLAP data by specifying criteria to limit the members of a data hierarchy based on the labels that are displayed in the table headings. For example, in a table view that displays sales data by quarter, you could create a filter to view only sales in the East region.

To create a hierarchy values filter based on labels:

1 Click in the Cube Manager to open the Filters view.

2 Click in the Filters view. The New Filter dialog box appears.

3 From the Select a type of filter box, select Filter members of a hierarchy based on their labels.

4 For the Hierarchy option, select the hierarchy whose members you want to filter.

Note: If you select a hierarchy that is not currently displayed in the table view, then you cannot apply the filter until the hierarchy is added to the table view.

5 The default value in the Limit members of drop-down list is either the parent member if all the members in the query share the same parent or the highest level of all the members in the query if the members do not share the same parent. To browse for the member or level that is associated with the member property that you want to use, click the member name to open the Member or Level dialog box.

- To browse for a specific member, select A member from the Select drop-down list.
- To browse for a specific level, select A level from the Select drop-down list.

Note: If you choose to filter on a specific member, you are filtering on the children of the selected member. If you choose to filter on a specific level, you are filtering on all of the members of the selected level.

6 For the operator option, select the comparison operator that you want to use. The default value is Contains. If you want to negate the comparison operator, click the operator to open the operator dialog box. Select the Not check box and the operator that you want to use.
TIP  You can create a filter to display only labels that are blank by using the Is blank operator. The Is blank operator returns all data that is associated with a blank label value.

7 Click the Enter a value option to enter or select the value that you want to be compared in the filter. If you select Exactly matches as the operator, click to select the value in the Select Values dialog box.

8 Specify a name for the filter. By default, the filter name is Hierarchy (membername).

9 Click OK to create the new filter.

Filtering Members of a Hierarchy Based on Their Properties

You can filter your OLAP data by specifying criteria to limit the members of a data hierarchy based on their property labels. For example, suppose you have a cube that contains sales data for retail stores. The cube also has a member property that indicates whether a store has street-front access. You could create a filter to display only the stores without street-front access.

To create a hierarchy values filter based on properties:

1 Click in the Cube Manager to open the Filters view.

2 Click in the Filters view. The New Filter dialog box appears.

3 From the Select a type of filter box, select Filter members of a hierarchy based on their properties.

4 For the Hierarchy option, select the hierarchy whose members you want to filter.

   Note: If you select a hierarchy that is not currently displayed in the table view, then you cannot apply the filter until the hierarchy is added to the table view.

5 The default value in the Limit members of drop-down list is either the parent member if all the members in the query share the same parent or the highest level of all the members in the query if the members do not share the same parent. To browse for the member or level that is associated with the member property that you want to use, click the member name to open the Member or Level dialog box.

   - To browse for a specific member, select A member from the Select drop-down list.
   - To browse for a specific level, select A level from the Select drop-down list.

   Note: If you choose to filter on a specific member, you are filtering on the children of the selected member. If you choose to filter on a specific level, you are filtering on all of the members of the selected level.
6 For the member property option, select the member property that you want to use in the filter.

7 For the operator option, select the comparison operator that you want to use. The default value is **Contains**. If you want to negate the comparison operator, click the operator to open the operator dialog box. Select the **Not** check box and the operator that you want to use.

**TIP** You can create a filter to display only labels that are blank by using the **Is blank** operator. The **Is blank** operator returns all data that is associated with a blank label value.

8 Click the **Enter a value** option to enter or select the value that you want to be compared in the filter.

9 Specify a name for the filter. By default, the filter name is **Hierarchy (membername)**.

10 Click **OK** to create the new filter.

---

**Filtering Time Periods of a Time Hierarchy**

You can filter your OLAP data by specifying criteria to limit the members of a time hierarchy to a certain time period. For example, you could create a filter to display only the first six months of the year 2018.

To create a time hierarchy filter:

1 Click 🔄 in the Cube Manager to open the Filters view.

2 Click 🔄 in the Filters view. The New Filter dialog box appears.

3 From the **Select a type of filter** box, select **Filter time periods of a time hierarchy**.

4 For the **Hierarchy** option, select the hierarchy whose members you want to filter.

**Note:** If you select a hierarchy that is not currently displayed in the table view, then you cannot apply the filter until the hierarchy is added to the table view.

5 The default value in the **Limit members of** drop-down list is either the parent member if all the members in the query share the same parent or the highest level of all the members in the query if the members do not share the same parent. To browse for the member or level that is associated with the member property that you want to use, click the member name to open the Member or Level dialog box.

- To browse for a specific member, select **A member** from the **Select** drop-down list.

- To browse for a specific level, select **A level** from the **Select** drop-down list.
6. Select the time period that you want to use to limit the data.

7. For the **Starting** option, specify the starting time period for the filter.

8. For the **Ending** option, specify the ending time period for the filter.

9. Specify a name for the filter. By default, the filter name is **Hierarchy (membername)**.

10. Click **OK** to create the new filter.

---

### Sorting Data in an OLAP Cube

You can sort the rows in the table view of the OLAP Analyzer by measure value, by member caption, or by member property. The column or row on which the data is sorted is identified by an upward triangle for an ascending sort or an inverted triangle for a descending sort in the column heading.

**Note:** The sorting functionality is available only when you access the OLAP cube by using an OLE DB for OLAP Provider.

To sort by using the table view, right-click on the heading in the table view on which you want to sort your data, and select **Sort**.

**Note:** The options to sort within or across a hierarchy are disabled when the totals that are displayed in the cube are visual totals.

**Note:** The sort is performed on the measure and is evaluated using the default member of the dimension on the column, even if the default member is not what is displayed in the table view.

---

### Customizing the OLAP Analyzer

#### Customize the Appearance of the Graph View

You can customize the appearance of the graph view of the OLAP Analyzer by changing the graph appearance and the graph type and by selecting a predefined color scheme. You can also create a customized scheme by modifying one of the
predefined schemes. By default, a title for the graph is automatically generated by using the dimensions and measures in the graph. You can change the default title, and you can also add additional lines to the default title.

To change the chart type, right-click on the background area of the graph in the graph view, and select Chart Type. If you select Automatic Chart, then the OLAP Analyzer chooses the best chart for the data based on the number of measures and whether the data includes a time dimension.

To set style and graph options:

1. Right-click on the background area of the graph in the graph view, and select Graph Properties. The Properties dialog box appears.
2. On the Graph tab, select the style that you want to use from the Style drop-down list. To make changes to the selected style, click Edit Style.
3. Select the type of view that you want to use for the graph.
4. If the chart type that you have chosen uses grid lines, you can select whether to display the grid lines and how to place them.
5. To display annotations, select Annotations. When they are available, annotations contain data details about graph areas.
6. To specify advanced settings for mouse preferences, Microsoft PowerPoint sessions, scroll bars, graph rendering, and lighting, click Advanced. The Advanced Settings dialog box appears. Select the options that you want to use, and then click OK to return to the Properties dialog box.
7. To specify options for specific elements of the chart type that you have chosen and for legends and titles, click the appropriate tab.
8. Click OK to save your changes and return to the OLAP Analyzer.

To change the graph title:

1. Right-click on the background area of the graph in the graph view, and select Graph Properties. The Properties dialog box appears.
2. Click the Titles tab.
3. To change the default title, select Title 1 from the titles drop-down list and enter the new title that you want to use in the title box. To change the title back to the default title, delete the text in the title box for Title 1 and click OK.
4. To add additional lines of text to the title, select Title 2 from the titles drop-down list and enter the text that you want to use in the title box. You can repeat this step for Title 3 and Title 4.
5. To change the position of a title, select the title that you want to move from the titles drop-down list and then select the position from the Position drop-down list. By default, all titles are centered over the graph.
6. To turn off the display of a title, select the title that you want to remove from the titles drop-down list and clear the Show title check box.
7. Click OK to save your changes.
Working with Conditional Highlighting

Creating Conditional Highlights

You can create a conditional highlight in an OLAP cube by applying special formatting to values that meet conditions that you specify. For example, you could display sales figures that are less than or equal to a specified value in red with a yellow background, and display sales figures above that value in black. Any conditional highlights that you create are saved and can be used again each time you open the OLAP cube.

When you create a conditional highlight, you can set the condition under which you want to highlight exceptions, and you can define the formatting that you want to apply when the condition is met.

Note: Row and column totals are not included in a conditional highlight.

If you create more than one conditional highlight, they are applied in the order in which you create them.

When you create conditional highlights, they are displayed in the Highlights section of the View Manager and in the Conditional Highlights view of the Cube Manager.

1. To create a new conditional highlight:
   - Click in the Cube Manager to open the Conditional Highlights view.

2. Click in the Conditional Highlights view. The Add Conditional Highlight dialog box appears.

3. If you want to create a condition that is based on rank, then select Rank in the Rule area and perform the following steps:
a Specify the measure that you want to use. The list of measures includes all measures that are available in the cube.

b Select whether you want the top (largest) or bottom (smallest) values returned in the ranking. By default, the top values are returned.

c Enter the numeric value for the ranking. The default value is 10.

d Specify how you want the rank to be determined:
  
  - **Count** - returns the top or bottom \(n\) members, where \(n\) is the numeric value that you specified. For example, if you specified *Bottom* and a numeric value of 5, then the filter would return the bottom, or smallest, five members.
  
  - **Percent by Count** - returns the top or bottom \(n\) percent of members, where \(n\) is the numeric value that you specified. For example, if you specified *Top* and a numeric value of 10, then the filter would return the top, or largest, 10% of the members. If there were 500 members in the set, the top 50 members would be returned.
  
  - **Percent by Value** - returns the top or bottom \(n\) percent of the sum of the values of the selected measure, where \(n\) is the numeric value that you specified. For example, if you specified *Top* and a numeric value of 90, then the sum of the members that are returned would equal at least 90% of the total sum of all of the measure values. If the member values that are being filtered include 6, 3, and 1, which add up to 10, then the members that are returned would be 6 and 3, which add up to 9, or 90% of 10.
  
  - **Sum** - returns the top or bottom members until their sum is at least the numeric value that you specified. For example, if you specified *Top*, a numeric value of 10, and the member values to filter include 5, 3, 2, and 1, then the members that are returned would be 5, 3, and 2 because their sum is 10.

e Specify whether you want to include ties and missing values in your filter results. By default, ties are included. Click the ties and missing values option to display the check boxes.
  
  - **Include ties** - includes multiple members that meet the criteria for the last member to return in your filter results. If you want to include only one arbitrarily chosen last member, then clear the *Include ties* check box.
  
  - **Include missing values** - includes missing values in the values that are ranked. This option is not selected by default.

4 If you want to create a condition that is based on range, select **Range** in the Rule area and perform the following steps:

a To create a conditional highlight, you must select the measure that you want to use. The list of measures includes all measures that are available in the cube.

b Select the comparison operator that you want to use. The default operator is **Is equal to**. To negate the comparison expression that you create, click the comparison operator and select **Not**. This option is not selected by default.

c In the value box, enter the value that you want to compare or select a measure from the drop-down list.
5 Use the **Highlight** area to define the formatting that you want to apply to values that meet the criteria that you specified in the **Rule** area. You can specify options for the text font, text size, text color, and text style. You can also specify a color for the cell background and select an icon to display in the cell. A preview of the formatting options that you choose is displayed in the **Preview** box.

6 Select whether you want to apply the conditional highlight to all levels or only to levels that you select. Click the **Apply conditional highlight to** option to open the dialog box.
   - If you want to apply the conditional highlight to all levels, select **All Levels**.
   - If you want to apply the conditional highlight only to specific levels, select **Selected Levels**. Expand the hierarchies and select the levels to which the highlight should be applied. Click **OK**.

7 Enter the name of the highlight.

8 Click **OK** to save the highlight.

### Applying and Editing Conditional Highlights

If you create more than one conditional highlight, they are applied in the order in which you create them. The highlighting that you see in the table view can change depending on the order in which the highlights are applied. You can change the order in which highlights are applied in the Conditional Highlights view by moving them up or down the list of highlights.

For example, you create two conditional highlights:

**Highlight A**  Sum of Sales > 100,000  values displayed in red
**Highlight B**  Sum of Sales > 400,000  values displayed in blue

If you apply Highlight A first and then apply Highlight B, then cells with values that are greater than 400,000 are displayed in blue, and cells with values that are between 100,000 and 400,000 are displayed in red. If you apply Highlight B first and then apply Highlight A, then all cells with values that are greater than 100,000 are displayed in red.

Moving the highlights in the View Manager is the only way to change the order in which the highlights are applied to the table view. Moving the highlights up and down the list of highlights in the Conditional Highlights pane of the Cube Manager does not change the order in which they are applied. You can also edit existing highlights and remove and reapply them to the table view.

### Moving the Rows and Columns

You can move the rows and columns in the OLAP Analyzer in several ways. You can pivot the table view by swapping the rows and columns. You can also move measures and hierarchies between the row and column axes as well as within the current axis. The OLAP Analyzer remembers any changes that you make each time you open it.

To swap rows and columns, click **Pivot**. The table and graph views are updated.

To move measures and hierarchies in the table view, right-click the measure or level heading that you want to move and select the appropriate option.
If you have selected a single measure heading, the Move option moves only the selected measure.

If you have selected a measure level heading, the Move Measures To option moves all measures.

If you have selected a level heading, the Move hierarchy-name To moves the entire hierarchy.

---

Viewing an ESRI Map

About ESRI Maps

Multidimensional data often contains a geographic dimension that allows analysis based on varying locations. In many cases, these locations are political boundaries such as country, state, province, or city. In other cases, the locations, or regions, are defined based on business rules such as sales territory, wireless coverage plans, or population-based designated market areas.

If ArcGIS software has been installed on your computer, you can view your data in the context of ESRI maps. In an ESRI map, you can drill down and navigate through cube data, display data, set options, filter data, and export the map as an image.

**Note:** ArcGIS Engine Run-time is required to work with ESRI maps. If you cannot open an ESRI map, contact your site administrator.

When you select an OLAP cube that has been associated with an ESRI map, the OLAP Analyzer displays the map as an additional view of the data.
Open an ESRI Map

If an ESRI map has been associated with the data in an OLAP cube, you can display the map after you open the cube.

To open an ESRI map:

1. Open the OLAP cube that is associated with the ESRI map that you want to view.
2. In the OLAP Analyzer group on the SAS tab in the Ribbon, select Insert View \( \Rightarrow \) ESRI Map. The Choose Location dialog box appears.
3. Specify the location for the new view and click OK. A new view with the ESRI map is created.

Displaying Data in an ESRI Map

When you have opened an OLAP cube that is associated with an ESRI map, you can navigate through the table view in the same way as with any other OLAP cube.
You can use the map view to select specific geographic locations that you want to analyze. You can select locations on the map by using the map legend on the left or by using the drawing tools in the toolbar. After you have selected a location, you can choose from many options, including drilling, expanding, or isolating the location as well as displaying data about the location.

You can select a location on the map either by using the Legend area or by using the drawing tools. Any locations on the map that are partially or wholly included in the area that you have drawn are selected in the legend and highlighted in the map view.

To isolate an area in the map view:

1. Select an area on the map view.
2. Right-click the area of the map that you have selected and select Keep Only level-name in hierarchy-name. Only the selected level is displayed in the map.

To identify a particular location and display the data that is associated with it, right-click a location on the map and select Identify.

Filter ESRI Map Data

You can use an ESRI map to filter your data. For example, you might choose to display only the data that pertains to a particular city.

To filter ESRI map data:

1. Select an area on the map view.
2. Right-click the area of the map that you have selected and select Filter. From the pop-up menu, select the filter that you want to use.
3. Click OK to create the filter.

Export an ESRI Map

You can export an ESRI map as an image file.

To export an ESRI map:

1. Right-click the ESRI map that you want to export and select Map View ➪ Export Image. The Save As dialog box appears
2. Select a file location and specify a filename.
3. Select an image type from the Save as type drop-down list. You can save the map as a BMP, JPEG, or PNG image
4. Click Save.
Setting ESRI Map Options

Specifying Visibility Options
To set ESRI map options, right-click the map and select Map Properties to display the Options window. Click the Display tab.

- **Show map legend** - displays the name of the selected area and its associated data along the right side of the map.
- **Show feature tips** - displays the name of the location on the map and its associated data as you move the mouse pointer over the map.
- **Resize on navigate** - resizes the map to zoom in on the current level of data as you navigate in the map. If you do not select this option, then the map does not automatically zoom to display the current level of data and instead remains at the last zoom level. This option is selected by default.

Specifying Layers and Viewing the Location of the Map Document
To set ESRI map options, right-click the map and select Map Properties to display the Options window. Click the General tab.

- **Map Layers** - enables you to select the map layers that you want to display. Clear the check boxes for the layers that you want to conceal from view.
- **Location** - displays the location of the map document.

Setting the Symbology Options
To set ESRI map options, right-click the map and select Map Properties to display the Options window. Click the Symbology tab.

Setting the color theme
- **Theme** - enables you to select a theme. The theme colors are displayed in the map and in the scale of values in the Cube View Manager.

Setting the classification method
- **Method** - specifies the classification method for displaying map data.
- **Classes** - specifies the number of classes into which the data is divided.

Setting patterns for missing values
- **Style** - specifies a pattern that is displayed for any missing values.
- **Foreground** - specifies the color and hue for the foreground.
- **Background** - specifies the color and hue for the background.
Setting OLAP Analyzer Options

How to Set the OLAP Analyzer Options in Microsoft Excel

1. Click the SAS tab in the Ribbon. In the Tools group, click Options.
2. In the SAS Add-In for Microsoft Office Options dialog box, click Data in the selection pane. Under the OLAP heading, click OLAP Analyzer Options.

Specifying Options for Data Drill-Through

**Maximum number of rows to include detailed data** specifies the maximum number of rows to display when you are drilling through to detail data. The default value is 100. The maximum value is 2,147,483,647.

Specifying Options for Data Slice

The type of slice determines how the data in a slice table is arranged.

- **Rows, columns, and measures as separate data columns** – creates separate data columns for the row headings, the column headings, and each measure value. Use the **Number of rows to scan to estimate column width** option to specify how many rows you want the OLAP Analyzer to read in order to estimate the width of a column. You must enter a value between 1 and 2,147,483,647. The default value is 500. If the width of the rows that occur after the rows that are scanned as an estimate differs from the width of the rows that are scanned, then the data slice might not display all of the columns correctly.

- **Maintain the same layout as the OLAP table** – creates the same rows and columns that are displayed in the current table view.

Specifying Options for Optimizing Performance

- **Maximum number of rows or columns to process** – specifies the maximum number of rows or columns to process from the current MDX query results. The default is 10,000, which means that up to 10,000 rows and 10,000 columns can be processed. The maximum value is 2,147,483,647.

- **Number of rows or columns to retrieve at one time** – specifies the number of rows or columns that you want to retrieve at one time when you are displaying data in the OLAP Analyzer. The default value is 100. This value must be less
than the value that is specified for the Maximum number of rows or columns to process option.

Specifying Options for Optimizing Results

- **Show empty rows in results** – includes the empty rows in the table and graph. This option is selected by default.

- **Show empty columns in results** – includes the empty columns in the table and graph. This option is selected by default.

- **Show 'ALL' member in results** – includes the [All] member in all of the table views of the cube. The [All] member includes all members of a dimension. This option is selected by default.

  Note: This option is available only for table views. This option does not affect the graph views or the Cube Explorer.

- **Show calculated members in results** – includes calculated members and calculated measures in the table and graph views when you navigate in the cube. This option is not selected by default.

Specifying Options for Raw Values and Unique IDs

- **Show unique member IDs for table headings** – displays the unique member identifiers, or keys, in the table headings instead of the captions.

- **Show raw values on data cells** – displays the raw value for each value in the table. To see the raw value, place the mouse pointer over the small blue triangle in the upper right corner of the table cell. In some instances, the raw value might differ from the displayed value.

Specifying Options for Styles

- **Style** – specifies the predefined color scheme for all of the table and graph views.

- **Row header** – specifies the color of the cells for the row headings.

- **Column header** – specifies the color of the cells for the column headings.

- **Measure header** – specifies the color of the cells for the measure headings.

- **Graph style** – specifies the predefined color scheme for the graph view.

- **Show shadings based on levels** – shades the cells of the table view based on the dimension levels. The deeper in the dimension a cell is, the darker it is shaded.
Specifying Options for Parent Totals and Visual Totals

- **Parent totals** – displays the total of all children of the parent level. This total includes all children members, regardless of whether they are displayed in the table view.

- **Visual totals** – displays the total of the values that are displayed in the table view. Because these visual totals change dynamically as you add and remove members from the table view, they can take longer to process.

- **On bottom (right)** – displays the totals below the values that are being totaled. This option is not available in all situations.

  Note: You can display visual totals on the bottom only if you are using a SAS 9.2 OLAP server.

- **On top (left)** – displays the totals above the values that are being totaled.

- **Itemize total and parent values across hierarchies** – displays all of the possible crossings, or summarizations of the unique combinations of variables, and totals. This option applies only when there is a cross-join between dimensions, not including the Measures dimension. If you do not select this option, then the intermediate totals are removed and some crossings are removed when the totals are visual and there is more than one dimension on an axis. This option is selected by default.
Accessing Tasks

SAS Add-In for Microsoft Office provides SAS tasks that you can run on your data. If you select a SAS data set as the input data source, all of the variables in the data set are available to the task, and the task runs against all the variables in the data set. If you select an information map as the input data source, you are prompted to select the variables to use.

You can view the list of available tasks from the Tasks tab in the SAS panel. When you run a task, the results appear on the Results tab in the SAS panel. To include
the results in the document the first time you open it, select **Automatically insert results into the Office document**. For more information, see "Setting the Results Options" on page 35.

**TIP** You can also access tasks by clicking **Tasks** on the **SAS** tab.

The **Tasks** tab shows any tasks that are shipped with SAS Add-In for Microsoft Office, any custom tasks, and any tasks that are shipped with SAS Studio 3.7 and 3.8. (For more information, see the **Display SAS Studio tasks** option in "Setting the Task Options" on page 54.) Any task templates that you have created also appear in the task pane. For more information, see "Working with Task Templates" on page 149.

**Note:** SAS Studio 5.2 tasks are not available in SAS Add-In for Microsoft Office.

To learn more about a task, place your mouse pointer over the task name. From the flyout window, you can view the following information:

- whether the task is a built-in task (in other words, a task that shipped with SAS Add-In for Microsoft Office) or a SAS Studio task.
- the category for the task.
- the SAS procedures used in the task.
- a brief description of the task.

By default, the tasks are listed in alphabetical order. You can filter the tasks by category, by SAS procedure, or by type. You can also search for a task by keyword.

To view any tasks that you opened recently, click 📋 and select **Recent**. To specify the number of recent tasks to display, set the **Number of recent tasks to display in the task browser** option. By default, the last 15 tasks are displayed.

To add a task as a favorite, right-click the task name and select **Add to Favorites**. To view your favorites, click 📋 and select **Favorites**.

**Note:** If you are using the SAS Visual Add-In for Office, SAS tasks are not available. For this functionality, you must use SAS Add-In for Microsoft Office. For more information, see “Determining Your SAS Add-In” on page 6.
Selecting a Data Source for the SAS Task

You can run SAS tasks in Microsoft Excel, Microsoft Word, and Microsoft PowerPoint. However, before you can run a task, you must specify an input data source. You select this data source from the Choose Data dialog box that appears after you select a task.

If you are running the SAS add-in in Excel, you can specify the following input data sources:
Running Tasks on a Slice of a Cube

To run a task on a slice of an OLAP cube:

1. In Microsoft Excel, open the OLAP cube in the OLAP Analyzer, and create a slice of a cube.

2. Click the SAS tab on the Ribbon. From the Insert group, click Tasks and select the task that you want to run.

3. In the Choose Data dialog box, specify the range in Microsoft Excel that contains the slice.

4. Specify the options for the task and click Run. For more information about specific tasks, see the Help for that task.

The results open on the Results tab in the SAS panel.
View the Input Data Source

In Microsoft Excel, you can view the data that was used as the input for a SAS task. To view the input data:

1. Place your cursor in the results from the SAS task.
2. Click the **SAS** tab on the Ribbon. In the **Tools** group, click **Tools** and select **View Input Data**.

If the input data source for your task is an Excel worksheet, then that worksheet will open. If the data source is a SAS data source, then that data source will open into an Excel worksheet. If your data source has already been opened in the active workbook, instead of opening a second copy of the worksheet, the worksheet that is already open will be activated.

Creating Microsoft Excel Charts

About Microsoft Excel Charts

SAS Add-In for Microsoft Office can create Microsoft Excel charts for some bar charts, bubble plots, line plots, and pie charts. To enable Microsoft Excel charts, select the **Create Microsoft Excel charts when possible** check box in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “Results Options in Microsoft Excel” on page 35.

**Note:** To use native charts, your results format must be SAS Report.

Microsoft Excel charts can be created for these types of graphs:

- Bar Charts
- Bubble Plots
- Line Plots
- Pie Charts

**Note:** When a Microsoft Excel chart is created, any appearance options (such as labels for axes or custom colors) that you specify are ignored. Instead, the defaults for Microsoft Excel charts are used. If you know that your output will be a Microsoft Excel chart, then do not specify any appearance options for your bar charts, bubble plots, line plots, and pie charts.
Bar Charts

To open the Bar Chart task, select **Tasks** ⇒ **Graph** ⇒ **Bar Chart**.

A Microsoft Excel chart can be created for these types of bar charts. Use this table to determine what options to select in the Bar Chart task to create a Microsoft Excel chart.

<table>
<thead>
<tr>
<th>Name on the Bar Chart Panel</th>
<th>Role Assignments</th>
<th>Additional Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Vertical Bar</td>
<td>In the Data panel, you must assign a column to the <strong>Column to chart</strong> role.</td>
<td>(Optional) In the Advanced panel, select <strong>Frequency</strong> as the statistic to use to calculate the bar.</td>
</tr>
<tr>
<td>Simple Horizontal Bar</td>
<td>You can also assign columns to these roles:</td>
<td>Note: If you select <strong>Mean</strong> as the statistic to use to calculate the bar, a SAS graph is created. Microsoft Excel charts do not support the <strong>Mean</strong> statistic.</td>
</tr>
<tr>
<td>Vertical Colored Bar</td>
<td><strong>Sum of</strong> to calculate the size of bar by a sum of values.</td>
<td></td>
</tr>
<tr>
<td>Horizontal Colored Bar</td>
<td><strong>Group charts by</strong> to create a group of bar charts</td>
<td></td>
</tr>
<tr>
<td>Grouped Vertical Bar</td>
<td>In the Data panel, you must assign a column to the <strong>Column to chart</strong> and <strong>Group bars by</strong> roles.</td>
<td>(Optional) In the Advanced panel, select <strong>Frequency</strong> as the statistic to use to calculate the bar.</td>
</tr>
<tr>
<td>Grouped Horizontal Bar</td>
<td>You can also assign columns to these roles:</td>
<td>Note: If you select <strong>Sum</strong> as the statistic to use to calculate the bar, a SAS graph is created. Microsoft Excel charts do not support the <strong>Sum</strong> statistic.</td>
</tr>
<tr>
<td>Grouped Vertical Colored Bar</td>
<td><strong>Sum of</strong> to calculate the size of bar by a sum of values.</td>
<td></td>
</tr>
<tr>
<td>Grouped Horizontal Colored Bar</td>
<td><strong>Group charts by</strong> to create a group of bar charts</td>
<td></td>
</tr>
<tr>
<td>Interleave Vertical Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D Grouped Vertical Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D Grouped Colored Vertical Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stacked Vertical Bar</td>
<td>In the Data panel, you must assign a column to the <strong>Column to chart</strong> and <strong>Stack</strong> roles.</td>
<td>(Optional) In the Advanced panel, select <strong>Frequency</strong> as the statistic to use to calculate the bar.</td>
</tr>
<tr>
<td>Stacked Horizontal Bar</td>
<td>You can also assign columns to these roles:</td>
<td>Note: If you select <strong>Sum</strong> as the statistic to use to calculate the bar, a SAS graph is created. Microsoft Excel charts do not support the <strong>Sum</strong> statistic.</td>
</tr>
<tr>
<td></td>
<td><strong>Sum of</strong> to calculate the size of bar by a sum of values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Group charts by</strong> to create a group of bar charts</td>
<td></td>
</tr>
</tbody>
</table>
Note: Because any appearance options (for example, custom colors, spacing between bars, or any options to display results in ascending or descending order) that you specify in the Bar Chart task are ignored, many of these charts could look alike. For example, an interleave bar chart, a grouped vertical bar chart, and a grouped colored vertical bar chart generate the same Microsoft Excel chart.

Also, a vertical colored bar chart and a horizontal colored bar chart produce the same results as a simple vertical bar chart and a simple horizontal bar chart. In this case, the colors that you specify in the Bar Chart task are ignored.

For 3-D grouped vertical bar charts, the colors of the bars in the Microsoft Excel chart are not assigned based on the values in the Group bars by role.

---

### Bubble Plots

To open the Bubble Plot task, select Tasks ⇒ Graph ⇒ Bubble Plot.

A Microsoft Excel chart can be created for these types of bubble plots. Here are the options to specify in the Bubble Plot task to create a Microsoft Excel chart.

In the Data panel, assign columns to these roles:
- Horizontal
- Vertical
- Bubble size

To create a group of bubble plots, you can also select the Group charts by role.

Note: If you assign a column to the Vertical (Right) role, then an ActiveX chart is created.

---

### Line Plots

To open the Line Plot task, select Tasks ⇒ Graph ⇒ Line Plot.

A Microsoft Excel chart can be created for these types of line plots. Use this table to determine what options to select in the Line Plot task to create a Microsoft Excel chart.

<table>
<thead>
<tr>
<th>Name on the Line Plot Panel</th>
<th>Role Assignments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Plot</td>
<td>In the Data panel, you must assign columns to the Horizontal and Vertical roles.</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td></td>
</tr>
<tr>
<td>Multiple vertical column line plots using</td>
<td>Note: If you are creating multiple vertical line plots that use overlay, you must assign a column with numeric values to the Horizontal role and two</td>
</tr>
<tr>
<td>overlay</td>
<td></td>
</tr>
</tbody>
</table>
Name on the Line Plot Panel | Role Assignments
--- | ---
 | columns to the **Vertical** role. Otherwise, an ActiveX chart is generated.
To create a group of plots, you can also assign a column to the **Group charts by** role.

Note: If the column assigned to the Horizontal role has missing values, an unexpected graph can result. To get the results that you expect, use one of these workarounds:
- Select **Scatter Plot** as the plot type instead of the default **Line Plot**.
- Define a filter that removes the missing values before the chart is generated. For example, if the Age column contains missing values, you can create a filter of "Age Is not missing." When the SAS add-in runs this filter, only values that are not missing are used to generate the line plot. For more information, see “About Filtering Data” on page 70.

Note: If you assign a column to the **Vertical (Right)** role, then an ActiveX chart is created.

Note: If you create a scatter plot by using the Scatter Plot task, then an ActiveX chart is created.

---

### Pie Charts

To open the Pie Chart task, select **Tasks ➔ Graph ➔ Pie Chart**.

A Microsoft Excel chart is created for these types of pie charts. Use this table to determine what options to select in the Pie Chart task to create a Microsoft Excel chart.

<table>
<thead>
<tr>
<th>Name on the Pie Chart Panel</th>
<th>Role Assignments</th>
<th>Additional Options</th>
</tr>
</thead>
</table>
| **Simple Pie** | In the **Data** panel, you must assign a column to the **Column to chart** role. You can also assign columns to these roles:  
  - **Sum of** to calculate the size of a slice by a sum of values | (Optional) In the **Advanced** panel, select **Frequency** as the statistic to use to calculate the slice. |
Interaction of the Graph Options

The following two tables show the interaction between the **Group by**, **Chart Type**, and **Put groups on** options. Each table represents a different value of the **Group by** option: Row and Column.

The **Put groups on** option depends on the value that you selected for the **Group by** option. If you select Row, then each entry on the category axis is a group that contains the column values for a row. If you select Column, then each entry on the category axis is a group that contains the row values for a column.

The locations of the category and response axes differ depending on the value of the **Chart Type**. For vertical bar charts, line plots, and area plots, the category axis is the horizontal axis, and the response axis is the vertical axis. For horizontal bar charts, the category axis is the vertical axis, and the response axis is the horizontal axis.

**Table 8.1  Group by = Row**

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Put groups on</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bar</td>
<td>Category Axis</td>
<td>A bar chart in which each row is plotted on the horizontal axis. The column values are drawn as a cluster of individual bars on the horizontal axis.</td>
</tr>
<tr>
<td>Stack</td>
<td></td>
<td>A bar chart in which each row is plotted as a single bar on the horizontal axis. The column values are drawn as segments that are stacked on top of one another.</td>
</tr>
<tr>
<td>Vertical Series</td>
<td></td>
<td>A series of bar charts that are displayed in parallel, share a common horizontal axis, and have graphs of the column values stacked on the vertical axis.</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>Category Axis</td>
<td>A bar chart in which each row is plotted on the vertical axis. The column values are drawn as a</td>
</tr>
<tr>
<td>Chart Type</td>
<td>Put groups on</td>
<td>Result</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cluster of individual bars on the vertical axis.</td>
</tr>
<tr>
<td>Stack</td>
<td></td>
<td>A bar chart in which each row is plotted as a single bar on the vertical axis. The column values are drawn as segments that are stacked on top of one another.</td>
</tr>
<tr>
<td>Vertical Series</td>
<td></td>
<td>A series of bar charts that are displayed in parallel, share a common vertical axis, and have graphs of the column values stacked on the horizontal axis.</td>
</tr>
<tr>
<td>Pie</td>
<td>Separate Pies</td>
<td>Several pie charts in which each row is drawn as an individual pie chart. The column values form the segments of the pie.</td>
</tr>
<tr>
<td>Stack</td>
<td></td>
<td>Stacked pie charts in which each row is drawn as an individual pie chart. The column values form the segments of the pie.</td>
</tr>
<tr>
<td>Plot</td>
<td>Category Axis</td>
<td>A line plot in which the rows are placed on the horizontal axis. The column values appear as points on the vertical axis.</td>
</tr>
<tr>
<td>Vertical Series</td>
<td></td>
<td>A series of line plots that are displayed in parallel, share a common horizontal axis, and have graphs of the column values stacked on the vertical axis.</td>
</tr>
<tr>
<td>Area</td>
<td>Category Axis</td>
<td>An area plot in which the rows are placed on the horizontal axis. The column values appear as points on the vertical axis.</td>
</tr>
<tr>
<td>Chart Type</td>
<td>Put groups on</td>
<td>Result</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vertical Bar</td>
<td>Category Axis</td>
<td>A bar chart in which each column is plotted on the horizontal axis. The rows values of the column are drawn as a cluster of individual bars on the horizontal axis.</td>
</tr>
<tr>
<td>Stack</td>
<td></td>
<td>A bar chart in which each column is plotted as a single bar on the horizontal axis. The row values are drawn as segments that are stacked on top of one another.</td>
</tr>
<tr>
<td>Vertical Series</td>
<td></td>
<td>A series of bar charts that are displayed in parallel, share a common horizontal axis, and have graphs of the row values stacked on the vertical axis.</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>Category Axis</td>
<td>A bar chart in which each column is plotted on the vertical axis. The row values of the column are drawn as a cluster of individual bars on the vertical axis.</td>
</tr>
<tr>
<td>Stack</td>
<td></td>
<td>A bar chart in which each column is plotted as a single bar on the vertical axis. The row values of the column are drawn as segments that are stacked on top of one another.</td>
</tr>
<tr>
<td>Vertical Series</td>
<td></td>
<td>A series of bar charts that are displayed in parallel, share a common vertical axis, and have graphs of the row values stacked on the horizontal axis.</td>
</tr>
<tr>
<td>Pie</td>
<td>Separate Pies</td>
<td>Several pie charts in which each column is drawn as an individual pie chart. The</td>
</tr>
</tbody>
</table>
### Changing the Destination of the Output Data

By default, SAS tasks that create output data, such as the Standardize Data task, store the data in your Work library.

Most tasks include an option to save your output data. You might want to designate a different location for your output data if you want the data to reside in a location other than the Work library—for example, in a central library that many users can access. To designate a different library for your output, use the Save As dialog box that is accessible within the specific task. For more information, see the Help for the task.
Viewing Output Data in Your Results

Some SAS tasks create output data. This output data can be opened only in Microsoft Excel. To specify how this output data should appear in Excel, use the output data set options on the Data panel of the SAS Add-In for Microsoft Office Options dialog box.

If you refresh the task that generated this output data, then the output data is also refreshed.

Note: If you are using Microsoft Word or Microsoft PowerPoint, then the output data is created, but it cannot be opened in Word or PowerPoint.

View Properties of a Task

By default, tasks use the settings from the SAS Add-In for Microsoft Office Options dialog box. From this dialog box, you can set the task options and set the results options.

To view and change the properties of an individual task:

1. Select the results from task in the workbook, document, or presentation.

2. Click the SAS tab on the Ribbon. In the Selection group, click Properties.

Working with Task Templates

About Task Templates

When you run a task, such as the Bar Chart task, you might want to frequently use the same settings. Instead of opening the task multiple times to specify these settings for different input data sources, task templates enable you to save your settings for a specific task to a template. You can then run that template with any input data source.

When working with task templates, remember these limitations:

- Values or settings that depend on the data source are not saved in the task template. For example, when you assign a variable to a specific role, the variable assignment is not saved in the task template. If an option is dependent on the
values of the data source, then the option setting is not saved in the task template. For example, in the Line Plot task, symbol definitions that depend on the data values are not saved in the task template.

- You cannot create a task template from these tasks: Compare Data, Forecast Studio Create Project, Forecast Studio Open Project, Forecast Studio Override Project, List Report Wizard, Model Scoring, and Summary Tables.

Create a Task Template

To create a task template:

1. Open the task and specify the options for the template.
2. Click the down arrow next to Run and select Create Template from the pop-up menu. The Create Task Template dialog box appears.

   Note: If the task is a wizard, click the down arrow next to Finish and select Create Template from the pop-up menu.

3. Specify a name for the template.
4. (Optional) Provide a brief description for the template. A description helps other users better understand the purpose of the template.
5. Select where to add the new template. You can choose either of the following options:
   - Create a new task template in group, and then select the group from the drop-down list.
   - Replace an existing task template, and then select the task to replace from the tree view.

   Note: If you choose to replace an existing task template, then the name that you previously specified is used for the new template.

6. Click Create. The new task template is now available from the Tasks tab in the SAS panel and the Tasks menu.

Export a Template

You might want to export a task template to a central location, so it can be imported by other users at your site.

To export a task template:

1. On the Tasks tab in the SAS panel, click and select Export Template. The Export Task Templates dialog box appears.
2. Select the templates that you want to export.
To select the location for these templates, click **Export** to. Select the location in the **Browse for Folder** dialog box and click **OK**. This location now appears in the **Export Task Templates** dialog box.

Click **Export**. A copy of the templates is saved to the location that you selected.

---

**Import a Template**

To import a task template:

1. On the **Tasks** tab in the SAS panel, click **Import** and select **Import Template**. The Import Task Templates dialog box appears.

2. To select one or more templates to import, click **Add**. The Open dialog box appears. Select the templates that you want to add and click **Open**. The templates now appear in the **Templates to import** pane.

3. From the **Import to group** drop-down list, select the group where you want to place the imported templates.

4. Click **Import**. The templates now appear on the **Tasks** tab in the SAS panel and from the **Tasks** menu.

---

**Run a Task Template**

To run a task template:

1. Double-click the task name on the **Tasks** tab in the SAS panel. You can also access task templates from the **SAS** tab on the Ribbon. Click **Tasks** and select **Task template** → **name-of-task-template**.

2. (Optional) Select the input data source. By default, the active data source in the Microsoft Office document is the input data source for the task. However, for most tasks, you can change the input data source from the **Data** panel.

3. In the **Data** panel of the task window, assign variables from the input data source to task roles.

4. (Optional) Modify any additional options in the task.

5. Click **Run**. The results from the task now appear in the Microsoft Office document.
Working with Custom Tasks

About Custom Tasks

You can extend the functionality of SAS Add-In for Microsoft Office by creating custom tasks. The SAS add-in can run tasks that were created for use with SAS Enterprise Guide 3.0 or later. To add a custom task, create a directory for the custom tasks. After you add a custom task, it is listed with the SAS tasks that are shipped with SAS Add-In for Microsoft Office.

For information about creating custom tasks, see the SAS Enterprise Guide website. To view help for custom tasks, click the Documentation tab, and then the link for all online documentation.

Creating a Directory for Custom Tasks

If you created a custom task for SAS Enterprise Guide, you can add this task to SAS Add-In for Microsoft Office by copying the appropriate DLL (dynamic link library) files to a special directory. From this special directory, SAS Add-In for Microsoft Office can automatically load the files.

If you have administrator privileges, you can create a Custom directory in the installation directory for SAS Add-In for Microsoft Office. If you copy custom task files to this location, then the custom tasks in this folder are available to all users who run this application. For more information, contact your system administrator.

Run a Custom Task

Custom tasks are integrated with the SAS tasks that are shipped with SAS Add-In for Microsoft Office. The location of the custom task is defined by the custom task. Custom tasks can be in new task groups that are created by the custom task or in an existing task group.

To run a custom task, double-click the task name on the Tasks tab in the SAS panel or select the task name from the Tasks menu.
About Reports

Working with SAS Visual Analytics Reports

Working with Reports from SAS Enterprise Guide or SAS Web Report Studio

Working with Report Snapshots

See Also

Open a Report

Adding Comments to a Report

View the Comments for a Report

View Display Rules for a Report

Working with Prompts in SAS Visual Analytics Reports

Create a Snapshot of a Report in Your Microsoft Office Document

View the Data Used to Create a Graph

Remove SAS Links

Generating Reports from SAS Stored Processes

About Stored Processes

Understanding the _MSOFFICECLIENT Macro Variable

About Input Streams and Output Parameters

Run a Stored Process to Generate a Report

Troubleshooting: Generating Reports from Stored Processes

Refreshing SAS Content

About Refreshing SAS Content

Refresh Multiple Data Sources and Results

Refresh the Results for a Single Analysis

Note: SAS Visual Analytics Add-In for Office is available only in Microsoft Excel and Microsoft PowerPoint.
In SAS Add-In for Microsoft Office, you can access reports that were created in SAS Visual Analytics. The type for these reports is SAS Report (2G).

You can specify the values for any prompts and select the elements to include in your Microsoft Office document.

Reports created in SAS Visual Analytics can contain these features:

- display rules and formatting. Display rules help direct your attention to results that meet specific criteria.
- links to other reports or to additional web pages.
- any filters and prompts that are applied to the report. You specify the values of these prompts and filters in the results pane after the report opens.

From the **Results** tab, you can select the elements to include in your Office document.

- To insert the entire report, click

- To insert a specific element, select the element that you want to include and click in the upper right corner. You can also press Ctrl+I to insert an element.

After you open a report from SAS Visual Analytics, you can refresh the SAS content in this report or perform any Microsoft Office operation on the SAS content.

**Note:** If your report includes web content, you can view that content by using the pop-up menu in the report controls pane. If you insert this web content into your document, you get a screen shot. The content is not connected to the live data on the web.

---

**Working with Reports from SAS Enterprise Guide or SAS Web Report Studio**

Some SAS applications, such as SAS Enterprise Guide and SAS Web Report Studio, publish reports to a report repository. By default, the entire report opens in your Microsoft Office application.

**Note:** If the input data source for a report is an OLAP cube, the report that opens does not support navigation functionality such as expanding and collapsing members and drilling up and down within the OLAP cube.

You can also send SAS Visual Analytics reports from SAS Enterprise Guide to Microsoft Excel, Microsoft Word, or Microsoft PowerPoint. These reports retain any specific filters that you defined while working in SAS Enterprise Guide. You can refresh the SAS content in these reports by using SAS Add-In for Microsoft Office.
Working with Report Snapshots

In SAS Enterprise Guide, you can create a report snapshot from another report, from an OLAP cube, or from results that are saved in the SAS Report format. A report snapshot is a report that contains a static copy of the data. The snapshot is not updated when the task or code that generated the results is rerun, or when the view of the OLAP cube is updated. From SAS Enterprise Guide, you can publish these reports to a location that is accessible by the SAS add-in. You can also send the results in a report snapshot to Microsoft Excel, Word, or PowerPoint.

See Also

Chapter 12, “Working with Results,” on page 187

Open a Report

From the Reports tab in the SAS panel, you can quickly access reports from any metadata connection server or SAS Visual Analytics server that you have defined in the SAS Connections window. To edit these connections or add new connections, click Manage Connections.

To open a report, click the server name, navigate to the file system, and select the report that you want to use. The report opens on the Results tab in the SAS panel.

If you created a report in SAS Enterprise Guide or SAS Web Report Studio, you might have saved the report to a common repository on a network drive, or you might have saved the report on your local computer.

To open reports saved in these locations:

1. Click the SAS tab on the Ribbon. In the General group, click Reports. The Reports window appears.

2. Select the report that you want to open.

3. Click Open. The report opens on the Results tab in the SAS panel.

To include the results in the document the first time you open it, select Automatically insert results into the Office document. For more information, see “Setting the Results Options” on page 35.

If you run a report frequently, you might want to add it to your list of favorites. Right-click the report name and select Add to favorites.
Adding Comments to a Report

View the Comments for a Report

The integration of the SAS Comment Server enables you to save comments with a SAS Visual Analytics report. As a result, any user who opens the report can view and reply to these comments. Any user can view and add comments. However, only a comments administrator can edit or delete comments. For more information, see SAS Intelligence Platform: Desktop Application Administration Guide.

To view the comments for a report, click the Comments tab. Click the Comments tab.

On the Comments tab, comments are organized by topic. By default, the comments are sorted by date in ascending order. However, you can sort these comments by date in descending order or by topic in ascending or descending order.

If another user at your site is adding comments to the same report, you should see his comments the next time the Comments tab is refreshed.

Search functionality is also available from the Comments tab. As you enter criteria into the search box, the results on the Comments tab are filtered to show only the relevant items. Strings that match your search criteria are highlighted.
View Display Rules for a Report

Display rules are criteria that specify how to highlight the various objects in a report. These display rules are specified when the author creates the report in SAS Visual Analytics.

To view the display rules for a report:

1. On the **Results** tab, click for the active report.
2. Click **Display Results** at the bottom of the **Results** tab.
From the **Display Rules** tab, you can view the display rules for an object in a report. To view the display rules, you must select an object. You cannot edit these display rules in SAS Add-In for Microsoft Office. To change the display rules, contact the author of the report.

For more information about display rules, see the documentation for SAS Visual Analytics.

---

### Working with Prompts in SAS Visual Analytics Reports

When a SAS Visual Analytics report is created, the author of the report can define prompts that appear when the report is run. These prompts enable you to subset the data and to create the specific report that you need. When you open a SAS Visual Analytics report in SAS Add-In for Microsoft Office, you can specify a value for each prompt. The report is updated immediately by using the new prompt values.

To change the value of a prompt for an existing report:

1. Open the report on the **Results** tab.
2. Modify the prompt values as needed and select the content to insert into your Microsoft Office document.

---

### Create a Snapshot of a Report in Your Microsoft Office Document

When you insert elements from a SAS Visual Analytics report into a Microsoft Office document, these report elements can be refreshed to reflect the most up-to-date information. However, you might want to include a snapshot of an element in your Microsoft Office document. This snapshot enables you to see the data at a particular point in time. Snapshots cannot be refreshed. The snapshot does not link to the original SAS Visual Analytics report.

To create a snapshot of an element in a report:

1. In the Microsoft Office document, select the element for which you want to create a snapshot.
2. Click the **SAS** tab on the Ribbon. In the **Selection** group, click **Selected Element**, and then select **Convert to Snapshot**.
View the Data Used to Create a Graph

Using SAS Add-In for Microsoft Office, you can view the aggregated data that was used to create a graph in a SAS Visual Analytics report. You might want to view this data if you are not the author of the report, and you want to determine what data was used to create the SAS content. You can save the exported data to the current worksheet or a new worksheet. When you refresh the SAS Visual Analytics report, the exported data is also refreshed.

To export the data source for a graph in a SAS Visual Analytics report:

1. Insert the SAS Visual Analytics report into your Microsoft Office document.
2. Select the graph in the Microsoft Office document.
3. Click the SAS tab on the Ribbon. In the Selection group, click Selected Element, and then select Export Graph Data. The Choose Location dialog box appears.
4. Select the output location for the data source, and click OK.

Remove SAS Links

When you refresh results from analyses, links are inserted into your worksheet, document, or presentation. If you remove the refresh links from your worksheet, document, or presentation, you will no longer be able to refresh those items.

To remove these SAS links:

1. Click SAS on the Ribbon. In the General group, click Currently Open, and then select Manage Content. The Manage Content window appears.
2. Select the SAS content where you want to remove the SAS links and click Delete.
Generating Reports from SAS Stored Processes

About Stored Processes

Stored processes are SAS programs that have been registered to the SAS Metadata Server by using SAS Management Console or SAS Enterprise Guide. You can run these stored processes to create reports. Stored processes can contain prompts that enable you to customize your report. These prompts appear when you run the stored process. Examples of prompts include selecting the type of chart to include in the results or selecting an input data source for the stored process. If you need more information about a stored process, contact the person who created the stored process.

In order to run a stored process, you must be connected to a SAS Metadata Server. For more information, see “Examine Your Connection” on page 10.

For information about stored processes, see the SAS Stored Process: Developer’s Guide.

Understanding the _MSOFFICECLIENT Macro Variable

SAS reserves several macro variables for use with stored processes. Most of these reserved macro variables are not product specific, so they are documented in the SAS Stored Process: Developer’s Guide.

The _MSOFFICECLIENT macro variable is unique to the SAS add-in. This macro variable specifies the Microsoft application that is currently executing the stored process. Values for this macro variable are Excel, Word, PowerPoint, and Outlook.

If you have questions about a specific stored process, contact the person who created the stored process. A stored process can be edited in SAS Enterprise Guide or SAS Management Console.

About Input Streams and Output Parameters

Note: The options in the Input Streams and Output Parameters dialog boxes depend on the input that is required by the stored process. For example, some stored processes do not require input streams, so you are not prompted to select an input data source. Other stored processes might not allow you to specify output parameters, so you are not prompted for output parameters. For questions about a stored process, contact the person at your site who created the stored process.
Specifying an Input Stream

Input streams are the data sources to use as input when the stored process runs. To view a description of the input stream (for example, the range of data must be from X to Y), position your mouse pointer over the text box. The description is optional and is provided when the stored process is created. If you have questions about the type of data that you can include in an input stream, contact the person at your site who created the stored process.

For each input stream, select the Microsoft Excel data to use. By default, the SAS add-in assumes the first row of your Excel data contains labels. If you do not have labels in the first row of your Excel data, then clear the Labels in the first row for Excel data sources check box in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “Data Options in Microsoft Excel” on page 28.

Specifying the Location of the Results

The results appear on the Results tab in the SAS panel. To include these results automatically in the Microsoft Office document, select the Automatically insert the results in the Office document option in the Options dialog box.

Specifying an Output Parameter

Output parameters enable you to specify what information to include in the results. The output parameters that are available depend on what is specified in the stored process code. However, here are examples of output parameters:

- the date-and-time stamp of when the stored process ran. When the stored process is run, you select a check box to insert this value in a specified location in the worksheet.

- the divisions in the company. When the stored process is run, you see a check box for each division. Selecting the check box for a division indicates that you want to include a value, such as total sales, for that division at a specified location in the worksheet.

For each output parameter that you want to include in the results, you must specify the output location in the Excel worksheet.

Note: If you specify a new worksheet for your results, then your output parameters might not appear in the location that you expected.

Output Types for Stored Processes

SAS Add-In for Microsoft Office supports two output types for the results that are generated by running a stored process. The output type for the stored process is set when the stored process is created.

Here are the two output types:

Streaming output
This output type consists of a single output file that is downloaded from the stored process server to the client computer when the stored process is executed. If the stored process output includes links to images that exist in
separate files, then the links to those image files will not work because the separate image files are not downloaded.

Note: If you select streaming output for your results and the stored process generates graphics, then the stored process can contain only ActiveX image types. The ActiveX format is the only image format that will not contain broken links to image files when using streaming output. This is because the ActiveX format embeds the images with the output that is downloaded to the client computer. If you select a format other than the ActiveX format and the stored process that you are running designates the output as streaming, you will get a message that states that the graphs might not be displayed correctly. You can either continue to run the stored process and not create graphical output, or you can cancel running the stored process and change your image format to ActiveX before running it again.

Package
This output type consists of a collection of output files that are downloaded to a single directory on the client computer. The output might contain links to files of any image format, and these links are displayed properly.

Run a Stored Process to Generate a Report

To run a stored process:

1. Click the SAS tab on the Ribbon. In the General group, click Reports. The Reports window appears.

2. Select the stored process that you want to run and click Open.

TIP If the stored process that you want to run is not available, you might want to refresh your list of stored processes.

3. Specify information for any prompts that appear. These prompts for user-supplied values are defined when the stored process is created.

After you have specified values for any required parameters, the results of the stored process open in the worksheet, document, or presentation.

Note: If the stored process produces streaming results and your image format is not set to ActiveX, then any graphs that the stored process generates cannot be displayed.

TIP If you run a stored process frequently, you might want to add it to your favorites list.
## Troubleshooting: Generating Reports from Stored Processes

For more information about stored processes, see *SAS Stored Processes: Developer’s Guide*.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I ran my stored process, and my graphical output is in the ActiveX format. However, I did not select ActiveX as the default format for my graphs. What happened?</td>
<td>Only the ActiveX format works with stored process that specify streaming report output. If you select a format other than the ActiveX format and the stored process that you are running designates the output as streaming, the SAS add-in changes the default graph format to ActiveX.</td>
</tr>
<tr>
<td>In my stored process results, the dates that are generated are not correct. What happened?</td>
<td>This is a problem with how Microsoft Office interprets dates. In Microsoft Office, the dates are interpreted according to the locale of the client computer. If the stored process defines a date format that is different from how the locale defines date formats, the dates can be misinterpreted by Microsoft Office. To work around this problem, use SAS Report as the format for your results. The SAS Report format enables the SAS add-in to interpret the date rather than Microsoft Office. To specify the format of the results, use the options on the <strong>Results</strong> panel in the SAS Add-In for Microsoft Office Options dialog box. For more information, see “Setting the Results Options” on page 35.</td>
</tr>
<tr>
<td>In my stored process results, all of the numbers are formatted like text. Why are the numbers formatted this way?</td>
<td>If your stored process results contain text that begins with either the ‘-‘ or ‘+’ character, then all of the information in your worksheet is treated as text. For example, some titles might begin with this character. To correct this formatting problem, contact the creator of the stored process and ask that person to correct the stored process so that no text begins with these characters.</td>
</tr>
<tr>
<td>When I tried to run a stored process, I got an error message saying that multiple</td>
<td>In order to run successfully, the code for a stored process must include a pair of macros. The %STPBEGIN macro is placed at the beginning of the stored</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>XML declaration were found. What happened?</td>
<td>process code, and the %STPEND macro at the end of the code. If multiple pairs of these macros are in the stored process code, you will see this error when the SAS add-in tries to run the stored process. Before you can run the stored process, the creator of the stored process needs to remove the extra macros.</td>
</tr>
<tr>
<td>The output of my stored process is not using the style or format that I selected. What happened?</td>
<td>If the author of the stored process specified in the stored process code the format and style that should be used for any generated output, these code values override any values that you specified in the SAS add-in.</td>
</tr>
</tbody>
</table>
| My stored process includes output parameters, but I do not see these output parameters in my results. Where are they? | When a stored process runs, you are prompted to specify the location of the results. You might choose to include the results in a new worksheet. However, this new worksheet is created when the stored process runs. Therefore, when you specify the location of the output parameter (for example, cell A30 in Microsoft Excel), the SAS add-in assumes that you are specifying a location in the existing worksheet (instead of the new worksheet, which has not been created yet). To include your output parameters in the same worksheet as the results from a stored process, use either of these workarounds:  
  - Before running the stored process, create the new worksheet.  
  - If you have already run the stored process (and the output parameters are on the wrong worksheet), select the results from the stored process. On the Ribbon, click the SAS tab, and in the Selection group, click Modify. Now when you are prompted for the location of the output parameters, specify a location in the same worksheet that contains the results from the stored process. |
Refreshing SAS Content

About Refreshing SAS Content

In Microsoft Excel, you can refresh the data sources in Excel workbooks, worksheets, or PivotTables. You might want to refresh a data source if it has been updated or modified on the server since you opened the data source.

In Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, you can refresh the results from an analysis. When you refresh the results, you can change the values that you specified for the analyses. You might want to refresh your results if the data source for the analysis has been updated or modified since you last ran the analysis.

When you refresh the results from an analysis, you might notice the following:

- In Microsoft Word or Microsoft PowerPoint, any user formatting is lost when you refresh data from an OLAP table in which the dimensions have changed. The table dimensions could change if the size of the data changes or the number of variables being analyzed has changed. If the table dimensions are the same, then the user formatting is preserved.

- In Microsoft PowerPoint, any animation that has been added to the SAS content is lost when you refresh an analysis.

- The results from a stored process can be refreshed if the stored process creates the same tables and data (even if the content changes). If the stored process creates different table structures or the table names of the output depend on the time of day or other values, then the results could appear as new content.

You cannot refresh the results in the following situations:

- If the data source for an analysis is an Excel worksheet, then you will not be able to refresh the results for an analysis within Word or PowerPoint. Word and PowerPoint are unable to open and read an Excel data source.

- You cannot refresh copied content. For example, if you copy the results from a stored process, then you cannot refresh the copied results. You can refresh only the original results.

**TIP** You can also schedule when the SAS content in a workbook, document, or presentation is refreshed. For more information, see About scheduling when the SAS content is refreshed.
Refresh Multiple Data Sources and Results

From the **Home** tab in the SAS panel, you can refresh all of the analyses that you have executed within your current Microsoft Excel workbook, Microsoft Word document, or Microsoft PowerPoint presentation. In Excel, you can also refresh any open data sources.

To refresh multiple analyses and any open data sources using the Manage Content window:

1. Click the **SAS** tab on the Ribbon. In the **General** group, click **Currently Open**, and then select **Manage Content**. The Manage Content window appears.

2. Select the check box for each analysis and data source that you want to refresh.

   **Note:** You can refresh data sources only in Microsoft Excel.

3. To refresh the items in the order in which they appear in the list, select the **Refresh checked items in order** check box. You can change the order of the items by using the up and down arrows.

   **Note:** The items that you selected are refreshed in the foreground, so you cannot work while the items are being refreshed. The items are refreshed in the order in which they appear in the Refresh Multiple window, and the SAS add-in must finish refreshing one item before the next item starts to refresh.

4. To specify that you want to edit the parameters for each analysis, select the **Modify items before refreshing** check box. If you select this check box, then a user prompt enabling you to modify each item is displayed before each item is refreshed. If you do not select this check box, then the analyses are refreshed based on your current parameter specifications.

5. Click **Refresh**. Your analyses are refreshed based on the current version of the data source that is available on the server. If you refreshed a data source in Microsoft Excel, then your view of the data source is refreshed based on the current version of the data source that is available on the server.

Refresh the Results for a Single Analysis

In Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, you can refresh the results for a single analysis. The analysis is updated based on the current version of the data source and the values that you entered for the parameters the last time you ran the analysis. If you want to change the parameters, then you need to modify your results.

Use one of these ways to refresh the results for a single analysis:

- In the SAS panel, use the refresh button on the **Results** tab or the **Home** tab.
Place the cursor on the SAS content. Click the **SAS** tab on the Ribbon. In the **Selection** group, click **Refresh**.
About the SAS Program Editor

Note:  This functionality is available only in SAS Add-In for Microsoft Office. It is not available in SAS Visual Analytics Add-In for Office.

You can use the SAS Program Editor to submit code to leverage the SAS 9 environment or the SAS Viya environment. The example shows syntax for the SAS 9 programming environment. In this program, you define a LIBNAME, create a SAS data set, and output the results to a specified location in the Office document.

To open the Program Editor, click Programs in the SAS panel. When you run a program, the results open on the Results tab.
SAS Add-In for Microsoft Office provides a color-coded, syntax-checking SAS language editor for editing new or existing SAS programs. The language editor includes a wide variety of features such as autocompletion, automatic formatting, pop-up help, and parenthesis matching. You can customize many of the settings for this editor. For more information, see “Setting the Advanced Options” on page 57.

- If you are not familiar with SAS 9 programming, see Step-by-Step Programming with Base SAS.
- For information about SAS Viya programming, see SAS Cloud Analytic Services: User’s Guide.
Run a SAS Program

To run a SAS program:

1. Open the program on the Programs tab in the SAS panel. You can open a program in either of these ways:
   - by selecting the program from the drop-down list on the Programs tab.
   - by clicking the SAS tab on the Ribbon. Click Programs and select program-name.

2. Select the code that you want to run. If no code is selected, the SAS add-in runs the entire program.

3. Select the workspace server where you want to run this code.

4. Click .

The results appear on the Results tab in the Programs tab. To include the results in the document the first time you open it, select Automatically insert results into the Office document. For more information, see “Setting the Results Options” on page 35.

To view any warnings, errors, or notes, click the Log tab.
Import a SAS Program

You can write SAS programs in various SAS applications such as SAS Enterprise Guide and SAS Studio. You can import and run these programs by using SAS Add-In for Microsoft Office.

To import a SAS program from the Programs tab in the SAS panel, click and select Import Program.
To import a SAS program from the SAS tab on the Ribbon:

1. Click Programs and select Import Program. The Open dialog box appears.
2. Select a program file and click Open. The program appears on the Programs tab in the SAS panel.

Export SAS Programs

You can export your SAS program so that the program is available to other SAS users at your site. Once exported, this program can be opened in other SAS applications such as SAS Enterprise Guide.

To export your SAS program:

1. On the Programs tab in the SAS panel, open the program that you want to export.
2. Click and select Export Program.
3. Specify the name and location for the program file and click Save.

Editing Program Files

Using the Autocomplete Feature

The autocomplete, or code completion, feature in the Program Editor can predict the next word that you want to enter before you enter it completely. The autocomplete feature can complete keywords that are associated with SAS statements, procedures, macros, functions, CALL routines, formats, informats, librefs or libraries, SAS data sets, macro variables, editor abbreviations, SAS colors, style elements, style attributes, statistics keywords, and various SAS statement and procedure options, including enumerated option values.

The autocomplete feature can also complete the names of SAS data sets and column names. The autocomplete feature includes nonstandard column names, such as "Total Retail $", when the default VALIDVARNAME=ANY system option is used and nonstandard data set names, such as "March Sales Data", when the VALIDMEMNAME=EXTEND system option is used. The VALIDMEMNAME option is available only in SAS 9.3 or later.

The Program Editor can also read your current program and suggest syntax for these program elements:

- macro variables that are defined by using the %LET statement or SYMPUT CALL routine
- macro routines that are defined by using the %MACRO statement
- data set names that are defined by using the DATA step statement

**Note:** The Program Editor does not automatically list macro variables and routines that are defined outside of the current document (for example, external macro programs, %include files, and autoexec files).

**TIP** You can disable or customize the autocomplete feature by using the Autocomplete options.

To use the autocomplete feature:

1. In the Program Editor, enter the first one or more letters of the word that you want to use. A window opens with a list of suggested keywords that begin with those letters.

2. You can navigate to the keyword that you want to use in these ways:
   - Continue to type until the correct keyword is selected (because the matching improves as you type).
   - Scroll through the list by using the up and down arrow keys or the Page Up and Page Down keys.
   - Scroll through the list by using your mouse scroll wheel.

3. You can add the keyword to your program in these ways:
   - Double-click the selected keyword.
   - Press the Spacebar, Enter, or Tab keys.
   - Enter the next valid punctuation, such as the semicolon, period, or equal sign keys.

---

### Using Parenthesis Matching

You can use the parenthesis matching feature to track nested parentheses within a program. The Program Editor highlights both the open and close parentheses. If only one parenthesis is highlighted, then you know that you are missing a parenthesis. This feature can be used to match parentheses, square brackets, and braces.

To match parentheses, position the cursor in front of the open parenthesis or after the close parenthesis that you want to match. The parenthesis and its match are highlighted in gray. If the parenthesis does not have a match, then it is not highlighted.

```sas
%let y = -5 to 5 by .5;
  z = sin(sqrt(y*y + x*x));
```
Using the Syntax Help

The Program Editor displays brief SAS syntax documentation as you write and edit your programs. You can display the Help in any of these ways:

- Position the mouse pointer over a valid SAS keyword in your program. Position the cursor within a valid SAS keyword and press F1.
- Start entering a valid SAS keyword, and then position the mouse pointer over a suggested keyword in the autocomplete window.

The SAS language often uses keywords that have the same name but can be used in different contexts. For example, the LABEL keyword is used both within the LABEL statement and as part of the LABEL= data set option. The Program Editor can distinguish between these uses and display the appropriate help.

The syntax help in the Program Editor can get you started with a hint about the syntax or a brief description of a keyword. You can get additional help by clicking links in the syntax help window as follows:

- Click the keyword link at the top of the window to search support.sas.com for the keyword. You can customize the search engine that is used in the search. For more information, see Specifying integrated syntax help options.
- Click the links at the bottom of the window to search for the keyword in the SAS Product Documentation, Samples and SAS Notes, and SAS Technical Papers.

For more comprehensive usage information about the SAS language, see support.sas.com.
Using Editor Macros

About Editor Macros
An editor macro is a series of Program Editor commands and instructions that you group together as a single command to accomplish a task automatically. Instead of manually performing a series of time-consuming, repetitive actions, you can create and run a single macro. You run the macro by using a keyboard shortcut.

Managing Macros
You can rename, edit, delete, import, and export editor macros in the Keyboard Macros window. To open this window, press Ctrl+Shift+M.

To edit a macro:
1. Select a macro and click Edit.
2. To rename the macro, enter thee name in the Keyboard macro name box.
3. Add a command to the list of commands that are performed when the macro is run.
4. To modify a command, you must first verify that the command can be modified. Select the command from the Keyboard macro contents box. If a command can be modified, click .
5. Click OK.

Recording Macros
To record a macro in the Program Editor:
1. Start recording by pressing Alt+Shift+F8.
2. Execute the sequence of actions to accomplish the task. You can record any sequence of keystrokes, including the Delete and Backspace keys, function keys, cursor control keys, and shortcut keys for other editor macros.
3. Stop recording by pressing Alt+Shift+F8.
4. Enter a name and description for the editor macro.
5. (Optional) Click Assign keys to define a keyboard shortcut to play the macro. For more information, see Assigning keyboard shortcuts to macros.
Assigning Keyboard Shortcuts to Macros

To assign a shortcut key to a macro immediately after you record it:

1. After you record the macro, click Assign Keys in the Save Keyboard Macro dialog box. The Assign Keys dialog box appears with the new macro selected in the Commands box.

2. Position the cursor in the Press new shortcut key box, and press the key or combination of keys to use as a shortcut for the macro. You can use any letter, number, function, or cursor control key by itself or in combination with one or more of these keys: Shift, Ctrl, and Alt. The sequence appears in the Press new shortcut key box and the assignment status for that key appears at the bottom of the window. If Currently assigned to is None, then no other command is assigned to this keyboard shortcut.

3. Click Assign to assign the keyboard shortcut.

Note: If you assign a macro to a keyboard shortcut that is already assigned to another command, the previous command for that shortcut is replaced. For example, if you assign the Backspace key to the Add a new abbreviation command, pressing the Backspace key opens the Add Abbreviation window. You can no longer use the Backspace key to delete content.

Creating and Saving a New Scheme

By default, the SAS language editor highlights your text in different colors to help you distinguish the different elements of a SAS program. You can adjust the text color, font, font size, and font style to create and save your own appearance schemes.

To create and save a new scheme:

1. Follow the steps for customizing the editor appearance for each element whose appearance you want to adjust.

2. Click Save As.

3. Enter the new scheme name and click OK.

Note: You cannot delete the built-in schemes.
Customizing the Editor Appearance

By default, the SAS language editor highlights your text in different colors and font styles. This highlighting helps you easily distinguish the different elements of a SAS program and detect basic syntax errors more quickly. You can adjust the text color, font, font size, and font style to create and save your own appearance schemes.

To access the editor appearance options:

1. Click the SAS tab on the Ribbon. In the Tools group, click Tools and select Options. The SAS Add-In for Microsoft Office Options dialog box appears.
2. In the selection pane, click Advanced.
3. Under the General heading, click Editor Options.
4. In the Enhanced Editor Options dialog box, click the Appearance tab. You can adjust the appearance of elements in log files and SAS program files.

To customize the appearance:

1. From the File type drop-down list, select the type of file whose appearance you want to customize.
2. From the Scheme drop-down list, select the appearance scheme that you want to use. Click Save As to save a new appearance scheme.
3. In the Font section, select the font name and size. The font settings apply to all text for that file type.

**TIP** A fixed-width font such as Courier New or Tahoma is recommended for the text.

4. From the File elements list, select the syntax element whose appearance you want to customize. If you are not sure what the name of the element is, click a sample of the element in the sample program that is displayed in the Preview box.

**Note:** To customize the appearance of user-defined keywords, select a file type of SAS Program File and a file element of User-defined keyword.

5. Select the foreground color, the background color, and the font style for the syntax element.
6. Repeat steps 1–5 for each element that you want to customize.
7. Click OK.
Creating User-Defined Keywords

You can create a list of user-defined keywords whose appearance you can customize. You might want to create user-defined keywords for programming elements such as SAS procedure statements, variables, and other user-defined formats.

To create user-defined keywords:

1. On the Ribbon, click the SAS tab, and then click Tools. From the drop-down menu, select Options.
2. In the SAS Add-In for Microsoft Office Options dialog box, select Advanced.
3. Under the General heading, click Editor Options. The Enhanced Editor Options dialog box appears.
4. Click the General tab.
5. Click User-Defined Keywords.
6. To add a new keyword, enter the name of the keyword in the name box and click Add. A new keyword is added to the list.
7. Click OK to save the keyword.

Setting the Program Editor Options

To access the editor appearance options, click the SAS tab on the Ribbon. In the Tools group, click Tools and select Options. In the SAS Add-In for Microsoft Office Options dialog box, click Advanced in the selection pane, and then click Editor Options.

Setting the Appearance Options

Changing the Appearance of a Specific File Type

- **File type** - specifies the type of file whose general settings you are editing. You can choose from these file types: SAS Log File and SAS Program File.
- **Scheme** - specifies the scheme that is used to determine the appearance of the SAS language editor.
- **Save As** - saves the appearance settings as a new scheme.
Delete - deletes the selected custom scheme. You cannot delete any of the default schemes that are included with SAS Add-In for Microsoft Office.

Name - specifies the font name for text in the selected file type. A fixed-width font such as Courier New or Tahoma is recommended for the text.

Size - specifies the font size for text in the selected file type.

Changing the Appearance of a Specific File Element

- File elements - specifies the syntax element whose appearance you want to edit.
- Foreground - specifies the foreground color of the selected syntax element.
- Background - specifies the background color of the selected syntax element.
- Font style - specifies the font style of the selected syntax element. You can choose from Normal, Bold, Italic, and Bold Italic.
- Underlined - displays the selected syntax element underlined.

Setting the Autocomplete Options

Customizing the Autocomplete Feature

- Enable Autocomplete - turns on the autocomplete feature of the Program Editor. This feature can predict the next keyword that you want to enter before you completely enter it.
- Autocomplete on - specifies on which character the autocomplete selection should be offered. You can choose to autocomplete your text on the first, second, or third characters.
- Commit a selection when typing any of these symbols - specifies the symbols that can be used to commit, or insert, the selected keyword from the autocomplete list and the symbol into your program. For example, if you select RUN from the autocomplete list and enter a semicolon (;), then run; is added to your program.

Note: The equal sign (=) is not included in the list of symbols, but it can be used to autocomplete a value-dependent option or statement, such as DATA= or PARENT=, to your program. However, if the currently selected keyword is not a value-dependent option or statement, then entering the equal sign does not automatically insert the keyword into your program.

For example, if you enter PROC PRINT DA and then you enter =, DATA= is selected from the autocomplete list and inserted into your program. However, if you enter DATA _NULL_; IN and then you enter =, IN= is inserted into your program. The autocomplete list includes the INFILE statement, but INFILE= is not inserted into the program because it is not a value-dependent statement.

The behavior of the equal sign does not change even if you add it to the list of symbols for this option.

- Add spaces when committing with these symbols - specifies the symbols that can be used to commit, or insert, the selected keyword from the autocomplete list, followed by a space, the symbol, and another space into your program.
program. For example, if you select a macro variable myConstant from the autocomplete list and type +, then myConstant + is added to your program.

- **Add spaces when committing value-type options** - adds a space, “=”, and then another space when you commit, or insert, an option that ends in “=”. For example, if you select this option and then select the YPIXELS= option from the autocomplete list, ypixels = is added to your program. If this option is not selected, then ypixels= is added to your program.

- **Commit selection when pressing the SPACEBAR key** - commits, or inserts, the selected keyword into your program when you press the Spacebar key. This option is selected by default.

- **Commit selection when pressing the ENTER or TAB key** - commits, or inserts, the selected keyword into your program when you press the Enter or Tab key. This option is selected by default.

Specifying the Types of Keywords to Autocomplete

**Autocomplete these keywords** - specifies which types of keywords you want SAS Add-In for Microsoft Office to autocomplete for you.

Selecting a SAS Color Format

**SAS color format** - specifies the color format that is used to specify colors. If you select **SAS color names**, then the predefined SAS/GRAPH color names are used. If you select **RGB Color Codes**, then the RGB color-naming scheme is used.

Specifying Integrated Syntax Help Options

- **Enable integrated syntax help** - displays brief SAS syntax documentation as you write and edit your programs. This option is selected by default. For more information, see Using the syntax help.

- **Search Engine** - specifies the search engine that is used to search support.sas.com when you click the keyword link in the syntax help window. The default value is Google. Select **SAS Support** to search for the keyword in the SAS Product Documentation.

Setting General Options

Changing the General Editor Options

- **Allow cursor movement past end of line** - enables you to move the cursor past the end of the line in the Code window. If you do not select this option, the cursor jumps down to the next line after a carriage return, and only the text on each line is highlighted during selection.

- **Drag-and-drop text editing** - enables drag-and-drop editing to cut, copy, or paste text within the code editor or between the code editor and another Windows application.

- **Show line numbers** - displays line numbers in the leftmost column of the program and log windows.

- **Strip Ctrl+Z characters** - removes any Ctrl+Z characters from the file. Ctrl+Z characters can be an end-of-file marker in some files.
- **Enable smart highlighting** - automatically highlights all occurrences of a selected word in the Program Editor.
  - **For word selection** - highlights all occurrences of a word that you select in the Program Editor.
  - **For find/replace search** - highlights all occurrences of a word that you search for in the Program Editor.
- **Case-sensitive smart highlighting** - highlights only the occurrences of a selected word in the Program Editor that match the case of the selected word.

### Changing the Appearance of the Different File Types
- **File type** - displays the type of file whose general settings you are editing. Available file types are SAS log files and SAS programs.
- **Tabs** - specifies the number of spaces that are inserted into your text when you insert a tab character. The default value is four spaces for each tab character. You can also choose to insert spaces for tabs or replace tabs with spaces on when the file opens.
- **Indentation** - automatically indents a new line by the amount of space that the previous line is indented.
- **Collapsible code sections** - specifies whether to insert lines between step boundaries within code and whether to display brackets in the margin to indicate step boundaries within code.
- **User-Defined Keywords** - opens a window that enables you to create your own list of keywords whose appearance you can customize.

### Specifying the Indenter Options

#### Customizing the Formatting
- **Indent Size** - displays how many spaces are inserted for each tab character. This option can be set only by using the Tab size option on the General tab. You can change the default indent unit from a tab character to spaces.
- **Put "THEN/ELSE DO" or "%THEN/%ELSE%DO" keywords on a single line** - puts all of the text for the THEN/ELSE DO or %THEN/%ELSE%DO keywords on a single line in the program. If you do not select this option, each keyword is displayed on a separate line.
- **Capitalize the first letter of every procedure name (if lowercase)** - capitalizes the first letter of all of the procedure names in your program. For example, *proc means* would be displayed as *proc Means*.

#### Inserting a Blank Line
- **Add a blank line before these statements/definitions** - specifies the statements and definitions before which you want to insert a blank line.
- **Exclusions** - specifies the exceptions to the rules for inserting blank lines.
About SAS Folders

If you want to store documents in a central repository so that they are available to other users at your site, you can save the documents to a metadata repository called SAS Folders. When you save documents to the SAS Folders, information about all the data sources, stored processes, and the location of the documents in WebDAV is saved to the repository. The documents are saved in WebDAV.

Storing this metadata in the repository enables you to perform an impact analysis on your documents. Impact analysis enables you to see where a data source came from and the items that are dependent on this source. This analysis enables you to know how changing a data source might affect other documents.

Some data sources are not stored in the metadata repository. These data sources include data from your local file system and data from SAS libraries, such as Sashelp and Sasuser, that do not exist in the metadata. When you save a document, you are warned that any data sources that are not stored in the metadata repository will not be tracked for impact analysis.

For more information, see Save a document to SAS Folders.

Save a Document to SAS Folders

To save a worksheet, document, or presentation to SAS Folders:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Save to SAS Folders. The Save dialog box appears.
Open a Document from SAS Folders

To open a document that is saved in SAS Folders:

1. Click the SAS tab on the Ribbon. In the Tools group, click Tools, and then select Open from SAS Folders. The Open dialog box appears.

2. Select the document that you want to open.

3. Click Open.

The document opens in your Microsoft Office application.

Specify the Security Settings for a Published Document

When you publish a document, you can specify the security settings for the document using the Security tab in the Properties dialog box.

To specify the security settings for a published document:

1. In the Properties dialog box, click the Security tab.

TIP You can also access these security settings by right-clicking on a published document or folder in the Reports window and selecting Properties from the pop-up menu. The Project Properties dialog box open. In the selection pane, select Security.
2 From the drop-down list, select the categories of users and groups that you want to select from. These users and groups appear in the list.

3 From the list, select one or more users and groups who should have access to this document or folder and add them to the Selected Users and Groups list.

4 To specify the type of access for a user or group, select the user or group from the Selected Users and Groups pane and select the Read or Write check box.

5 Click OK.

---

Note: The Verify Document for Impact Analysis dialog box opens if you are saving a document that contains data sources that are not in the metadata repository. This window lists any data sources that are not found in the data warehouse.

Select the Do not show this message again check box if you do not want this dialog box to open when you save another document with untracked data sources. To turn this dialog box back on, select the Prompt for untracked data sources check box on the Advanced panel in the SAS Add-In for Microsoft Office Options dialog box.
Viewing the Results

When you run a SAS program, task, or stored process, the results open on the Results tab in the SAS panel. Reports also open on this tab.

Note: If the results are data and you are working in Microsoft Excel, the data automatically opens in the Excel worksheet.

By default, the results are not included in your Office document. From the Results tab, you can select the elements to include in your Office document.

- To insert the entire result, click .
To insert a specific element from a SAS Visual Analytics report, select the element that you want to include and click in the upper right corner. You can also press Ctrl+I to insert an element.

To insert the results automatically into the Office document, select the Automatically insert results into the Office document when opening a report option. When this option is selected, you are prompted to specify where to insert any results or reports. This prompt appears the first time that the results or report opens. For more information, see “Setting the Results Options” on page 35.

From the Results tab, you can refresh your results or reset the report to use the default values on the server. You can also insert selected results or all the results into the Office document or export a report to a PDF. Open the Information panel to view comments or display rules associated with a SAS Visual Analytics report.

Modify the Results

When you refresh the results from an analysis, the SAS add-in runs the analysis again using the same settings from the previous run. You are not prompted to change any of the values in the analysis. If you want to change the values for a SAS task, stored process, or report, then you need to modify the SAS task, stored process, or report.

**Note:** The setting of the Use graph settings generated by SAS option determines whether any formatting changes that you made to the graph are preserved.

To modify the results from a SAS task, stored process, or report in Microsoft Excel, Word, or PowerPoint:

1. Select the results that you want to modify.
2. Click the SAS tab on the Ribbon. In the Selection group, click **Modify**.
3. Specify the new values for the task, stored process, or report. The window that opens depends on the analysis that you used to generate the results.

For example, if you are modifying the results for a SAS task, the SAS task window appears. If the SAS task was originally run as a wizard, then the wizard window appears. If you are modifying the results for a stored process or report, then a dialog box appears and you can enter new values for the prompts that were defined when the stored process or report was created.

**Note:** You can also modify the results for the analysis when you refresh multiple data sources or results. To modify the SAS task or stored process, select the **Modify items before refreshing** check box from the Manage Content window.

In Microsoft Outlook, you can modify the results only for a stored process and not for any other type of SAS content.
Cutting, Pasting, and Refreshing Results

In Microsoft Excel, Word, and PowerPoint, you can cut, paste, and refresh results that use the SAS Report format or SAS Visual Analytic reports. When you cut and paste the results into the same Office document (such as the same Excel worksheet or same PowerPoint presentation), the SAS add-in can find and refresh the results. However, if you paste the results into another Office document (such as a different Excel workbook or new PowerPoint presentation), the SAS add-in cannot refresh these results.

Note: You cannot copy, paste, and refresh results in a Microsoft Office document. When you copy results, the SAS add-in cannot distinguish between the original and duplicate content, so the results cannot be refreshed.

Delete SAS Content

You can remove the visual contents and hidden references to the SAS content from an Office document. If you are using Microsoft Excel, you can also remove a data source from a worksheet.

To remove the SAS content from your document, worksheet, or presentation, close the report on the Results tab in the SAS panel. You are prompted about whether you want to remove the content from your Microsoft Office document.

Replicate SAS Content

After you run a SAS job, you might want to replicate some or all of the SAS content.

To replicate SAS content:

1. In your document, select the results from a task, stored process, or report that you want to replicate.

2. Click the SAS tab on the Ribbon. In the Tools group, select Tools \ Replicate SAS Content.

The replicated results appear in the Results tab of the SAS panel. To insert these replicated results in the document, click .
Save a Report as HTML or PDF

After you run a report in Microsoft Outlook, you can save the results to an HTML or PDF file. You can save these results to your local computer or to a network location. You cannot refresh the SAS content after you save it to an HTML or PDF file. The SAS content in these files reflects the data when you saved the report. To determine whether the report has changed, open the report again by using the SAS add-in in Microsoft Outlook.

To save a report:

1. On the Results tab in the SAS panel, click to open the report in an email message.

2. On the Report tab, select Save As ⇒ file format, where file format is either HTML or PDF. The Save As dialog box appears.

3. Specify the location where you want to save the results. In the File name box, enter a name for your file, and then click Save.

Note: If the Save As option is not available, you are working with a SAS Visual Analytics report. Before you can save this type of report, you must export the report to PDF. For more information, see “Export a SAS Visual Analytics Report to PDF” on page 190.

Export a SAS Visual Analytics Report to PDF

To save a SAS Visual Analytics report, you must export the report to PDF. You can create a PDF of a single report element or an entire report. The default settings of the report are set by the author when the report is created. You can change the setting when you print the report in a PDF reader.

On the Results tab in the SAS panel, click and select Export to PDF.
Applying Styles to the Results

Select a Style

You can select the style for all of your results by using the options in the Results panel in the SAS Add-In for Microsoft Office Options dialog box.

You can change the style for a result created in the SAS Report or HTML format by using the options on the Appearance tab in the Properties dialog box. If you specify a style in the Properties dialog box, then this style is applied when you refresh the results.

To select a style before running an analysis:

1. Click the SAS tab on the Ribbon. In the Tools group, click Tools and select Options. The SAS Add-In for Microsoft Office Options dialog box appears.
2. In the selection pane, click Results.
3. Select the format and style of the results. The available options depend on your application. For more information, see “Setting the Results Options” on page 35.
4. Click OK to save your changes.

To change the style for a result created in the SAS Report or HTML format:

1. In the worksheet, document, or presentation, select the results.
2. Click the SAS tab on the Ribbon. In the Current Selection group, click Properties. The Properties dialog box appears.
3. Click the Appearance tab.
4. Select the style to apply to the results.
5. To refresh the results when you click OK, select the Refresh check box. If you do not select this check box, then the style is not applied until you refresh the results.
6. Click OK to save your changes.

How Styles Are Applied

Styles enable you to apply special formatting to your results. How styles are applied depend on the format that you selected for your results. You can select a style to apply to all of your results. After you run an analysis, you can change the style for results in certain formats.
<table>
<thead>
<tr>
<th>Result Format</th>
<th>How Styles Are Applied</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>You cannot apply a style to the results.</td>
</tr>
<tr>
<td>HTML</td>
<td>You must select a style to apply to the results.</td>
</tr>
<tr>
<td>SAS Report</td>
<td>You can specify whether a style should be applied to the results. By default, the AMODefault style is applied. If you use the default style, then any appearance changes (such as changing the font size or colors) that you make in the Microsoft Office application are preserved when you refresh the analysis. You can apply a SAS style to your results in these ways:</td>
</tr>
<tr>
<td></td>
<td>Before you run an analysis, use the Apply the SAS style to the results option in Results pane in the SAS Add-In for Microsoft Office Options dialog box. For more information, see Setting the results options.</td>
</tr>
<tr>
<td></td>
<td>After you run an analysis, select Always apply the SAS style to the results check box from the Appearance tab in the Properties dialog box. For more information, see “Setting the Appearance Properties” on page 207.</td>
</tr>
<tr>
<td></td>
<td>Note: The Use graph settings generated by SAS and the Preserve Excel number formatting options are also available.</td>
</tr>
<tr>
<td>SAS Report</td>
<td>The following examples explain how setting the style options can affect your results.</td>
</tr>
<tr>
<td>(continued)</td>
<td>Example 1: No initial style is applied to the results.</td>
</tr>
<tr>
<td></td>
<td>From the Results pane in the SAS Add-In for Microsoft Office Options dialog box, you select SAS Report as the results format. For the Apply the SAS style to the results option, you select Never. The results in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint use the AMODefault style (the default style).</td>
</tr>
<tr>
<td></td>
<td>After the results are generated, you decide to change the font size and then refresh the results. Any formatting changes that you made are preserved. If your results contain a graph, then any formatting changes that you made using the graph's right-mouse menu are also preserved. Only the data underlying the graph is updated.</td>
</tr>
<tr>
<td></td>
<td>To apply a different style to the results, select the Always apply the SAS style to the results check box in the Appearance tab of the Properties dialog box. If you have a graph in your results, then the style is applied to the graph only if you also select the Use graph settings generated by SAS check box. After you apply the style and refresh your results, any formatting changes that you made (using the formatting option in the Microsoft Office application) are lost, and the formatting from the SAS style is applied instead.</td>
</tr>
<tr>
<td></td>
<td>Example 2: You select a style to apply to the results.</td>
</tr>
</tbody>
</table>
|              | From the Results pane in the SAS Add-In for Microsoft Office Options dialog box, you select SAS Report as the results format. For the Apply the SAS style to the results option, you
### Sending Results

#### About Sending Results to Another Application

You can send the results from an analysis from one Microsoft Office application to another. For example, from Microsoft Excel, you can send results to Microsoft Word or to Microsoft PowerPoint. From Microsoft Outlook, you can send results to Excel, Word, or PowerPoint. When you select an analysis to send, the current result is displayed in the receiving Microsoft Office application.

The analysis that you send is automatically run again if any of the following conditions are met:

- if the files that were generated by the analysis no longer exist.
- if the results were generated in a result format other than SAS Report. The analysis is rerun so that the results can be generated in a format that can be displayed properly. For more information about how to specify a result format, see Setting the results options.

To display the latest results, rerun the analysis after the results are included in the application.
Send Results to Another Microsoft Office Application

To send the results from analyses from one Microsoft Office application to another:

1. On the **Results** tab in the SAS panel, click and then select **Send to**. The Send to Microsoft Office dialog box appears.
2. Specify where to send the analyses. You can send your results to more than one Microsoft Office application.
3. For each application, specify the location of your results. The results are always opened in the **Results** pane in the SAS panel. If you select the **Automatically open results into the Office document** option, the results are opened based on the default location for that Microsoft application.
4. Click **OK** to send the results from the analyses to Excel, PowerPoint, or Word.

To send multiple results, click the **SAS** tab on the Ribbon. In the **General** group, click **Currently Open** and select **Manage Content**. The Manage Content window appears. From this window, you can select multiple analyses and specify the order of these items before sending them to a Microsoft Office application.

Email a Report

You can email your results as an HTML, PDF, or ZIP file. To view these results, the email recipients must have SAS Add-In for Microsoft Office installed on their computer.

**Note**: If you selected ActiveX as the graph format for your results, you must forward the report as a ZIP file to retain the data tips in the graph. If you forward the results as HTML or PDF, the data tips are lost.

On the **Results** tab in the SAS panel, click and select **Email**. The report is attached to the email message as a PDF.

In Microsoft Outlook, you can also send a report from an email message. To open the report in an email, click **on the **Results** tab. From the **Report** tab of the email message, select **Forward** > **file format**, where file format is the HTML, PDF, or ZIP. HTML results are included in the email message. PDF and ZIP files are added as attachments.
View a Report on the Web

To view a report on the web, you must have access to SAS Visual Analytics Viewer.

- On the Results tab in the SAS panel, click and select View on Web.
- In an email message, click View Report on Web.

Inserting a Large Table into the Results

If the SAS add-in determines that a table in the results will exceed the recommended limit for the number of rows or columns, the Insert Table dialog box appears. The recommended limit is different for Microsoft Word and Microsoft PowerPoint. The Insert Table dialog box appears in these situations:

- In Microsoft Word, the table contains more than 200 rows or 20 columns.
- In Microsoft PowerPoint, the table contains more than 15 rows or 15 columns.

From the Insert Table dialog box, you can choose from these options:

- Limit the table size to inserts in the Word document or PowerPoint presentation a table with the number of rows and columns that you specify. By default, the SAS add-in creates a table that contains a maximum of 200 rows and 20 columns in Word or a maximum of 15 rows or 15 columns in PowerPoint.
- Display the entire table inserts in the Word document the entire table. The number of rows and columns for the table are in parentheses next to this option. Drawing the entire table can take several minutes.
- Display the largest table allowed inserts in the PowerPoint presentation the largest table that is allowed by PowerPoint, which is 150 rows and 150 columns. The number of rows and columns that will appear in your table are in parentheses next to this option.
- Do not prompt when refreshing this table specifies that you do not want the Insert Table dialog box to open for this table. When you refresh the analysis, this table uses the settings that you specified previously in the Insert Table dialog box. This dialog box will open for other tables in the analysis unless you also selected the Apply these settings to the remaining large tables in the analysis check box.
- Apply these settings to the remaining large tables in the analysis limits subsequent tables in the same analysis to the size that you specified. This option applies only to large tables that have more than 200 rows or 20 columns in Word and more than 15 rows or 15 columns in PowerPoint. When you select this option, the Insert Table dialog box does not open for tables that exceed this size limit. Instead, the table in the results conforms to the size limits that you specified when you were first prompted with the Insert Tables dialog box.

Tables in the analysis that have fewer than 200 rows or 20 columns in Word or fewer than 15 rows or 15 columns in PowerPoint are not affected when you
select this option. For these smaller tables, the entire table appears in the results.

In the following example, you are running an analysis in Word, and your analysis contains six different tables. Four of the tables exceed the recommended number of rows. Two of the tables do not exceed this recommendation. The following table explains when the Insert Table dialog box appears and how selecting **Apply these settings to the remaining large tables in the analysis** can affect your results.

<table>
<thead>
<tr>
<th>Table Number</th>
<th>Number of Rows</th>
<th>Expected Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>500 rows</td>
<td>The number of rows exceeds the recommended value of 200, so the Insert Table dialog box appears. You limit the table size to 10 rows and select the <strong>Do not prompt when refreshing this table</strong> check box, and then click <strong>OK</strong>. In the results, the first table contains only 10 rows. When you refresh the results, the Insert Table dialog box does not open because you selected the <strong>Do not prompt when refreshing this table</strong> check box. Again, the first table in the results contains 10 rows.</td>
</tr>
<tr>
<td>2</td>
<td>20 rows</td>
<td>The number of rows is fewer than 200, so the Insert Table dialog box does not open. In the results, the second table contains all 20 rows. When you refresh the results, the Insert Table dialog box does not open as long as this table contains fewer than 200 rows.</td>
</tr>
<tr>
<td>3</td>
<td>1,900 rows</td>
<td>The number of rows exceeds the recommended value of 200, so the Insert Table dialog box appears. You limit the table size to 190 rows, and then click <strong>OK</strong>. In the results, the third table contains only 190 rows. When you refresh the results, the Insert Table dialog box appears because you did not select the <strong>Do not prompt when refreshing this table</strong> check box. This time, you limit the table size to 50 rows. In the results, the third table contains only 50 rows.</td>
</tr>
<tr>
<td>4</td>
<td>600 rows</td>
<td>The number of rows exceeds the recommended value of 200, so the Insert Table dialog box appears. You limit the table size to 100 rows and select the <strong>Do not prompt when refreshing this table</strong> check box. Then you select <strong>Apply these settings to the remaining large tables in the analysis</strong> and click <strong>OK</strong>. In the results, the fourth table contains only 100 rows. When you refresh the results, the Insert Table dialog box does not open because you selected the <strong>Do not prompt when refreshing this table</strong> check box. In the results, the fourth table contains only 100 rows.</td>
</tr>
<tr>
<td>5</td>
<td>250 rows</td>
<td>The number of rows exceeds the recommended value of 200. However, the Insert Table dialog box does not open</td>
</tr>
</tbody>
</table>
because you chose to apply the settings that you specified for the fourth table to any remaining large tables in the analysis. Therefore, the SAS add-in uses the size limit (100 rows) that you specified for the fourth table. In the results, the fifth table contains only 100 rows.

When you refresh the results, the Insert Table Insert Table dialog box does not open because you selected the Do not prompt when refreshing this table and Apply these settings to the remaining large tables in the analysis check boxes for the fourth table. In the results, the fifth table contains only 100 rows.

| 6   | 125 rows | The number of rows is fewer than 200, so the Insert Table dialog box does not open. In the results, the sixth table contains all 125 rows. When you refresh the results, the Insert Table dialog box does not open as long as this table contains fewer than 200 rows. |

After you have made your selections in the Insert Table dialog box, click OK. Depending on the table size, it might take several minutes for the table to appear. If you want to stop the SAS add-in from creating this table, click Delete Table. The rest of the results from the analysis are displayed, but this large table is not.

---

**Troubleshooting: Working with Results**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When I insert ActiveX content into Microsoft Excel, Word, or PowerPoint, the application crashes. What happened?</td>
<td>Third-party ActiveX controls are not supported in 64-bit versions of Microsoft Office. To insert this content into Excel, Word, or PowerPoint, select a different format type for the image, such as the ActiveX image format.</td>
</tr>
<tr>
<td>Why can’t I refresh the results of an analysis in Microsoft Word?</td>
<td>When you sent the results of the analysis to Word, if the data source was a Microsoft Excel worksheet, then you will not be able to refresh the results for that analysis within Word. Word is unable to open and read the Excel data source. If the data source is a SAS data source, then you are able to refresh the results for that analysis as usual. For more information, see “Refreshing SAS Content” on page 165.</td>
</tr>
<tr>
<td>In Microsoft Excel, the tables in my results are taking a long time to load.</td>
<td>If you are generating large tables, you might prefer to use the CSV format, which</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>How can I reduce the amount of time it takes them to load?</td>
<td>is displayed more quickly in Microsoft Excel than other formats are. To select the format for your results, see “Results Options in Microsoft Excel” on page 35.</td>
</tr>
</tbody>
</table>
| Microsoft PowerPoint or Microsoft Word takes a long time to generate my results. How can I reduce the amount of time it takes to generate these results? | If your results contain a large table and you are applying a style, then it can take a long time to display your results in PowerPoint or Word. To reduce this time, you can do the following:  
  - Do not apply a style to the results and instead use the default font and color settings for PowerPoint. To remove the applied style, see “Setting the Results Options” on page 35.  
  - If the table contains more than 25 columns or 25 rows in PowerPoint or 200 columns or 20 rows in Word, then the Insert Table dialog box appears. From this dialog box, you can choose to limit the table size, which decreases the time it takes to display the results. From the Insert Table dialog box, you can also choose to display the entire table or delete the table. |
| When I refresh the results of an analysis in Microsoft PowerPoint, my tables do not retain their formatting. What happened? | PowerPoint has limited table functionality. Therefore, in some situations the SAS add-in must completely reformat an OLAP table to ensure that the results are correct. These situations include the following:  
  - you have added or deleted rows in the table since the results were generated.  
  - the number of columns in the table has changed.  
  - the table layout has changed during the refresh. If the cells in the refreshed table are not merged in the same way as in the original table results, then the SAS add-in must reformat the table. |
<p>| I am running out of disk space. Is SAS Add-In for Microsoft Office affecting my disk space? | The files needed to display the results for a stored process or task are not deleted when you close your Microsoft Excel, Microsoft Word, or Microsoft PowerPoint session. The <strong>Delete Files</strong> option on the <strong>Advanced</strong> panel in the SAS Add-In for Microsoft Office Options dialog box enables you to delete these files. For more information about where these files are stored and how to delete these files, |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I selected ActiveX as the graph format for my results. When I modified the results, I changed some settings that should have affected the appearance of a graph, but the graph does not reflect the changes. What happened?</td>
<td>The <strong>Use graph settings generated by SAS</strong> option on the <strong>Appearance</strong> tab of the Properties dialog box must be selected to apply any appearance changes that you made to the graph. To open the Properties dialog box, right-click on the graph and select <strong>Properties</strong>.</td>
</tr>
</tbody>
</table>
Working with Favorites

Favorites in the SAS Add-In
Any favorites that you create in SAS Add-In for Microsoft Office are saved locally and are saved in the SAS Favorites folder.

You can access a favorite in either of these ways:

- In the **Home** tab of the SAS panel, select **Favorites** from the drop-down list. The Favorites page lists all the items you have identified as favorites.
- Click the **SAS** tab in the Ribbon. In the **General** group, click **Favorites** and select **name-of-favorite**.
Note: When accessing favorites, remember these things:

- Favorites are shared between Microsoft Excel, Microsoft Word, Microsoft PowerPoint, and Microsoft Outlook. If a favorite cannot run in your current Microsoft Office application, then it is dimmed. The availability of a favorite depends on the active profile. If you created a favorite using one profile and then changed your profile, then the favorite might not be available.

- The menus in the Ribbon cannot exceed five levels, so any favorites that are nested more than five levels are not available from the Favorites menu.

To manage your favorites, select Favorites ⇒ Manage Favorites. In the Manage Favorites window, you can delete favorites, rename favorites, and organize your favorites into groups.

Working with Favorites from SAS Visual Analytics

If your site also licenses SAS Visual Analytics, favorites can be shared with SAS Add-In for Microsoft Office. These favorites are stored on the server and are available only after the SAS add-in connects to the metadata server.

Favorites from SAS Visual Analytics can also be accessed from the Favorites menu. If you are not connected to the metadata server, the Check for server favorites option appears. When you select this option, a connection is made to the metadata server, and the server favorites now appear in the Favorites menu.

When working with favorites from SAS Visual Analytics in the SAS add-in, remember these caveats:

- Favorites that were created in SAS Visual Analytics appear in the Visual Analytics Favorites folder in the Manage Favorites window.

- The Visual Analytics Favorites folder can contain SAS Report (2G) content.

- You cannot change the order of your SAS Visual Analytics favorites by using SAS Add-In for Microsoft Office.

Managing Jobs

About SAS Jobs

A SAS job is an operation that brings SAS content into a Microsoft Office document. An example of a SAS job is running an analysis or stored process, opening a report or data source, or opening a Microsoft Office document that is saved to a central repository called SAS Folders. From the SAS Status window, you can view jobs that are currently executing, jobs that are waiting to be executed, and jobs that have failed to execute because of errors. After a job is complete, the results are displayed in the Microsoft Office application.
If a job failed with errors, you can open the SAS log to view the warnings or errors that were generated. After you have fixed these errors, you can re-run the job from the SAS Status window. You can also open any results that were generated from the failed run. However, once the results are open, the job is removed from this window.

The jobs listed in the SAS Status window persist between sessions. This enables you to return to a job later. For example, if you are running a SAS job and need to exit Microsoft Excel, then these canceled jobs remain in the SAS Status window so that you can run them later. Once a job has completed successfully and opened in Microsoft Office, it is removed from this window.

### Viewing the Status of a SAS Job

To view the status of a SAS job, click the SAS tab in the Ribbon. In the Tools group, click Tools and select Status.

The SAS Status window appears. In the table, the status appears in the Status column.

To view the log for a selected job, click the log icon. The SAS Add-In Log window appears. You can scroll through the log for warnings or errors that caused a job to fail.

**Note:** You can view the log only for SAS task or a SAS stored process. You cannot view the log for reports or data.

To cancel the job that is currently executing, click the cancel icon. You can cancel only jobs that are being refreshed in the background. The status of the job changes to Canceled.

### Viewing the Results from a SAS Job

From the SAS Status window, you can open any results that were generated from a failed job. You can also open results from a job that completed successfully, but the results were not opened in Microsoft Excel, Microsoft Word, Microsoft PowerPoint, or Microsoft Outlook. Once you open the results from a job, the job is removed from the SAS Status window.

To view the results of a completed or failed job:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Status. The SAS Status window appears.

![SAS Status window](image)

2. Select a job and click the open icon to open the results.
Note: If your results are generated in the SAS Report format, then a progress bar appears during the rendering of these SAS Report elements. This progress bar indicates when the SAS Report elements are completed.

Scheduling a Time to Refresh SAS Content

About Scheduling When the SAS Content Is Refreshed

Scheduling when the SAS content in a Microsoft Excel workbook, Microsoft Word document, or Microsoft PowerPoint presentation is refreshed enables you to have the most up-to-date data and reports. The SAS add-in uses the Scheduled Tasks functionality in the Windows operating environment to schedule a refresh.

When you create a schedule, a Visual Basic (VB) script is generated. When executed, this script opens the workbook, document, or presentation and refreshes all of the SAS content. When the script runs, you might be prompted for your credentials for the server. If you do not want to be prompted for your credentials when the automation script runs, then you can create a credentials file.

You can create only one schedule for a workbook, document, or presentation. For each schedule, you can specify the following:

- the date and time that the SAS content is refreshed. You can specify a specific date and time for the refresh (for example, Friday, Aug 5 at 2:00 pm), or you can schedule a periodic refresh (for example, every Wednesday morning at 8:00 am).
- the location of the results. You can send results via email or save the results to a file on your local file system or on a network location.

Create a Schedule

To create a schedule:

1. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Create Schedule.

   The dialog box that opens depends on your operating environment. In this dialog box, you specify the date and time for the content to be refreshed, and other options that are specific to your environment.

   After you have specified the scheduling options, click OK. The Deliver Results dialog box appears.

2. Select the delivery method from the Deliver Results dialog box.
Delete a Schedule

To delete a schedule:

1. Open the workbook that is scheduled.
2. Click the SAS tab in the Ribbon. In the Tools group, click Tools and select Edit Schedule. The Scheduled Refresh dialog box appears.
3. On the Schedule tab, select the Show multiple schedules check box and click Delete.
4. Click OK in the Scheduled Refresh dialog box.
5. Click Yes in the message dialog box that appears.

When the schedule for the workbook, document, or presentation has been deleted, the Create Schedule menu item is again available from the Tools menu.

Using the Manage Content Window

From the Manage Content window, you can perform a variety of tasks, such as deleting SAS content, refreshing analyses and data sources, and sending the results from an analysis to another Microsoft Office application. All of the SAS content in your current document is listed in the Manage Content window. In Microsoft Excel, you can see the data sources that are associated with each analysis.

To open this window, click SAS in the Ribbon. In the General group, click Currently Open and then select Manage Content.

Remove SAS Links

When you refresh results from analyses, links are inserted into your worksheet, document, or presentation. If you remove the refresh links from your worksheet, document, or presentation, you will no longer be able to refresh those items.

To remove these SAS links:
1. Click **SAS** in the Ribbon. In the **General** group, click **Currently Open** and then select **Manage Content**. The Manage Content window appears.

2. Select the SAS content where you want to remove the SAS links and click 🗑️.

---

**Setting the Properties of an Analysis or Data Source**

**Viewing the Properties**

You can view the properties for an analysis in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint. In Excel, you can also view the properties for a data source.

To view the properties for the selected analysis or the selected data source in an Excel worksheet, workbook, or PivotTable, right-click on the image or data and select **Properties**. The Properties dialog box appears.

You can also click the **SAS** tab in the Ribbon. In the **Selection** group, click **Properties**.

**Note:** You can modify the properties only for SAS content. If your results were created as Microsoft Excel charts, these properties are not available. For more information, see “Data Options in Microsoft Excel” on page 28.

**Note:** Which properties are available depend on whether you have selected a data source, a PivotTable, the results from a SAS task, or the results from a stored process.

To apply any changes that you made in the Properties dialog box, select the **Refresh** check box. After the Properties dialog box closes, the SAS add-in refreshes the data or analysis and applies any changes.

---

**Setting the Advanced Properties**

From the **Advanced** tab in the Properties dialog box, you can specify how new data or SAS content is inserted into the Microsoft Excel worksheet when you refresh a data source or analysis. You can also specify whether to adjust the column widths in the worksheet to fit the new data.

**Note:** The **Advanced** tab is available only in Microsoft Excel.
Setting the Appearance Properties

The **Appearance** tab in the Properties dialog box is available only for results. It is not available for data sources. From this tab, you can specify the following options:

- **Report format** displays the format of the results that you selected in the **Results** pane in the SAS Add-In for Microsoft Office Options dialog box.

  Note: This format is specified before the analysis is run. You cannot edit this field.

- **Graph format** displays the image format that you selected in the **Results** pane in the SAS Add-In for Microsoft Office Options dialog box.

  Note: This format is specified before the analysis is run. You cannot edit this field.

- **Style** enables you to select a style to apply to the results. The style options are available when you select SAS Report or HTML as the results format.

  - If you select **SAS Report** as the format of your results, then the **Always apply the SAS style to the results** option is also available. If you select this option, then the SAS add-in applies to the results the style that you select from the drop-down list rather than the default font and color settings for the Microsoft Office application.

    Note: If the author of the stored process specified a style for the output, then SAS Add-In for Microsoft Office applies that style to the results, and the **Always apply the SAS style to the results** option is not available.

  - If you select HTML as the format of your results, then you must select a style from the **Style** drop-down list.

    The **Style** drop-down list includes the styles that are supplied by SAS, as well as any custom styles that you create using the Style Manager. To open the Style Manager, click **Manage Styles**.

    Note: Microsoft Office does not support images as part of the background of styles. Therefore, if you select a style that uses an image as part of the background, the image will not be displayed in the background of your results. Also, in Microsoft Excel, a color palette with only 56 colors is used. If you want to display a specific RGB color, you must replace another color on the color palette with the one that you want to add. To add a color to the color palette, open the Excel Options dialog box, which is accessible by selecting **Tools → Options**. For more information about how to change the color palette for a workbook, see the Microsoft Excel Help.

  - **Use graph settings generated by SAS** specifies that you want to use the graph settings that are generated by SAS for ActiveX graph formats. This option does not apply to any other graph format. Here is how this option works:
If this option is selected, any changes that you made to the graph’s appearance by using the pop-up menu are lost when you refresh. The graph settings that are generated by SAS for ActiveX graph formats are applied. Any data options that you specified by using the pop-up menu are also lost.

If this option is not selected, any changes that you made to the graph’s appearance by using the pop-up menu are preserved. The graph settings that are generated by SAS for ActiveX graph formats are not applied. Any data options that you specified by using the pop-up menu are also preserved.

- **Preserve Excel number formatting** specifies that you want to keep any changes that you made to the cell formats in Excel. By default, the first time you run a job, the SAS Add-In for Microsoft Office uses the number formats that SAS generates. If this option is selected, then any cell formatting changes that you made are preserved after you refresh. If this option is not selected, when you refresh the results the number formatting from SAS is applied, and any changes that you made to the cell formats in Excel are lost.

  Note: This option is available only in Microsoft Excel.

- **Use raw values in SAS Report tables** specifies how values are formatted in the results. By default, this option is selected and the formatting is done by Microsoft Excel or the SAS add-in. If you clear this option, then the formatting occurs on the server and the formatted value is returned to Excel.

  Note: This option is available only in Microsoft Excel and only if you selected SAS Report as the format for the results.

---

**Setting the Data Properties**

From the **Data** tab, you can view the properties of Microsoft Excel data or SAS data that is used to run the SAS task. You can also view the properties of the SAS data that is opened in Excel. The data properties differ depending on the data source. For example, some properties appear only if you are using Excel data. Other properties, such as the description of the filter, the sort order, and the column properties, are not available if your input data source is an information map.

Depending on your data source, the **Data** tab in the Properties dialog box displays some or all of the following information:

- the name of the worksheet that contains the data source if the data source is opened in Excel.
- the data range in the worksheet that contains the data source if the data source is opened in Excel.
- whether the Excel data includes labels in the first row.
- the name of the SAS data source. The name includes the server and SAS library where the data is saved.
- a description of the filter that is being applied to the input data source. This filter was created when you selected the data source in the Choose Data dialog box.
To add or change the filter that is applied to the SAS data source, click **Filter & Sort**. The Modify Data Source window appears. Click the **Filter** tab to create a filter.

**Note:** Task filters are not listed on the **Data** tab. You can create a task filter by clicking **Edit** in the **Data** panel of the task window.

- the prompt values or filter if your input data source is an information map. To change the prompt values, click **Filter & Sort**. The Modify Data Source window appears. Click the **Filter** tab to create a filter.
- the sort order for the input data. To specify or change the sort order that is applied to the SAS data source, click **Filter & Sort**. The Modify Data Source window appears. Click the **Sort** tab to sort your data.
- the column properties for the data source that is selected in Excel. You cannot view the column properties for the data source that is used to run a SAS task.
- any data attributes and constraints (for example, whether to show the record numbers, the number of records to display, and the format of the data values).

**Note:** The **Data** tab is not available for stored processes.

---

**Setting the Execution Properties**

From the **Execution** tab in the Properties dialog box, select the **Refresh on file open** check box. When you select this option, the SAS add-in gets the latest copy of the data or reruns the analysis when you open the file. After this action completes, the updated data or analysis appears in the worksheet, document, or presentation. You cannot work while the contents are being refreshed.

The name of the execution server appears on this tab. The execution server is the server where the data is refreshed or the analysis is run. You cannot change the execution server from this window.

If the SAS content is saved in the metadata, then the location of the SAS content on the SAS Metadata Server is also listed. You cannot change this location from the Properties dialog box.

---

**Viewing the General Properties**

The **General** tab in the Properties dialog box displays the following information:

- the name of the data source or analysis that was used to create the results.
- the name of the object. You can use this string to identify an individual result. If you write an event procedure for the SAS add-in, the object name is returned by the ItemUpdated event. For more information, see *SAS Add-In for Microsoft Office: Developer’s Guide*
- the date and time that the data source or analysis was first run in the document.
- the date and time that the data source or analysis last ran.
- the name of the person who modified the data or analysis.
- the length of time for the last run.

You cannot edit any of this information.
Customizing Styles

About the Style Manager
You can change the look of your HTML or SAS Report output by modifying and creating styles. Styles are based on cascading style sheets (CSS) and are a set of specifications that control what your HTML or SAS Report output looks like. There are several predefined styles that you can use. You can select an existing style for your output, modify an existing style, or create a new style. You can also use external styles that reside on a web server or elsewhere on your network.

To open the Style Manager:

- In SAS Enterprise Guide, select Tools ➤ Style manager.
- In SAS Add-In for Microsoft Office, click the SAS tab in the Ribbon. In the Tools group, click Tools, and then select Style Manager.

Set a Default Style

1. Open the Style Manager.
   - In SAS Enterprise Guide, select Tools ➤ Style manager.
   - In SAS Add-In for Microsoft Office, click the SAS tab in the Ribbon. In the Tools group, click Tools, and then select Style Manager.
Note: In the Style Manager window, the default style is displayed in bold in the Style List box.

2 From the list of available styles, select the style that you want to use as your default style, and click Set as Default.

3 Click OK.

Create a Copy of an Existing Style

You can create a copy of an existing style so that you can edit it.

1 Open the Style Manager.
   - In SAS Enterprise Guide, select Tools ➔ Style manager.
   - In SAS Add-In for Microsoft Office, click the SAS tab in the Ribbon. In the Tools group, click Tools, and then select Style Manager.

Note: In the Style Manager window, the default style is displayed in bold in the Style List box.

2 From the list of available styles, select the style that you want to copy and click Create a Copy.

3 Enter the name of the new style.

4 Click Save. The copied style, which has a location of My Style, is added to the list of styles.

Note: Styles that you copy and save are stored in your user profile area on your machine in this directory: %APPDATA%\SAS\SharedSettings\Styles. For example, this might resolve to C:\Users\user profile name\AppData\Roaming\SAS\SharedSettings\Styles.

Edit an Existing Style

There are several predefined, or built-in, styles that you can use as is or that you can make a copy of and then modify and save. You can also edit the name and URL of external styles.

Note: You cannot edit a predefined style without first making a copy of it.
Create a New Style Based on an Existing Style

You can use the predefined styles as the basis for creating a new style.

1 Open the Style Manager.
   - In SAS Enterprise Guide, select **Tools** ⇒ **Style manager**.
   - In SAS Add-In for Microsoft Office, click the **SAS** tab in the Ribbon. In the **Tools** group, click **Tools**, and then select **Style Manager**.

   **Note:** In the Style Manager window, the default style is displayed in bold in the **Style List** box.

2 Click **Add**. The Add New Style window appears.
3 Select **Add new based on existing style**.
4 In the **Style name** box, enter the name of the new style.
5 From the **Based on** drop-down list, select the style that you want to use as the basis for your new style, and click **OK**.

   **Note:** Styles that you copy and save are stored in your user profile area on your machine in this directory: %APPDATA%\SAS\SharedSettings\Styles. For example, this might resolve to C:\Users\user profile name\AppData\Roaming\SAS\SharedSettings\Styles.
Add an External Style

You can add external styles that you can apply to any results that you generate. There are two types of external styles that you can add:

- external styles that reside on a Web server or elsewhere on your network
- SAS styles that are stored on the SAS server

Note: After you add an external style, you can edit the style name and URL.

1. Open the Style Manager.
   - In SAS Enterprise Guide, select Tools ➤ Style manager.
   - In SAS Add-In for Microsoft Office, click the SAS tab in the Ribbon. In the Tools group, click Tools, and then select Style Manager.

   Note: In the Style Manager window, the default style is displayed in bold in the Style List box.

2. Click Add. The Add New Style window appears.

3. Select Add new external style.

4. In the Style name box, enter the name of the style.

5. In the Style URL box, enter the URL location of the style (for example, http://www.sas.com/tjf/Reports/SansPrinterTop.css).

   If the style is a SAS server style, select This is a SAS server style only. The Style URL box is disabled, because you do not need to specify a URL for SAS server styles.

6. Click OK.